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Lesson 1
Introduction

Upon successful completion of this lesson, you will be able to:

� Describe the key characteristics of a feature-based, parametric solid 
modeler.

� Distinguish between sketched and applied features.

� Identify the principal components of the SolidWorks user interface.

� Explain how different dimensioning methodologies convey 
different design intents.
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About This 
Course

The goal of this course is to teach you how to use the SolidWorks 
mechanical design automation software to build parametric models of 
parts and assemblies and how to make simple drawings of those parts 
and assemblies.

SolidWorks 2006 is such a robust and feature rich application that it is 
impractical to cover every minute detail and aspect of the software and 
still have the course be a reasonable length. Therefore, the focus of this 
course is on the fundamental skills and concepts central to the 
successful use of SolidWorks 2006. You should view the training 
course manual as a supplement to, not a replacement for, the system 
documentation and on-line help. Once you have developed a good 
foundation in basic skills, you can refer to the on-line help for 
information on less frequently used command options.

Prerequisites Students attending this course are expected to have the following:

� Mechanical design experience.
� Experience with the Windows™ operating system.
� Read the Introducing SolidWorks manual. A hardcopy of this 

manual is included with your software. Or, you can access an 
online version of this manual by clicking Help, Introducing 

SolidWorks.
� Completed the online tutorials that are integrated in the SolidWorks 

software. You can access the online tutorials by clicking Help, 

Online Tutorial.

Course Design 
Philosophy

This course is designed around a process- or task-based approach to 
training. Rather than focus on individual features and functions, a 
process-based training course emphasizes the processes and procedures 
you follow to complete a particular task. By utilizing case studies to 
illustrate these processes, you learn the necessary commands, options 
and menus in the context of completing a design task.

Using this Book This training manual is intended to be used in a classroom environment 
under the guidance of an experienced SolidWorks instructor. It is not 
intended to be a self-paced tutorial. The examples and case studies are 
designed to be demonstrated “live” by the instructor.

Laboratory 

Exercises

Laboratory exercises give you the opportunity to apply and practice the 
material covered during the lecture/demonstration portion of the 
course. They are designed to represent typical design and modeling 
situations while being modest enough to be completed during class 
time. You should note that many students work at different paces. 
Therefore, we have included more lab exercises than you can 
reasonably expect to complete during the course. This ensures that even 
the fastest student will not run out of exercises.
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A Note About 

Dimensions

The drawings and dimensions given in the lab exercises are not intended 

to reflect any particular drafting standard. In fact, sometimes dimensions 

are given in a fashion that would never be considered acceptable in 

industry. The reason for this is the labs are designed to encourage you to 

apply the information covered in class and to employ and reinforce 

certain techniques in modeling. As a result, the drawings and dimensions 

in the exercises are done in a way that complements this objective.

About the CD Bound inside the rear cover is a CD containing copies of the various 
files that are used throughout this course. They are organized by lesson 
number. The Case Study folder within each lesson contains the files 
your instructor uses while presenting the lessons. The Exercises 
folder contains any files that are required for doing the laboratory 
exercises.

Windows® 2000 

and Windows® XP

The screen shots in this manual were made using SolidWorks 2006 

running on Windows® 2000 and Windows® XP. You may notice 
differences in the appearance of the menus and windows. These 
differences do not affect the performance of the software.

Conventions Used 
in this Book

This manual uses the following typographic conventions:

Use of Color The SolidWorks user interface makes extensive use of color to 
highlight selected geometry and to provide you with visual feedback. 
This greatly increases the intuitiveness and ease of use of the 
SolidWorks software. To take maximum advantage of this, the training 
manuals are printed in full color.

Convention Meaning

Bold Sans Serif SolidWorks commands and options appear in 
this style. For example, Insert, Boss means 
choose the Boss option from the Insert menu.

Typewriter Feature names and file names appear in this 
style. For example, Sketch1.

17 Do this step

Double lines precede and follow sections of 
the procedures. This provides separation 
between the steps of the procedure and large 
blocks of explanatory text. The steps 
themselves are numbered in sans serif bold.
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Also, in many cases, we have used 
additional color in the illustrations to 
communicate concepts, identify 
features, and otherwise convey 
important information. For example, 
we might show the result of a filleting 
operation with the fillets in a different 
color, even though by default, the 
SolidWorks software would not display the results in that way.

What is the 
SolidWorks 
Software?

SolidWorks mechanical design automation software is a feature-based, 
parametric solid modeling design tool which takes advantage of the 
easy to learn Windows™ graphical user interface. You can create fully 

associative 3-D solid models with or without constraints while 
utilizing automatic or user defined relations to capture design intent.

The italicized terms mean:

� Feature-based

Just as an assembly is made up of a number of individual piece parts, a 
SolidWorks model is also made up of individual constituent elements. 
These elements are called features.

When you create a model using the SolidWorks software, you work 
with intelligent, easy to understand geometric features such as bosses, 
cuts, holes, ribs, fillets, chamfers, and draft. As the features are created 
they are applied directly to the work piece.

Features can be classified as either sketched or applied.

� Sketched Features: One that is based upon a 2-D sketch. Generally 
that sketch is transformed into a solid by extrusion, rotation, 
sweeping or lofting.

� Applied Features: Created directly on the solid model. Fillets and 
chamfers are examples of this type of feature.

The SolidWorks software graphically shows you the feature-based 
structure of your model in a special window called the 
FeatureManager® design tree. The FeatureManager design tree not 
only shows you the sequence in which the features were created, it 
gives you easy access to all the underlying associated information. You 
will learn more about the FeatureManager design tree throughout this 
course.
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To illustrate the concept of 
feature-based modeling, consider 
the part shown at the right:

This part can be visualized as a 
collection of several different 
features – some of which add 
material, like the cylindrical 
boss, and some which remove 
material, like the blind hole.

If we were to map the individual 
features to their corresponding 
listing in the FeatureManager 
design tree, it would look like 
this: 

� Parametric

The dimensions and relations used to create a feature are captured and 
stored in the model. This not only enables you to capture your design 
intent, it also allows you to quickly and easily make changes to the 
model.

� Driving Dimensions: These are the dimensions used when creating 
a feature. They include the dimensions associated with the sketch 
geometry, as well as those associated with the feature itself. A 
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simple example of this would be a feature like a cylindrical boss. 
The diameter of the boss is controlled by the diameter of the 
sketched circle. The height of the boss is controlled by the depth to 
which that circle was extruded when the feature was made.

� Relations: These include such information as parallelism, tangency, 
and concentricity. Historically, this type of information has been 
communicated on drawings via feature control symbols. By 
capturing this in the sketch, SolidWorks enables you to fully 
capture your design intent up front, in the model.

� Solid Modeling

A solid model is the most complete type of geometric model used in 
CAD systems. It contains all the wire frame and surface geometry 
necessary to fully describe the edges and faces of the model. In addition 
to the geometric information, it has the information called topology that 
relates the geometry together. An example of topology would be which 
faces (surfaces) meet at which edge (curve). This intelligence makes 
operations such a filleting as easy as selecting an edge and specifying a 
radius.

� Fully Associative

A SolidWorks model is fully associative to the drawings and 
assemblies that reference it. Changes to the model are automatically 
reflected in the associated drawings and assemblies. Likewise, you can 
make changes in the context of the drawing or assembly and know that 
those changes will be reflected back in the model.

� Constraints

Geometric relationships such as parallel, perpendicular, horizontal, 
vertical, concentric, and coincident are just some of the constraints 
supported in SolidWorks. In addition, equations can be used to 
establish mathematical relationships among parameters. By using 
constraints and equations, you can guarantee that design concepts such 
as through holes or equal radii are captured and maintained.

� Design Intent

Design intent is your plan as to how the model should behave when it is 
changed. For example, if you model a boss with a blind hole in it, the 
hole should move when the boss is moved. Likewise, if you model a 
circular hole pattern of six equally spaced holes, the angle between the 
holes should change automatically if you change the number of holes to 
eight. The techniques you use to create the model determine how and 
what type of design intent you capture.
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Design Intent In order to use a parametric modeler like SolidWorks efficiently, you 
must consider the design intent before modeling. Design intent is your 
plan as to how the model should behave when it is changed. The way in 
which the model is created governs how it will be changed. Several 
factors contribute to how you capture design intent:

� Automatic (sketch) Relations

Based on how geometry is sketched, these relations can provide 
common geometric relationships between objects such as parallel, 
perpendicular, horizontal, and vertical.

� Equations

Used to relate dimensions algebraically, they provide an external way 
to force changes.

� Added Relations

Added to the model as it is created, relations provide another way to 
connect related geometry. Some common relations are concentric, 
tangent, coincident, and collinear.

� Dimensioning

The way in which a sketch is dimensioned will have an impact upon is 
design intent. Add dimensions in a way that reflects how you would 
like to change them.

Examples of 
Design Intent

Some examples of different design intent in a sketch are shown below.

A sketch dimensioned like this will keep 
the holes 20mm from each end regardless 
of how the overall plate width, 100mm, 
is changed.

Baseline dimensions like this will keep 
the holes positioned relative to the left 
edge of the plate. The positions of the 
holes are not affected by changes in the 
overall width of the plate.
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Dimensioning from the edge and from 
center to center will maintain the distance 
between the hole centers and allow it to 
be changed that way. 

How Features 
Affect Design 
Intent

Design intent is affected by more than just 
how a sketch is dimensioned. The choice of 
features and the modeling methodology are 
also important. For example, consider the 
case of a simple stepped shaft as shown at 
the right. There are several ways a part like 
this could be built.

The “Layer Cake” 

Approach

The layer cake approach builds the part one piece at a time, adding each 
layer, or feature, onto the previous one, like this:

Changing the thickness of one layer has a ripple effect, changing the 
position of all the other layers that were created after it.

The “Potter’s 

Wheel” Approach

The potter’s wheel approach builds the part as 
a single, revolved feature. A single sketch 
representing the cross section includes all the 
information and dimensions necessary to make 
the part as one feature. While this approach 
may seem very efficient, having all the design 
information contained within a single feature 
limits flexibility and can make changes awkward.

The Manufacturing 

Approach

The manufacturing approach to modeling mimics the way the part 
would be manufactured. For example, if this stepped shaft was turned 
on a lathe, you would start with a piece of bar stock and remove 
material using a series of cuts.
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Unselectable 
Icons

At times you will notice commands, icons, and menu options that are 
grayed out and unselectable. This is because you may not be working in 
the proper environment to access those options. For example, if you are 
working in a sketch (Edit Sketch mode), you have full access to all the 
sketch tools. However, you cannot select the icons such as fillet or 
chamfer on the Features toolbar. Likewise, when you are working in 
the Edit Part mode, you can access these icons but the sketch tools are 
grayed out and unselectable. This design helps the inexperienced user 
by limiting the choices to only those that are appropriate, graying out 
the inappropriate ones.

To Pre-select or 

Not?

As a rule, the SolidWorks software does not require you to pre-select 
objects before opening a menu or dialog box. For example, if you want 
to add some fillets to the edges of your model, you have complete 
freedom – you can select the edges first and then click the Fillet tool or 
you can click the Fillet tool and then select the edges. The choice is 
yours.

The SolidWorks 
User Interface

The SolidWorks user interface is a native Windows interface, and as 
such behaves in the same manner as other Windows applications. Some 
of the more important aspects of the interface are identified below.

Pull down Menus

Graphics Area

Document Window

Reference Triad

Toolbars

FeatureManager
design tree

Status Area

Task Pane
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Menus Menus provide access to all the commands that the 
SolidWorks software offers. 

When a menu item has a right-pointing arrow like 

this: , it means there is a sub-menu 
associated with that choice.

When a menu item is followed by a series of dots 

like this: , it means that option opens a 
dialog box with additional choices or information.

When the Customize Menu item is selected, each 
item appears with a check box. Clearing the check 
box removes the associated item from the menu.

Keyboard 
Shortcuts

Some menu items indicate a keyboard shortcut like this:  
SolidWorks conforms to standard Windows conventions for such 
shortcuts as Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+Z for 
Edit, Undo and so on. In addition, you can customize SolidWorks by 
creating your own shortcuts.
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Toolbars The toolbar menus provide shortcuts enabling you to quickly access the 
most frequently used commands. The toolbars are organized according 
to function and you can customize them, removing or rearranging the 
tools according to your preferences. The individual options on them 
will be covered in detail throughout this course.

Example of a 

Toolbar

An example of a toolbar, in this case the Standard toolbar, is shown 
below. This toolbar contains such commonly used functions as opening 
new or existing documents, saving documents, printing, copying and 
pasting objects, undo, redo, and help.

Making Toolbars 

Visible

You can turn toolbars on or off using one of three methods:

� Click Tools, Customize.

On the Toolbars page, click the check boxes to select each toolbar you 
want to display. Clear the check boxes of the toolbars you want to hide.

Note In order to access Tools, Customize, you must have a document open. 
Also the Commands tab can be used to add or remove icons from 
toolbars.
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Work flow 

Customization

Toolbars can be turned on and off by industry 
using Work flow customization on the Options 
tab. Several industries are available.

� Right-click in the toolbar area of the SolidWorks 

window.

Check marks indicate which toolbars are currently 
visible. Clear the check marks of the toolbars you 
want to hide.

� Click View, Toolbars.

This displays the same list of toolbars.
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Arranging the 
Toolbars

The toolbars, including the Command Manager, can be arranged in 
many ways. They can be docked around all four borders of the 
SolidWorks window or dragged onto the graphics or FeatureManager 
areas. These positions are “remembered” when you exit SolidWorks so 
the next time you start SolidWorks, the toolbars will be where you left 
them. One such arrangement is shown below.

Quick Tips Quick Tips are part of 
the on-line help system. 
They ask “What would 
you like to do?” and 
provide typical answers 
based on the current 
task. Clicking an answer 
highlights the toolbar 
and icon required to 
perform that task.

Toolbars

Command
Manager

Toggle Quick Tips
On/Off
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FeatureManager 
Design Tree

The FeatureManager design tree is a unique part of the SolidWorks 
software that visually displays all the features in a part or assembly. As 
features are created they are added to the FeatureManager design tree. 
As a result, the FeatureManager design tree represents the 
chronological sequence of modeling operations. The FeatureManager 
design tree also allows access to the editing of the features (objects) 
that it contains.

PropertyManager 
Menus

Many SolidWorks commands are executed through PropertyManager 
menus. PropertyManager menus occupy the same screen position as the 
FeatureManager design tree and replace it when they are in use.

The color scheme and appearance of the PropertyManager menus can 
be modified through Tools, Options, Colors. See the SolidWorks 
online help for more information.

The top row of 
buttons contains 
the standard OK, 
Cancel and Help 
buttons.

Below the top row 
of buttons are one 
or more Group 

Boxes that contain 
related options. 
They can be 
opened (expanded) 
or closed 
(collapsed) and in 
many cases made 
active or inactive.

A Word about the 

Command Manager

The Command Manager is a set of 
toolbars geared towards helping the 
novice user, working alone, to perform 
specific tasks. For example, the part 
version of the toolbar has two main 
groupings: Features and Sketches 
listed as buttons on the top. 

This manual will not use the 
Command Manager toolbar. It will 
instead use the more general standard 
toolbar set. For more information see 
Toolbars on page 12.

OK

Cancel

Help 

Group Box

Open and active

Group Box

Closed and inactive

Open and

Close icon
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Taskpane The Task Pane window is used to house the SolidWorks Resources 

, Design Library  and File Explorer  options. The window 
appears on the right by default but it can be moved and resized. It can 

be opened/closed  , tacked or moved from its default position on the 
right side of the interface.

Opening Labs with 

the Design Library

You can open parts and assemblies required for 
lab exercises using the design library. Add the 
class files to the design library using this 
procedure.

� Open the Task Pane and the Design 

Library.

� Click Add File Location .
� Select the Essentials - Parts and 

Assemblies folder used for the class 
files. It should be found under the 
SolidWorks 2006 Training Files 
folder.

� Click OK.

Double-click the icon of the part or assembly in the Design Library to 
open it.
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Mouse Buttons The left, right and middle mouse buttons have distinct meanings in 
SolidWorks.

� Left

Select objects such as geometry, menus buttons and objects in the 
FeatureManager design tree.

� Right

Activates a context sensitive shortcut menu. The contents of the menu 
differ depending on what object the cursor is over. These menus also 
represent shortcuts to frequently used commands.

� Middle

Dynamically rotates, pans or zooms a part or assembly. Pans a drawing.

System Feedback Feedback is provided by a symbol attached to the 
cursor arrow indicating what you are selecting or 
what the system is expecting you to select. As the 
cursor floats across the model, feedback will come 
in the form of symbols, riding next to the cursor. 
The illustration at the right shows some of the 
symbols: vertices, edges, faces and dimensions. 

Options Located on the Tools menu, the Options dialog box allows you to 
customize the SolidWorks software to reflect such things as your 
company’s drafting standards as well as your individual preferences 
and work environment.

Vertex

Edge

Face

Dimension
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Customization You have several levels of customization. They are:

� System options

The options grouped under the heading System Options are saved on 
your system and affect every document you open in your SolidWorks 
session. System settings allow you to control and customize your work 
environment. For example, you might like working with colored 
viewport background. I don’t. Since this is a system setting, parts or 
assemblies opened on your system would have a colored viewport. The 
same files opened on my system would not.

� Document properties

Certain settings are applied to the individual document. For example, 
units, drafting standards, and material properties (density) are all 
document setting. They are saved with the document and do not 
change, regardless of whose system the document is opened on.

For more information about the options settings that are used in this 
course, refer to Options Settings on page 455 in the Appendix.

� Document templates

Document templates are pre-defined documents that were set up with 
certain specific settings. For example, you might want two different 
templates for parts. One with English settings such as ANSI drafting 
standards and inch units, and one with metric settings such as 
millimeters units and ISO drafting standards. You can set up as many 
different document templates as you need. They can be organized into 
different folders for easy access when opening new documents. You 
can create document templates for parts, assemblies, and drawings.

For more detailed instructions on how to create document templates, 
refer to Document Templates on page 455 in the Appendix.

� Object

Many times the properties of an individual object can be changed or 
edited. For example, you can change the default display of a dimension 
to suppress one or both extension lines, or you can change the color of a 
feature.
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Lesson 2
Introduction to Sketching

Upon successful completion of this lesson, you will be able to:

� Create a new part.

� Insert a new sketch.

� Add sketch geometry.

� Establish sketch relations between pieces of geometry.

� Understand the state of the sketch.

� Use sketch tools to add chamfers and fillets.

� Extrude the sketch into a solid.
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2D Sketching This lesson introduces 2D sketching, the basis of modeling in 
SolidWorks.

Sketches are used for all sketched features in SolidWorks including:

� Extrusions � Revolves
� Sweeps � Lofts

The illustration below shows how a given sketch can form the basis of 
several different types of features.

In this lesson, only extruded features will be covered. The others will 
be covered in detail in later lessons or courses.

Stages in the 
Process

Every sketch has several characteristics that contribute to its shape, size 
and orientation.

� New part

New parts can be created in inch, millimeter or other units. Parts are 
used to create and hold the solid model.

� Sketches

Sketches are collections of 2D geometry that are used to create solid 
features.

� Sketch geometry

Types of 2D geometry such as lines, circles and rectangles that make up 
the sketch.

� Sketch relations

Geometric relationships such as horizontal and vertical are applied to 
the sketch geometry. The relations restrict the movement of the entities.

Extrude Revolve Sweep LoftPre-
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� State of the sketch

Each sketch has a status that determines whether it is ready to be used 
or not. The state can be fully-, under- or over defined.

� Sketch tools

Tools can be used to modify the sketch geometry that has been created. 
This often involves the trimming or extension of the entities.

� Extruding the sketch

Extruding uses the 2D sketch to create a 3D solid feature.

Procedure The process in this lesson includes sketching and extrusions. To begin 
with, a new part file is created.

1 New part.

Click New , or click File, New on the Standard toolbar. Click the 
Part_IN template from the Training Templates tab on the New 

SolidWorks Document dialog box, and click OK.

The part is created with the settings of the template. One key setting is 
the part’s units. As the name implies, this part template uses inches as 
the units. You can create and save any number of different templates, 
all with different settings.
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2 Filing a part.

Using the Save option from the File menu or selecting the Save button 

 on the Standard toolbar, file the part under the name Plate. The 
extension, *.sldprt, is added automatically. Click Save.

What are We 
Going to 
Sketch?

The first feature of a part will be created in this section. That initial 
feature is just the first of many features needed to complete the part.

Sketching Sketching is the act of creating a 2-dimensional profile comprised of 
wireframe geometry. Typical geometry types are lines, arcs, circles and 
ellipses. Sketching is dynamic, with feedback from the cursor to make 
it easier.

Default Planes To create a sketch, you must choose a plane on which to sketch. The 
system provides three initial planes by default. They are Front, Top, 
and Right.

Introducing: 

Insert Sketch

When creating a new sketch, Insert Sketch opens the sketcher on the 
currently selected plane or planar face. You also use Insert Sketch to 
edit an existing sketch.
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You must select a reference plane or a planar face of the model after 
clicking Insert, Sketch. The cursor  appears indicating that you 
should select a face or plane.

Where to Find It You can access the Insert Sketch command in several ways.

� On the Sketch toolbar click the  tool.
� Or, on the Insert menu, click Sketch.
� Or, with the cursor positioned over a planar face or plane of the 

model, right-click and choose Insert Sketch from shortcut menu.

3 Open a new sketch. 
Open the sketch by either 

clicking  or choosing 
Sketch from the Insert 
menu. This will show all 
three default planes for 
selection in a Trimetric 
orientation. A Trimetric 
orientation is a pictorial 
view that is oriented so the 
three mutually 
perpendicular planes appear 
unequally foreshortened.

From the screen, choose the Front Plane. The plane will highlight 
and rotate.

Note The Reference Triad (lower left corner) shows the orientation 
of the model coordinate axes (red-X, green-Y and blue-Z) at all 
times. It can help show how the view orientation has been 
changed relative to the Front Plane.

4 Sketch active.

The selected Front Plane 
rotates so it is parallel to the 
screen. This only happens for the 
first sketch in a part.

The  symbol represents the 

part’s model origin which is the 
intersection of the X, Y, and Z 
axes. It is displayed in the color red, indicating that it is active.

Introducing: 

Confirmation Corner

When many SolidWorks commands are active, a symbol or a set of 
symbols appears in the upper right corner of the graphics area. This 
area is called the Confirmation Corner.
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Sketch Indicator When a sketch is active, or open, the confirmation corner 

displays two symbols. One looks like a sketch. The other is a 

red X. These symbols provide a visual reminder that you are 

active in a sketch. Clicking the sketch symbol exits the 

sketch and saves any changes. Clicking the red X exits the sketch and 

discards any changes.

When other commands are active, the confirmation corner 
displays a check mark and an X. The check mark executes 
the current command. The X cancels the command.

Sketch Entities SolidWorks offers a rich variety of sketch tools for creating profile 
geometry. In this lesson, only one of the most basic shapes will be used: 
Lines.

Sketch Geometry The following chart lists the basic sketch entities that are available by 
default on the Sketch toolbar.

Sketch Entity Toolbar Button Geometry Example

Line

Circle

Centerpoint Arc

Tangent Arc

3 Point Arc

Ellipse

Partial Ellipse

Parabola

Spline
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Basic Sketching The best way to begin sketching is by using the most fundamental 
shape, the Line.

The Mechanics of 
Sketching

To sketch geometry, there are two techniques that can be used:

� Click-Click

Position the cursor where you want the line to start. Click (press 
and release) the left mouse button. Move the cursor to where you 
want the line to end. A preview of the sketch entity will follow the 
cursor like a rubber band. Click the left mouse button a second 
time.

� Click-Drag

Position the cursor where you want the line to start. Press and hold 
the left mouse button. Drag the cursor to where you want the sketch 
entity to end. A preview of the sketch entity will follow the cursor 
like a rubber band. Release the left mouse button.

Introducing: 

Insert Line

The Line tool creates single line segments in a sketch. Horizontal and 
vertical lines can be created while sketching by watching for the 
feedback symbols on the cursor. 

Where to Find It � From the Tools menu, select Sketch Entities, Line.
� Or, with the cursor in the graphics window, right-click and select 

Line from the shortcut menu.
� Or, on the Sketch toolbar click Line .

Introducing: Sketch 

Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. They will be discussed in detail in 
Sketch Relations on page 33.

Polygon

Rectangle

Parallelogram

Point

Centerline

Sketch Entity Toolbar Button Geometry Example
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1 Sketch a line.

Click the Line tool  and sketch a horizontal line 

from the origin. The “ ” symbol appears at the 
cursor, indicating that a Horizontal relation is automatically added to 
the line. The number indicates the length of the line. Click again to end 
the line. 

Important! Do not be too concerned with making the line the exact length. 
SolidWorks software is dimension driven – the dimensions control the 
size of the geometry, not the other way around. Make the sketch 
approximately the right size and shape and then use dimensions to 
make it exact.

2 Line at angle.

Starting at the end of the first line, sketch a 
line at an angle.

Inference Lines 
(Automatic 
Relations)

In addition to the “ ” and “ ” symbols, dashed inference lines will 
also appear to help you “line up” with existing geometry. These lines 
include existing line vectors, normals, horizontals, verticals, tangents 
and centers.

Note that some lines capture actual geometric 
relations, while others simply act as a guide or 
reference when sketching. A difference in the 
color of the inference lines will distinguish 
them. In the picture at the right, the lines 
labeled “A” are olive-green and if the sketch 
line snaps to them, will capture either a 
tangent or perpendicular relationship. The 
line labeled “B” is blue. It only provides a 
reference, in this case vertical, to the other 
endpoint. If the sketch line is ended at this 
point, no vertical relation will be captured.

Note The display of Sketch Relations that appear automatically can be 
toggled on and off using View, Sketch Relations. They will remain on 
during the initial phase of sketching.

A

B
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3 Inference lines.

Moving in a direction perpendicular to the 
previous line causes inference lines to be 
displayed. A Perpendicular relation is 
created between this line and the last one.

The cursor symbol indicates that you are 
capturing a perpendicular relation. Note 
that the line cursor is not shown for clarity.

4 Perpendicular.

Another perpendicular line is created from the 
last endpoint. Again, a perpendicular relation 
is automatically captured.

5 Reference.

Some inferences are strictly for reference and do 
not create relations. They are displayed in blue. 
This reference is used to align the endpoint 
vertically with the origin.

Sketch Feedback The sketcher has many feedback 
features. The cursor will change to 
show what type of entity is being 
created. It will also indicate what 
selections on the existing geometry, 
such as end, coincident (on) or midpoint, are available using a red dot 
when the cursor is on it. 

Three of the most common feedback symbols are:

Endpoint Yellow concentric 
circles appear at the 
Endpoint when the 
cursor is over it.
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6 Close.

Close the sketch with a final line connected 
to the starting point of the first line. 

Turning Off Tools Turn off the active tool using one of these techniques:

� Press the Esc key on the keyboard.

� Click the Line  tool a second time.

� Click the Select  tool.

� Right-click in the graphics area, and choose Select from the 
shortcut menu.

Status of a Sketch Sketches can be in one of three definition states at any time. The status 
of a sketch depends on geometric relations between geometry and the 
dimensions that define it. The three states are:

Under Defined There is inadequate definition of the sketch, but the sketch can still be 
used to create features. This is good because many times in the early 
stages of the design process, there isn’t sufficient information to fully 
define the sketch. When more information becomes available, the 
remaining definition can be added at a later time. Under defined sketch 
geometry is blue (by default).

Fully Defined The sketch has complete information. Fully defined geometry is Black 
(by default). As a general rule, when a part is released to 
manufacturing, the sketches within it should be fully defined.

Midpoint The Midpoint appears 
as a square. It changes 
to red when the cursor 
is over the line.

Coincident (On 
Edge)

The quadrant points of 
the circle appear with a 
concentric circle over 
the centerpoint.
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Over Defined The sketch has duplicate dimensions or conflicting relations and it 
should not be used until repaired. Extraneous dimensions and relations 
should be deleted. Over defined geometry is red (by default).

Additional Colors There are several additional colors and states that may appear for 
geometry in the sketch. Dangling (brown), Not Solved (pink) and 
Invalid (yellow) all indicate errors that must be repaired.

Rules That 
Govern 
Sketches

Different types of sketches will yield different results. Several different 
types are summarized in the table below. It is important to note that 
some of the techniques shown in the table below are advanced 
techniques that are covered either later in this course, or in other 
advanced courses.

Sketch Type Description Special Considerations

A typical “standard” 
sketch that is a neatly 
closed contour.

None required.

Multiple nested 
contours creates a boss 
with an internal cut.

None required.

Open contour creates a 
thin feature with 
constant thickness.

None required. For more information, see 
Thin Features on page 359.

Corners are not neatly 
closed. They should be.

Use the Contour Select Tool. For more 
information, see Sketch Contours on 
page 258.
Although this sketch will work, it 
represents poor technique and sloppy 
work habits. Do not do it.

Sketch contains a self-
intersecting contour.

Use the Contour Select Tool. For more 
information, see Sketch Contours on 
page 258. If both contours are selected, 
this type of sketch will create a Multibody 

Solid. See Multibody Solids in the 
Advanced Part Modeling course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.
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7 Current sketch status.

The sketch is Under Defined because some 
of the geometry is blue. Note that endpoints 
of a line can be a different color and different 
state than the line itself. For example, the 
vertical line at the origin is black because it is 
(a) vertical, and (b) attached to the origin. 
However, the uppermost endpoint is blue 
because the length of the line is under 
defined.

8 Dragging.

Under defined geometry (blue) can be dragged 
to new locations. Fully defined geometry 
cannot. Drag the uppermost endpoint to change 
the shape of the sketch. The dragged endpoint 
appears as a green dot.

9 Undo the change.

Undo the last command by clicking the Undo 

 option. You can see (and select from) a list 
of the last few commands by clicking the down arrow menu. The 
keyboard shortcut for Undo is Ctrl+Z.

Tip You can also Redo  a change, which reverts it back to the state 
prior to undo. The shortcut for redo is Ctrl+Y.

Design Intent The design intent, as discussed earlier, governs how the part is built and 
how it will change. In this example, the sketch shape must be allowed 
to change in these ways:

The sketch of the first 

feature contains 
disjoint contours.

This type of sketch can create a Multibody 

Solid. See Multibody Solids in the 
Advanced Part Modeling course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.
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What Controls 
Design Intent?

Design intent in a sketch is captured and controlled by a combination of 
two things:

� Sketch relations

Create geometric relationships such as parallel, collinear, 
perpendicular, or coincident between sketch elements.

� Dimensions

Dimensions are used to define the size and location of the sketch 
geometry. Linear, radial, diameter and angular dimensions can be 
added.

To fully define a sketch and capture the desired design intent requires 
understanding and applying a combination of relations and dimensions.

Desired Design 
Intent

In order for the sketch to change properly, the correct relations and 
dimensions are required. The required design intent is listed below:

Horizontal and vertical 
lines.

Angle value.

Parallel Distance value.

Right-angle corners, or 
perpendicular lines.

Overall length value.
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Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. Some are automatic, others can be 
added as needed. In this example, we will look at the relations on one 
of the lines and examine how they affect the design intent of the sketch.

Automatic Sketch 
Relations

Automatic relations are added as geometry is sketched. We saw this as 
we sketched the outline in the pervious steps. Sketch feedback tells you 
when automatic relations are being created.

Added Sketch 
Relations

For those relations that cannot be added automatically, tools exist to 
create relations based on selected geometry and add dimensions.

Introducing: Display 

Relations

Display Relations shows and optionally allows you to remove 
geometric relationships between sketch elements.

Where to Find It � Double-click the entity.
Symbols appear indicating what relations are 
associated with that entity. In this example, the line has 
two relations: horizontal and tangent.

� The PropertyManager.
Select the sketch entity and the PropertyManager 
shows the relations associated with that entity.

� Click Display/Delete Relations  on the 
Dimensions/Relations toolbar.
The PropertyManager will show a list of all the 
relations in the sketch. 
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10 Display the relations associated with a line.

Double-click the uppermost angled line. 
Symbols appear identifying the lines that are 
perpendicular to the line you selected.

11 PropertyManager.

When you double-click the line, the PropertyManager 
opens. The Relations box in the PropertyManager 
also lists the geometric relations that are associated 
with the selected line.

12 Remove the relation.

Remove the uppermost relation by clicking the 
relation, either the symbol or in the 
PropertyManager, and pressing the Delete key. 
If the symbol is selected, it turns yellow and 
displays the entitie(s) it controls.

13 Drag the endpoint.

Because the line is no longer constrained to be 
perpendicular, the sketch will behave differently 
when you drag it. Compare this to how the 
sketch behaved when you dragged it in step 8.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 2
Introduction to Sketching

Sketch Relations 35

Examples of 
Sketch Relations

There are many types of Sketch Relations. Which ones are valid 
depends on the combination of geometry that you select. Selections can 
be the entity itself, endpoints or a combination. Depending on the 
selection, a limited set of options is made available. The following 
chart shows some examples of sketch relations. This is not a complete 
list of all geometric relations. Additional examples will be introduced 
throughout this course.

Relation Before After

Coincident between 
a line and an 
endpoint.

Merge between two 
endpoints.

Parallel between 
two lines.

Perpendicular 
between two lines.
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Collinear between 
two lines.

Horizontal applied 
to one or more lines.

Horizontal between 
two endpoints.

Vertical applied to 
one or more lines.

Vertical between 
two endpoints.

Relation Before After

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 2
Introduction to Sketching

Sketch Relations 37

Introducing: Add 

Relations

Add Relations is used to create a geometric relationship such as 
parallel or collinear between sketch elements.

Where to Find It � Select the sketch entity or entities, and select the 
appropriate relation from the Add Relations 
section of the PropertyManager.

� Or, right-click the entity or entities, and select 
Add Relation from the short-cut menu.

� Or, click Tools, Relations, Add...

� Or, on the Sketch toolbar click Add Relation .

Selecting Multiple 
Objects

As you learned in Lesson 1, you select objects with the left mouse 
button. What about when you need to select more than one object at a 
time? When selecting multiple objects, SolidWorks follows standard 

Microsoft® Windows conventions: Ctrl-select. Hold down the Ctrl key 
while selecting the objects.

Equal between two 
lines.

Equal between two 
arcs or circles

Midpoint between a 
line and an endpoint.

Relation Before After
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14 Add a relation.

Hold down Ctrl and select the 
two lines. The PropertyMan-
ager shows only those rela-
tions that are valid for the 
geometry selected.

Click Perpendicular, and click OK .

15 Drag the sketch.

Drag the sketch back into approximately its 
original shape.

Dimensions Dimensions are another way to define geometry and capture design 
intent in the SolidWorks system. The advantage of using a dimension is 
that it is used to both display the current value and change it.

Introducing:

Smart Dimensions

The Smart Dimension tool determines the proper type of dimension 
based on the geometry chosen, previewing the dimension before 
creating it. For example, if you pick an arc the system will create a 
radial dimension. If you pick a circle, you will get a diameter 
dimension, while selecting two parallel lines will create a linear 
dimension between them. In cases where the Smart Dimension tool 
isn’t quite smart enough, you have the option of selecting endpoints 
and moving the dimension to different measurement positions.

Where to Find It � From the Tools menu, select Dimensions, Smart.
� Or, right-click and select Smart Dimension from the shortcut 

menu.
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� Or, on the Dimensions/Relations toolbar, pick the Smart 

Dimension  tool.

Dimensioning: 
Selection and 
Preview

As you select sketch geometry with the dimension tool, the system 
creates a preview of the dimension. The preview allows you to see all 
the possible options by simply moving the mouse after making the 
selections. Clicking the left mouse button places the dimension in its 
current position and orientation. Clicking the right mouse button locks 
only the orientation, allowing you to move the text before final 
placement by clicking the left mouse button.

With the dimension tool and two endpoints selected, below are three 
possible orientations for a linear dimension. The value is derived from 
the initial point to point distance and may change based on the 
orientation selected.

16 Adding a linear dimension.

Choose the dimension tool from any 
source and click the line shown. 
Click a second time to place the text 
of the dimension above and to the 
right of the line. The dimension 
appears with a Modify tool 
displaying the current length of the 
line. The spin box is used to 
incrementally increase/decrease the 
value. Or with the text highlighted, 
you can type a new value to change it directly.

Endpoints
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The Modify Tool The modify tool that appears when you create or edit 
a dimension (parameter) has several options. The 
options available to you are:

Spin the value up or down by a preset amount.

Save the current value and exit the dialog box.

Restore the original value and exit the dialog box.

Rebuild the model with the current value.

Change the spin increment value.

Mark the dimension for drawing import.

17 Set the value. 
Change the value to 0.75 and click the 

Save  option. The dimension forces the 
length of the line to be 0.75 inches.

Tip Pressing Enter has the same effect as 

clicking the Save  button.

18 Linear dimensions.

Add additional linear dimensions to 
the sketch as shown.

Dimensioning Tip When you dimension a sketch, start 
with the smallest dimension first, and 
work your way to the largest. 

Angular 
Dimensions

Angular dimensions can be created using the same dimension tool used 
to create linear, diameter and radial dimensions. Select either two lines 
that are both non-collinear and non-parallel, or select three non-
collinear endpoints.
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Depending on where you place the angular dimension, you can get the 
interior or exterior angle, the acute angle, or the oblique angle. Possible 
placement options:

19 Angular dimension.

Using the dimension tool, create the 
angular dimension shown and set the 
value to 125°.

The sketch is fully defined.

Sketch Fillets Sketch Fillets are used to round off sharp corners in a sketch. A sketch 
fillet can be applied to a sketch that is already fully defined.

Important! Not all fillets should be added at the sketch level. There is a fillet 
command that works directly on solid models that may be more 
appropriate to use. You will learn about this in later lessons.
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Introducing: 

Sketch Fillet

Sketch Fillet is used to create a fillet or round in a sketch. The fillet is 
created as an arc placed tangent to adjacent entities.

Where to Find It � From the Tools menu, select Sketch Tools, Fillet.

� Or, on the Sketch toolbar click Sketch Fillet .

Note Sketch Fillets do not allow 0 radius values.

20 Sketch fillets.

Click Sketch Fillet  and set 
the Radius to 0.1875”. Select all 
of the endpoints in the sketch. 

Click OK.

Note For clarity, the relations are hidden in this example and the remainder 
of the lesson.

Why is There Only 

One Dimension?

A dimension only appears on the 
first fillet you create. All the 
fillets created in one operation are 
controlled by this dimension 
value. How is this done? 
Displaying the relations on the 
first fillet shows the answer: the 
system automatically adds an 
Equal relation to the other fillets 
in the series.

Extrude Once the sketch is completed, it can be extruded to create the first 
feature. There are many options for extruding a sketch including the 
end conditions, draft and depth of extrusion, which will be discussed in 
more detail in later lessons. Extrusions take place in a direction normal 
to the sketch plane, in this case the Front plane.

Where to Find It � From the menu: Insert, Boss/Base, Extrude....

� Or, on the Features toolbar, choose: .
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21 Extrude menu.

Click Insert, Boss/Base, Extrude or the  tool on the Features 
toolbar to access the command.

On the Insert menu, the options for other methods of creating features 
are listed along with Extrude and Revolve. They are unavailable 
because this sketch does not meet the conditions necessary for creating 
these types of features. For example, a Sweep feature requires both 
profile and path sketches. Since there is only one sketch at this time, the 
Sweep option is unavailable.

22 Preview graphics.

The view orientation 
automatically changes to 
Trimetric and a preview 
of the feature is shown at the 
default depth.

Handles  appear that can 
be used to drag the preview 
to the desired depth. The 
handles are colored red for 
the active direction and gray 
for inactive direction. A 
callout shows the current 
depth value.

Tip Color settings in SolidWorks can be modified using Tools, Options.

23 Extrude Feature settings.

Change the settings as shown.

� End Condition = Blind

�  (Depth) = 0.25”

Click OK  to create the feature.

Tip The OK button  is just one way to accept and 
complete the process.

A second method is the set of OK/Cancel buttons in 
the confirmation corner of the graphics area.
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A third method is to right-click and select OK from 
the shortcut menu.

24 Completed feature.

The completed feature is the first 
solid, or feature of the part. The sketch 
is absorbed into the Extrude1 
feature.

25 Save and close.

Click Save  to save your work and 

click Close  to close the part.
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Exercise 1:
Sketching 
Horizontal and 
Vertical Lines

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

� Sketching.
� Dimensions.
� Extruding a feature.

1 New part.

Open a new part using the Part_IN template.

2 Sketch.

Create this sketch on the 
Front Plane using lines, 
automatic relations and 
dimensions.

Fully define the sketch.

3 Extrude.

Extrude the sketch 1” in 
depth.

4 Save and close the part.Pre-
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Exercise 2:
Sketching Lines 
with Inferences

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

� Sketching.
� Dimensions.
� Extruding a feature.

1 New part.

Open a new part using the Part_IN template.

2 Automatic relations.

Create this sketch on the Front Plane using lines and automatic 
relations. Show the Perpendicular and Vertical relations.

3 Dimensions.

Add dimensions to fully define the 
sketch.

4 Extrude.

Extrude the sketch 0.5”.

5 Save and close the part.
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Exercise 3:
Sketching Lines

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

� Sketching.
� Dimensions.
� Extruding a feature.

1 New part.

Open a new part using the Part_MM template.

2 Sketch and extrude.

Create this sketch on the Front 
Plane using lines, automatic relations 
and dimensions. Extrude the sketch 
20mm in depth.

3 Save and close the part.
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Lesson 3
Basic Part Modeling

Upon successful completion of this lesson, you will be able to:

� Choose the best profile for sketching.

� Choose the proper sketch plane.

� Create a new part.

� Create a sketch.

� Extrude a sketch as a boss.

� Extrude a sketch as a cut.

� Create Hole Wizard holes.

� Insert fillets on a solid.

� Make a basic drawing of a part.

� Make a change to a dimension.

� Demonstrate the associativity between the model and its drawings.
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Basic Modeling This lesson discusses the 
considerations that you make before 
creating a part, and shows the process 
of creating a simple one.

Stages in the 
Process

The steps in planning and executing the creation of this part are listed 
below.

� Terminology

What are the terms commonly used when talking about modeling and 
using the SolidWorks software?

� Profile choice

Which profile is the best one to choose when starting the modeling 
process?

� Sketch plane choice

Once you’ve chosen the best profile, how does this affect your choice 
of sketch plane?

� Design intent

What is design intent and how does it affect the modeling process?

� New part

Opening the new part is the first step.

� First feature

What is the first feature?

� Boss and hole features

How do you modify the first feature by adding bosses and holes?

� Fillets

Rounding off the sharp corners – filleting.

� Dimension changes

Making a change to a dimension changes the model’s geometry. How 
does this happen?
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Terminology Moving to 3D requires some new terminology. The SolidWorks 
software employs many terms that you will become familiar with 
through using the product. Many are terms that you will recognize from 
design and manufacturing such as cuts and bosses.

Feature All cuts, bosses, planes and sketches that you create are considered 
Features. Sketched features are those based on sketches (boss and cut), 
applied features are based on edges or faces (fillet).

Plane Planes are flat and infinite. They are represented on the screen with 
visible edges. They are used as the primary sketch surface for creating 
boss and cut features.

Extrusion Although there are many ways 
to create features and shape 
the solid, for this lesson, only 
extrusions will be discussed. 
An extrusion will extend a 
profile along a path normal to 
the profile plane for some 
distance. The movement along 
that path becomes the solid model. 

Sketch In the SolidWorks system, the name used to describe 
a 2D profile is sketch. Sketches are created on flat 
faces and planes within the model. They are generally 
used as the basis for bosses and cuts, although they 
can exist independently.

Boss Bosses are used to add material to the model. The critical initial feature 
is always a boss. After the first feature, you may add as many bosses as 
needed to complete the design. As with the base, all bosses begin with a 
sketch.

Cut A Cut is used to remove material from the model. This is the opposite 
of the boss. Like the boss, cuts begin as 2D sketches and remove 
material by extrusion, revolution, or other methods you will learn 
about.

Fillets and Rounds Fillets and rounds are generally added to the solid, not the sketch. By 
nature of the faces adjacent to the selected edge, the system knows 
whether to create a round (removing material) or a fillet (adding 
material).

Design Intent How the model should be created and changed, is considered the 
Design Intent. Relationships between features and the sequence of 
their creation all contribute to design intent.
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Choosing the 
Best Profile

Choose the “best” profile. This profile, when extruded, will generate 
more of the model than any other. Look at these models as examples. 

Part Best Profile Extruded
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Choosing the 
Sketch Plane

Once the best profile is determined, the next step is to decide which 
view to use and select the plane with the same name for sketching it. 
The SolidWorks software provides three reference planes, they are 
described below.

Reference Planes There are three default reference planes, labeled Front Plane, Top 
Plane and Right Plane. Each plane is infinite, but has screen 
borders for viewing and selection. Also, each plane passes through the 
origin and is mutually perpendicular to the others.

The planes can be renamed. In this course the names Front, Top and 
Right replace the default names respectively. This naming 
convention is used in other CAD systems and is comfortable to many 
users.

Although the planes 
are infinite, it may be 
easier to think of 
them as forming an 
open box, connecting 
at origin. Using this 
analogy, the inner 
faces of the box are 
the potential sketch 
planes.

Placement of the 
Model

The part will be placed into the box three times. Each time the best 
profile will contact or be parallel to one of the three planes. Although 
there are many combinations, the choices are limited to three for this 
exercise.

There are several things to consider when choosing the sketch plane. 
Two are appearance and the part's orientation in an assembly. The 
appearance dictates how the part will be oriented in standard views 
such as the Isometric. This also determines how you will spend 
most of your time looking at the model as you create it.

The part's orientation in an assembly dictates how it is to be positioned 
with respect to other, mating parts.

Orient the Model for 

the Drawing

Another consideration when deciding which sketch plane to use is how 
you want the model to appear on the drawing when you detail it. You 
should build the model so that the Front view is the same as the Front 
view will be in the final drawing. This saves time during the detailing 
process because you can use predefined views.
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In the first example, the best profile is 
in contact with the Top plane.

In the second example, it is contacting 
the Front plane.

The last example shows the best 
profile in contact with the Right 
plane.

Chosen Plane The Top plane orientation seems to 
be the best. This indicates that the 
best profile should be sketched on the 
Top plane of the model.

How it Looks on the 

Drawing

By giving careful thought to 
which plane is used to 
sketch the profile, the 
proper views are easily 
generated on the detail 
drawing.
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Details of the 
Part

The part we will be creating is shown at right. There are two main boss 
features, some cuts, and fillets.

Standard Views The part is shown here in four standard views.

Main Bosses The two main bosses have distinct 
profiles in different planes. They are 
connected as shown in the exploded 
view at right.
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Best Profile The first feature of the model, 
is created from the rectangular 
sketch shown overlaid on the 
model. This is the best profile 
to begin the model. 

The rectangle will then be 
extruded as a boss to create the 
solid feature.

Sketch Plane Placing the model “in 
the box” determines 
which plane should be 
used to sketch on. In this 
case it will be the Top 
reference plane. 

Design Intent The design intent of this part describes how the part’s relationships 
should or should not be created. As changes to the model are made, the 
model will behave as intended.

� All holes are through holes.

� Holes in base are symmetrical.

� Slot is aligned with tab.
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Procedure The modeling process includes sketching and creating bosses, cuts and 
fillets. To begin with, a new part file is created.

1 New part.

Click New , or click File, New. Create a new part using the 
Part_IN template and Save it as Basic.

2 Select the sketch plane.

Insert a new sketch and choose the 
Top Plane.

Tip A plane doesn’t have to be shown in order to be used; it can be selected 
from the FeatureManager.

Sketching the First 
Feature

Create the first feature by extruding a sketch into a boss. Begin with the 
sketch geometry, a rectangle.

Introducing: 

Insert Rectangle

Insert Rectangle is used to create a rectangle in a sketch. The 
rectangle is comprised of four lines (two horizontal and two vertical) 
connected at the corners. It is sketched by indicating the locations of 
two diagonal corners.

Where to Find It � On the Sketch toolbar, click Rectangle .
� Or, on the Tools menu, select Sketch Entities, Rectangle.

3 Sketch a rectangle.

Click the Rectangle 

tool  and begin the 

rectangle at the origin.

Make sure the rectangle is locked to the origin by looking for the 
vertex cursor as you begin sketching. Do not worry about the size 
of the rectangle. Dimensioning it will take care of that in the next 
step.
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4 Fully defined sketch.

Add dimensions to the sketch. The 
sketch is fully defined.

Extrude Options An explanation of some of the more frequently used Extrude options is 
given below. Other options will be discussed in later lessons.

� End Condition Type

A sketch can be extruded in one or two directions. Either or both 
directions can terminate at some blind depth, up to some geometry in 
the model, or extend through the whole model.

� Depth

The distance for a blind or mid-plane extrusion. For mid-plane, it refers 
to the total depth of the extrusion. That would mean that a depth of 
50mm for a mid-plane extrusion would result in 25mm on each side of 
the sketch plane.

� Draft

Applies draft to the extrusion. Draft on the extrusion can be inwards 
(the profile gets smaller as it extrudes) or outward.

5 Extrude.

Extrude the rectangle 
0.5” upwards.

The completed feature is shown 
at the right.

Renaming 
Features

Any feature that appears in the FeatureManager design tree (aside from 
the part itself) can be renamed. Renaming features is a useful technique 
for finding and editing features in later stages of the model. Well 
chosen, logical names help you to organize your work and make it 
easier when someone else has to edit or modify your model.
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6 Rename the feature.

It is good practice to rename the features that you create with some 
meaningful name. In the FeatureManager design tree, use a very slow 
double-click to edit the feature Extrude1. When the name is 
highlighted and editable, type BasePlate as the new feature name. 
All features in the SolidWorks system can be edited in the same way.

Tip Instead of using a slow double-click to edit the name, you can select the 
name and press F2.

Boss Feature The next feature will be the boss with a 
curved top. The sketch plane for this 
feature is not an existing reference 
plane, but a planar face of the model. 
The required sketch geometry is shown 
overlaid on the finished model. 

Tip Cut features are created in the same way as bosses – with a sketch and 
extrusion. They remove material rather than add it.

Sketching on a 
Planar Face

Any planar (flat) face of the model can be used as a sketch plane. 
Simply select the face and choose the Sketch tool. Where faces are 
difficult to select because they are on the rear of the model or are 
obscured by other faces, the Select Other tool can be used to choose a 
face without reorienting the view. In this case, the planar face on the 
front of the BasePlate is used.

7 Insert new sketch.

Create a new sketch using 
Insert, Sketch or by clicking 

the Sketch tool . Select the 
indicated face.

Sketching SolidWorks offers a rich variety of sketch tools for creating profile 
geometry. In this example Tangent Arc is used to create an arc that 
begins tangent to a selected endpoint on the sketch. Its other endpoint 
can be placed in space or on another sketch entity.

Introducing: 

Insert Tangent Arc

Insert Tangent Arc is used to create tangent arcs in a sketch. The arc 
must be tangent to some other entity, line or arc, at its start.

Where to Find It � From the Tools menu, select Sketch Entities, Tangent Arc.
� Or, with the cursor in the graphics window, right-click and select 

Sketch Plane
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Tangent Arc.
� Or, on the Sketch toolbar click Tangent Arc .

Tangent Arc Intent 
Zones

When you sketch a tangent arc, the 
SolidWorks software infers from the 
motion of the cursor whether you 
want a tangent or normal arc. There 
are four intent zones, with eight 
possible results as shown.

You can start sketching a tangent arc 
from the end point of any existing sketch entity (line, arc, spline, and so 
on). Move the cursor away from the end point.

� Moving the cursor in a tangent direction creates one of the four 
tangent arc possibilities.

� Moving the cursor in a normal direction creates on of the four 
normal arc possibilities.

� A preview shows what type of arc you are sketching.

� You can change from one to the other by returning the cursor to the 
endpoint and moving away in a different direction.

Autotransitioning 
Between Lines and 
Arcs

When using the Line tool , you can switch from sketching a line to 
sketching a tangent arc, and back again, without selecting the Tangent 

Arc tool. You can do this by moving the cursor as described above, or 
by pressing the A key on the keyboard.

8 Vertical line.

Click the line tool  and start 
the vertical line at the lower 

edge capturing a Coincident  
relation at the lower edge and 

Vertical relation .

9 Autotransition.

Press the letter A on the keyboard.

You are now in tangent arc mode.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 3 SolidWorks 2006 Training Manual
Basic Part Modeling

62 Sketching on a Planar Face

10 Tangent arc.

Sketch a 180° arc tangent to 
the vertical line. Look for the 
inference line indicating that 
the end point of the arc is 
aligned horizontally with the 
arc’s center.

When you finish sketching the 
tangent arc, the sketch tool 
automatically switches back to the line tool.

11 Finishing lines.

Create a vertical line from the 
arc end to the base, and one 
more line connecting the bottom 
ends of the two vertical lines.

Note that the horizontal line is 
black, but its endpoints are not.

12 Add dimensions.

Add linear and radial 
dimensions to the sketch.

As you add the 
dimensions, move the 
cursor around to view 
different possible 
orientations.

Always dimension to an 
arc by selecting on its cir-
cumference, rather than center. This makes other dimensioning options 
(min and max) available.

13 Extrude direction.

Click Insert, Boss, 

Extrude and set the Depth 
to 0.5 inches. Note that the 
preview shows the 
extrusion going into the 
base, in the proper 
direction.

If the direction of the 
preview is away from the 

base, click the Reverse direction  button.
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14 Completed boss.

The boss merges with the 
previous base to form a single 
solid.

Rename the feature 
VertBoss. 

Viewports Viewports can be used to view and edit a model in multiple view 
orientations at the same time. The viewport icons include: Single 

View , Two View  (horizontal and vertical), Four View  and 

Link Views . Link Views ties the views together for zooming and 
panning.

Each viewport contains a view pop-up menu in the lower left corner. 
This menu displays the current view orientation (Custom for anything 
that is not a standard view) and contains a menu to change the view 
orientation.

Note The default four viewport orientation, first angle or third angle, is set 
using Tools, Options, System Options, Display/Selection, 
Projection type for four view viewport.

Where to Find It � From the Standard Views toolbar click the appropriate icon.
� Or, click the view pop-up menu and a select an icon.

15 Four viewports.

Click Four View  to divide the graphics window into four equal 
sized viewports. The view pop-up menu is blue in the active viewport.
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Using the Hole 
Wizard

The Hole Wizard is used to create specialized holes in a solid. It can 
create simple, tapered, counterbored and countersunk holes using a step 
by step procedure. In this example, the Hole Wizard will be used to 
create a standard hole.

Creating a 
Standard Hole

You can choose the face to insert the hole onto, define the hole’s 
dimensions and locate the hole and using the Hole Wizard. One of the 
most intuitive aspects of the Hole Wizard is that you specify the size of 
the hole by the fastener that goes into it.

Tip You can also place holes on reference planes and non-planar faces. For 
example, you can create a hole on a cylindrical face.

Introducing: 

The Hole Wizard

The Hole Wizard creates shaped holes, such as countersunk and 
counterbore types. The process creates two sketches. One defines the 
shape of the hole. The other, a point, locates the center.

Note The Hole Wizard requires a face to be selected or pre-selected, not a 
sketch.

Where to Find It � From the Insert menu choose Features, Hole, Wizard....

� Or choose the Hole Wizard  tool on the Features toolbar.

16 Select face.

Select the top, flat face of the base 

feature and click .

17 Type.

The Hole Specification dialog appears. Set the 
properties of the hole as follows:

Type: Hole

Standard: Ansi Inch

Screw Type: All Drill sizes

Size: 9/32

End Condition: Through All

Click the Positions tab.

Select this face
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18 Positions.

A point and hole preview is placed on the selected 
face near where you selected it.

Tip Multiple instances of the hole can be created in one 
command by inserting additional points at other 
locations.

19 Dimensions.

Add dimensions between 
the model edges and the 
point as shown. 

20 Additional point.

Click to add another Point 
on the face. Add the 
dimension shown.

21 Horizontal Relation.

Press Esc to turn off the dimension tool. Select both points and add a 
Horizontal relation between them. 

22 Single viewport.

Click Single View  
to return to the original 
view and click OK.
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23 Change the view orientation.

Click the view orientation menu and 
choose Isometric to change view 
orientation. 

Counterbore Hole A counterbore hole is required in this model. Using the front face of the 
model and a relation, the hole can be positioned.

24 Hole position.

Again, an existing face of the model 
will be used to position geometry. 
Select the face indicated and Insert, 

Features, Hole, Wizard....

25 Click Counterbore.

Set the properties of the hole as follows:

Standard: Ansi Inch

Screw Type: Hex Bolt

Size: 1/4

End Condition: Through All

Click the Positions tab.

26 Wake up the centerpoint.

Turn off the Point tool. Drag the point 
onto the circumference of the large arc. 
Do not drop it.

When the Coincident symbol appears 

, the center point of the large arc has 
been “woken up” and is now a point 
you can snap to.
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Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 3
Basic Part Modeling

Cut Feature 67

Drop the point onto the arc’s centerpoint. Look for the feedback that 
tells you that you are snapping to the arc’s center, a coincident relation. 
Click OK.

Cut Feature Once the two main boss features are completed, it is time to create a cut 
to represent the removal of material. Cut features are created in the 
same way as bosses- in this case with a sketch and extrusion.

Introducing: 

Cut Extrude

The menu for creating a cut feature by extruding is identical to that of 
creating a boss. The only difference is that a cut removes material while 
a boss adds it. Other than that distinction, the commands are the same. 
this cut represents a slot.

Where to Find It � From the Insert menu, select Cut, Extrude....

� Or, on the Features toolbar, choose Extruded Cut .

27 Rectangle.

Press the spacebar and double-
click *Front. Start a sketch on 
this large face and add a rectangle 
Coincident with the bottom 
model edge.

Selecting Multiple 
Objects

As you learned in Lesson 2, when selecting multiple objects, hold 
down the Ctrl key and then select the objects.

28 Relations.

Select the left vertical sketch line 
and the vertical model edge. Add 
a Collinear relation between 
them. Repeat the process on the 
opposite side.

29 Dimension.

Add a dimension to fully define 
the sketch. Change the view 
orientation to Isometric.
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30 Through All Cut.

Click Insert, Cut, Extrude or 

pick the Extruded Cut  tool on 
the Features toolbar. Choose 

Through All and click OK. This 
type of end condition always cuts 
through the entire model no 
matter how far. No depth setting 
was needed. Rename the feature 
BottomSlot.

View Options SolidWorks gives you the option of representing your solid models in 
one of several different ways. They are listed below, with their icons:

� Shaded

� Shaded with Edges

� Hidden Lines Removed

� Hidden Lines Visible

� Wireframe

Examples of each are shown in the illustration below. You will learn 
more about view display and manipulation in Lesson 4: Modeling a 

Casting or Forging.

Filleting Filleting refers to both fillets and rounds. The distinction is made by the 
geometric conditions, not the command itself. Fillets are created on 
selected edges. Those edges can be selected in several ways. Options 
exist for fixed or variable radius fillets and tangent edge propagation.

Both fillets (adding volume) and rounds (removing volume) are created 
with this command. The orientation of the edge or face determines 
which is used.

Shaded Hidden Lines Hidden Lines WireframeShaded with
Removed VisibleEdges
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Filleting Rules Some general filleting rules are:

1. Leave cosmetic fillets until the end.
2. Create multiple fillets that will have the same radius in the same 

command.
3. When you need fillets of different radii, generally you should make 

the larger fillets first.
4. Fillet order is important. Fillets create faces and edges that can be 

used to generate more fillets.

Where to Find It � From the Insert menu, select Features, Fillet/Round....

� Click the  tool on the Features toolbar.

31 Insert Fillet.

Select the Fillet option in one of the ways mentioned 
above. The Fillet options appear in the 
PropertyManager. Set the radius value.

�  (Radius) = 0.25”

Preview You have a choice between Full preview, Partial 

preview and No preview of the fillet. Full preview, 
as shown below, generates a mesh preview on each 
selected edge. Partial preview only generates the 
preview on the first edge you select. As you gain 
experience with filleting, you will probably want to 
use Partial or No preview because they are faster.

Tip The display can be changed to Hidden Lines Visible 

to make it easier to select the edges. The edges can be 
selected “through” the shaded model as displayed below.

32 Edge selection.

The edges will highlight red as the 
cursor moves over them and then 
appear green as they are selected. 
Edges are automatically filtered by 
the Fillet command.

A callout  appears on the first 
edge you select. Select six edges total 
and click OK.

A Note About Color You can customize the colors of the SolidWorks user interface. This is 
done through Tools, Options, System Options, Colors. You can 
select predefined color schemes, or create your own. In some cases, we 
have altered colors from their default settings to improve clarity and 
reproduction quality. As a result, the colors on your system may not 
match the colors used in this book.
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Tip You can also select edges using a 
window. Using the left mouse 
button, drag a window surrounding 
one or more edges. Edges that are 
entirely inside the window are 
selected.

33 Completed fillets.

All six fillets are controlled by the same 
dimension value. The creation of these 
fillets has generated new edges suitable 
for the next series of fillets.

Recent 
Commands Menu

SolidWorks provides a “just used” 
buffer that list the last few commands 
for easy reuse.

34 Recent Command.

Right-click in the graphics window and select Recent Commands and 
the Fillet command from the dropdown list to use it again.

Fillet Propagation A selected edge that connects to others in a smooth fashion (through 
tangent curves) can propagate a single selection into many. 

35 Preview and propogate.

Add another fillet, radius 0.125”, using 
Full preview.

Select the edge indicated to see the 
selected edges and preview.
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36 Additional selections.

Select the inner arc edge to see another 
preview with propagation.

Note A callout only appears on the first edge 
you select.

37 Last selection.

Select one final edge to complete the 
fillet. More propagation occurs due to 
the connections between the edges.

Click OK.

Introducing: Edit 

Color

Use Edit Color to change the color and optical properties of graphics. 
Color Swatches can also be created for user defined colors. 

Where to Find It � Click Edit Color  on the Standard toolbar.
� Or, right-click a feature, face, surface or body and choose 

Appearance, Color.

38 Edit Color.

Right-click the FeatureManager 
top level feature, Basic, and click 
Appearance, Color. 
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39 Select Swatch.

Select the shiny swatch and one 
of the colors. Click OK.

40 Save the results.

Click Save  on the Standard 
toolbar, or click File, Save to save 
your work.

Detailing Basics SolidWorks enables you to 
easily create drawings from 
parts or assemblies. These 
drawings are fully 
associative with the parts 
and assemblies they 
reference. If you change the 
model, the drawing will 
update.

Various topics related to 
making drawings are 
integrated into several 
lessons throughout this book. The material presented here is just the 
beginning. Specifically:

� Creating a new drawing file and sheet
� Creating Model and Projected drawing views
� Inserting model dimensions
� Adding driving (model) dimensions
� Adding annotations

A comprehensive treatment of detailing is offered in the course 
SolidWorks Essentials: Drawings.
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Settings Settings are accessed through Tools, Options. The settings used in this 
lesson are:

Toolbars There are toolbars that are specific to the process of detailing and 
making drawings. They are:

� Drawing

� Annotation

New Drawing Drawing files (*.SLDDRW) are SolidWorks files that contain drawing 
sheets. Each sheet is the equivalent of a single sheet of paper.

Introducing: Make 

Drawing from Part

Make Drawing from Part takes the current part and steps through the 
creation of a drawing file, sheet format and initial drawing views using 
that part.

Where to Find It � Click Make Drawing from Part/Assembly  on the Standard 
toolbar.

� Or, click File, Make Drawing from Part.

System Options
Document Properties

(Set using drawing template)

Drawings, Display Style:
• Display style for new views = 

Hidden lines visible

• Tangent edges in new views = 

Removed

Detailing:
• Dimensioning standard = ANSI

• Automatic update of BOM = 

Selected

• Auto insert on view creation:

� Center marks = Selected

� Centerlines = Cleared

� Balloons = Cleared

� Dimensions marked for 

drawing = Cleared

Colors:
• Drawings, Hidden Model Edges 

= Black

Detailing, Annotations Font, 
Dimension:
• Font = Century Gothic

• Height = 12pt

Detailing, Dimensions:
• Precision, Primary Units = .123

Units = InchesPre-
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1 Create Drawing.

Click the Create Drawing from Part/Assembly icon and choose 
A-Scale1to2 from the Training Templates tab.

The sheet format creates an A-Landscape drawing. This is an A-size 

drawing (81/2” x 11”) arranged with its long edge horizontal. The sheet 

format includes a border, title block, and other graphics.

Tip Double-clicking the template will automatically open it, eliminating the 
need to click OK.

Drawing Views The initial task of detailing is the creation of views. Using the Make 
drawing from part tool leads you through the drawing sheet to the 
creation of View Orientation views. The View Orientation option 
creates drawing views that match the orientations in the part.

These options are discussed in detail in the SolidWorks Essentials: 

Drawings manual.

2 Drawing views.

Click Multiple views, 
View orientation and 
select the four standard 
views (Front, Top, 
Right and 
Isometric) as 
shown.

On the Display Style 
tab, click the Hidden 

Lines Visible button.

Click OK to create the 
drawing views.

Note The drawing sheet can be any color. The color is used here to 
distinguish the part from the drawing.
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3 Drawing views.

The drawing views are created 
on the drawing.

Tip Use Ctrl-drag to break the default angled alignment and drop the 
isometric view anywhere on the drawing.

Set the Display Style for this view to Shaded With Edges.

Tip The part document is still open. You can press Ctrl+Tab to switch 
between the drawing and part document windows.

4 Tangent edges.

Select inside the a drawing view, between the 
model and the temporary dotted border, to 
display the view border. Double-clicking locks the view focus on that 
view.

Right-click in the Front view and choose Tangent Edge, Tangent 

Edges Removed. Repeat for the Top and Right views.

5 Display style.

Select the Isometric view and change the Display Style to 
Shaded.

Moving Views Drawing views can be repositioned by dragging them around the 
drawing. In the standard 3 view arrangement, the Front view is the 
source view. This means that moving the front view moves all three 
views. The Top and Right views are aligned to the Front. They can 
only move along their axis of alignment.

6 Move Aligned Views.

Select and move the Front 
view. It can be moved in any 
direction and the other views 
remain aligned.
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Moving one of the projected views is limited by the 
alignment.

Tip Use Alt-drag to select anywhere in the view. Use Shift-drag to 
maintain the spacing between the views while dragging.

Note Once the drawing view has been selected, it can be dragged with the 
mouse or moved with the arrow keys. The distance moved for each 
press of an arrow key is set under Tools, Options, System Options, 
Drawings, Keyboard movement increment.

Center Marks Center marks were inserted into the drawing 
views automatically. You can turn this option on 
or off. Set your preference using the Tools, 

Options, Document Properties, Detailing menu.

7 Center Mark Properties.

Click on the center mark on the 
circle in the front view. Check the 
Extended lines option.Pre-
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Model 
Dimensions

Model dimensions are simply dimensions and parameters that were 
used to create the part and that have been inserted into the drawing. 
These dimensions are considered to be driving dimensions. Driving 
dimensions can be used to make changes to the model. You can insert 
model dimensions into the drawing in four ways. You can 
automatically insert all the dimensions associated with:

� A selected view

� Selected feature(s)

� Selected components in an assembly

� All views

Inserting All Model 
Dimensions

The dimensions created in the part will be used in the detail drawing. In 
this case all the dimensions in all views will be inserted. When the 
system inserts model dimensions into all views, it starts with any detail 
and section views first. Then it adds any remaining dimensions to 
remaining views based on which views are most appropriate for the 
features being dimensioned.

Introducing: 

Insert Model Items

Insert Model Items allows you to take the dimensions that were 
created while modeling and insert them into the drawing. Dimensions 
imported from the model can be used to change the model. These 
dimensions are called driving dimensions.

Where to Find It � From the menu select Insert, Model Items....

� Or, on the Annotations toolbar, click .

8 Insert Model Items.

Click Insert, Model Items and Import from the 
Entire model. 

Click the options for Marked for drawing and Hole 

Wizard Locations and click Import items into all 

views.

Tip The Marked for drawing option selects those dimensions which were 

marked in the part. The marking option  appears in the Modify tool 
where dimension values are set. By default, all dimensions are marked 
for import into the drawing. Unmarked dimensions appear with blue 
text.
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9 Resulting Dimensions.

The dimensions are added into 
the drawing, but generally not 
at their final locations. Placing 
dimensions carefully in the 
model when you sketch will 
save time when they are 
imported into the drawing.

Once the dimensions are 
inserted, they are associated to 
that view and will move with it 
unless you deliberately move them to another view or delete them.

Manipulating 
Dimensions

Once dimensions have been added to a view, there are several options 
as to how they can be manipulated:

� Drag them into position.

Drag dimensions by their text to new locations. Use the inference lines 
to align and position them.

To facilitate positioning dimensions, the 
Drawings settings on the Tools, Options, 

System Options dialog box has two Detail item snapping options. 
The inferences are displayed when you drag a dimension or note by its 
center or corner.

� Hide them.

Some dimensions created in the model have limited use in the drawing 
so you might want to hide them. Right-click the dimension text and 
select Hide from the shortcut menu. The dimension will be removed 
from the drawing sheet, but not from the model’s database.

� Move or Copy them to other views.

Many times a feature can be dimensioned in more than one view. The 
dimension may not automatically appear in the view where you want it. 
You can move dimensions between views as long as the destination 
view can display that dimension.

To move a dimension hold down Shift and drag the dimension to 
another view. To copy the dimension, hold down Ctrl and drag it into 
another view and drop it.
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10 Repositioning dimensions.

The top view contains several 
dimensions. Some of them will 
be repositioned into the right 
view.

11 Moving a dimension.

In this case, move the 1.500 
dimension from the top view to 
the right side view using the 
Shift-drag technique.

12 Delete dimensions.

Delete the diameter dimensions shown. They will be replaced by Hole 

Callouts, a type of annotation that is a driven dimension.

Note Deleting a dimension in the drawing does not delete it from the model. 
Deleted dimensions can be re-inserted from the model.
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13 Dimensions after moving and deleting.

The illustration below shows the result of moving several other 
dimensions into the right side view. It also shows the results of 
rearranging the dimensions in the top view.

Driven 
Dimensions

Not all of the dimensions you need on a drawing may be present in the 
model. Sometimes, because of the way the model was built, there is no 
dimension to import into the drawing. When this happens, the 
dimension has to be inserted manually using the same dimension tool 
you use when sketching. This type of dimension is called a driven 
dimension because its value is driven by the model. Unlike driving 
dimensions, you cannot change its value and thereby change the model.

Dimension Display By default, driven dimensions are displayed differently than driving 
dimensions:

The value is enclosed in parentheses. This is accepted practice for 
reference dimensions.

They are displayed in a different color, in this case, gray.

14 Dimensioning.

Click Vertical Dimension .

Dimension the overall height of the vertical 
boss.

Click the tool again to turn it off.
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15 Display options.

The appearance of a dimension 
can be changed in many ways. 
Right-click the dimension and 
clear the Display Options, 

Show Parentheses option.

Associativity 
Between the Model 
and the Drawing

In the SolidWorks software, everything is associative. If you make a 
change to an individual part, that change will propagate to any and all 
drawings and assemblies that reference it.

Procedure To change the size of the BasePlate feature follow this procedure:

16 Switch windows.

Press Ctrl+Tab to switch back to the part document window.

Changing 
Parameters

SolidWorks mechanical design automation software makes it very easy 
to make changes to the dimensions of your part. This ease of editing is 
one of the principal benefits of parametric modeling. It is also why it is 
so important to properly capture your design intent. If you don’t 
properly capture the design intent, changes to dimensions may cause 
quite unexpected results in your part.

Rebuilding the 
Model

After you make changes to the dimensions, you must rebuild the model 
to cause those changes to take affect.

Rebuild Symbol If you make changes to a sketch or part that require the part to be 

rebuilt, a rebuild symbol  is displayed beside the part’s name as well 
as superimposed on the icon of the feature that requires rebuilding 

. Look for the rebuild icon on the Status Bar, also.

The rebuild symbol also is displayed when you edit a sketch. When you 
exit the sketch, the part rebuilds automatically.

Introducing: Rebuild Rebuild regenerates the model with any changes you have made.

Where to Find It � Click Rebuild  on the Standard toolbar.
� Or, on the Edit menu, click Rebuild.
� Use the keyboard shortcut Ctrl+B.
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Refreshing the 
Screen

If you simply want to refresh the screen display, removing any graphic 
artifacts that might remain from previous operations, you should use 
Redraw, not Rebuild.

Introducing: Redraw Refreshes the screen, but does not rebuild the part.

Where to Find It � From the View menu, click Redraw.
� Use the keyboard shortcut Ctrl+R.

Rebuild vs. Redraw Redraw will not cause changes to dimensions to take affect. Therefore, 
it is very fast. Rebuild regenerates the model. Depending on the 
complexity of the model, this can take more time.

17 Double-click on the feature.

You can double-click on the 
BasePlate feature either in the 
FeatureManager design tree or the 
graphics window. When you do this, 
the parameters associated with the 
feature will appear.

Double-click on the 4 inch 
dimension indicated. The Modify dialog box will appear. Enter a new 
value either by typing it directly or by using the spin box arrows. Enter 
6 inches.

18 Rebuild the part to see the 

results.

You can Rebuild the part either 
by clicking on the Rebuild tool 

 on the Modify box or on the 
Standard toolbar. If you use the 
one on the Modify dialog box, the 
dialog box will stay open so you 
can make another change. This 
makes exploring “what if” scenarios easy.
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19 Update the drawing.

Switch back to the drawing 
sheet. The drawing will update 
automatically to reflect the 
changes in the model.

Introducing: Hole 

Callouts

The Hole Callout tool is used to add driven diameter dimensions to 
holes created by the Hole Wizard or circular cut features. It is one of 
many annotations available in SolidWorks.

These annotations can be added automatically using Insert Model 

Items.

� Click Insert, Annotations, Hole Callout.

� Or on the Annotations toolbar, click Hole Callout .
� Or right-click and select Annotations, Hole Callout.

20 Add Hole Callouts.

Click the center hole in the front 
view and place the annotation on 
the drawing. Select the left of the 
two holes in the top view and 
place.

Note The “2X”prefix is added 
automatically because there are 
two drilled holes.

21 Save and close the part and 

drawing.
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Exercise 4:
Plate

Create this part using the 
information and dimensions 
provided. Sketch and extrude 
profiles to create the part. This 
lab reinforces the following 
skills:

� Sketching

� Base Extrusion

� Boss Extrusion

� Hole Wizard

Design Intent Use the design intent to create the part.

1. The part is not symmetrical.
2. The hole is an ANSI Metric Drill Size hole.

Dimensions Use the following graphics with the design intent to create the part.
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Exercise 5:
Basic-Changes

Make changes to the 
part created in the 
previous lesson.

This exercises uses 
the following skills:

� Changing 
Dimension 
Values.

Procedure Open an existing part in the Exercises folder.

1 Open the part

Basic-Changes.

Several changes will be 
performed on the model to resize 
it and check the design intent.

2 Overall dimension.

Double-click the first feature (Base Plate) in the FeatureManager or 
on the screen to access the dimensions. Change the length dimension to 
6in (shown bold and underlined below) and rebuild the model.
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3 Boss.

Double-click the Vert boss feature and change the diameter and 
height dimensions as shown. Rebuild the part.

4 Hole locations.

Double-click the 9/32 Holes feature and change the position 
dimensions to 0.75in each. Rebuild the model.

5 Center the Vert Boss.

Determine the proper value and change the dimension that centers the 
Vert Boss on the base.

6 Save and close the part.
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Exercise 6:
Bracket

Create this part using the 
information and dimensions 
provided. Sketch and 
extrude profiles to create the 
part.

This lab reinforces the 
following skills:

� Sketching.
� Bosses.
� Holes.

Design Intent The design intent for this part is as follows:

1. The boss is centered on the rounded end of the base.
2. The hole is a through hole and is concentric to the boss.

Use the Part_MM template.

Dimensioned View Use the following graphics and the design intent to create the part. 

As an aid to constructing this 
part, visualize how it could be 
broken down into individual 
features:
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Exercise 7:
Working with 
Fractions

Create this part using the information 
and fractional dimensions provided. 
Sketch and extrude profiles to create 
the part. This lab reinforces the 
following skills:

� Entering and displaying 
dimensions as fractions.

� Bosses.
� Cuts.
� Fillets.
� Blind and Through All end 

conditions.

Fractions There are two things to consider when working with dimensions that 
are given in fractions:

1. Setting the document units to fractional inches.
2. Entering dimension values as fractions.

Document Units On the Tools, Options dialog, click the Document Properties tab and 
select Units. The two types of length units that support Fractions are:

� Inches

� Feet & Inches

When you choose Fractions, 
you should specify the default 
Denominator. Dimensions that 
are evenly divisible by this 
denominator are displayed as fractions. How dimensions are displayed 
that are not evenly divisible depends on whether you select the Round 

to nearest fraction option.

For example, if the Denominator is set to 16 and you enter a value of 
3⁄64 the value will display as 1⁄16 if Round to nearest fraction is 
selected. It will display as 0.047 if it is not selected.

Entering 

Dimensions

You can enter dimensions as fractions regardless of whether the 
document units are set to fractions. To enter a value such as 1 7⁄8”, 
type 1, press the Spacebar, then type 7/8, and press Enter.

Design Intent The design intent for this part is as follows:

1. The side to side cut is centered on the corner.
2. The front to back cut is centered at the midpoint of the edge.

Use the Part_IN template.
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Views Use the following graphics to help 
visualize the part. 

1 New part.

Open a new part using the Part_IN template.

2 First feature.

Create the first feature 
using a sketch and an 
extruded boss. You can 
use either the Front, 
Top or Right reference 
plane for sketching.

3 Cut Feature.

Using a sketch containing a 
circle, create an extruded cut 
feature. The circle is 
centered on the corner 
(vertex) of the first feature.
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4 Second cut feature.

Create a second extruded cut 
using a circle. This circle 
should be centered at the 
midpoint (halfway along the 
edge).

5 Fillet/Round.

Using the edge created by the cuts, 
create a fillet/round feature.

6 Save and close the part.
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Exercise 8:
Part Drawings

Create this part drawing using the information 
provided. 

This lab reinforces the following skills:

� Drawing Sheets.
� Drawing Views.
� Center Marks.
� Dimensions.
� Hole Callouts.

Use the A-Scale1to2 template and the built part Basic-
Changes-Done.

Dimensioned View Use the following graphics to create the drawing.
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Exercise 9:
Guide

This lab reinforces the 
following skills:

� Sketch lines, arcs, circles 
and fillets.

� Relations.
� Extrusions.
� Fillets and rounds.

Design Intent Some aspects of the design intent 
for this part are:

1. Part is not symmetrical. 
2. Large circle is tangent to 

outer edge.
3. Large circle is coincident 

with underside brace edge.
4. Plate thicknesses are equal.

Procedure Open a new part using the Part_MM template.

1 Sketch the profile.

Using the Front 
plane, create the 
profile.

2 Extrusion.

Extrude the sketch 10mm.
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3 Upper sketch.

Start a sketch on 
the top face of the 
model. The circle 
is tangent to one 
edge and 
coincident to 
another edge.

4 Extrude equal 

thickness.

Extrude the circle the same 
thickness as the first feature.

5 Add two fillets.

Add two fillets as 
shown.

6 Last fillet.

Create a third fillet 
with a 20mm radius.
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7 Cuts.

Use symmetry with lines and arcs to create a Through All cut for the 

slot shape. Use a circle to create another cut concentric with the model 

edge.

Note This sketch requires the use of a Parallel relation. Check the Help, 

SolidWorks Help Topics for more information.

8 Save and close the part.
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Lesson 4
Modeling a Casting

or Forging

Upon successful completion of this lesson, you will be able to:

� Open a SolidWorks part and save your work.

� Sketch on a system defined plane or a planar face of a model.

� Use the view display and modification commands.

� Create fully defined sketches through the use of dimensions and 
geometric relationships.

� Create base and boss features by extrusion.

� Create cut features by extrusion.

� Copy and paste features.

� Create constant radius fillets.

� Edit the definition and parameters of a feature and regenerate the 
model.

� Use Up To Next and Mid Plane end conditions to capture design 
intent.

� Use symmetry in the sketch.
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Case Study: 
Ratchet 

The Ratchet contains many of 
the features and procedures that 
you will use frequently. It contains 
bosses, cuts, sketch geometry, 
fillets and draft.

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 
following list. Each of these topics comprises a section in the lesson.

� Design intent

The overall design intent for the part is discussed. 

� Boss feature with draft

The first portion of the model to be created is the Handle. The 
Handle uses sketched lines and is extruded in two directions with 
draft forming a solid. It is the initial feature of the part and 
demonstrates the use of mirroring in the sketch.

� Up To Next end condition

The second portion of the model is the Transition. It uses the Up 

To Next end condition to connect to the Handle’s faces.

� Sketching inside the part

The third boss created is the Head. It is sketched within the solid 
created by the Transition.

� Cut using existing edges

The Recess is the first cut type feature created. It uses an offset from 
the existing edges of the model to create the sketch. It is extruded as a 
offset cut to a specific depth.

� Cut with trimmed sketch geometry

The Pocket is another cut feature, this time using circles that are 
trimmed to the proper shape.

� Cut using copy and paste

The Wheel Hole feature will be copied and pasted.

� Filleting

Fillets and rounds are added to the solid using several different 
techniques. 

� Editing a feature’s definition

Features that already exist can be changed using Edit Feature. Fillets 
will be edited in this way. 
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Design Intent The general design intent of the Ratchet is summarized in the 
illustration and list below. Specific design intent for each portion of the 
part is discussed separately. 

� Centering: The Head, Handle and Transition features are 
centered along an axis. 

� Symmetry: The part is symmetrical, both with respect to a 
longitudinal centerline and with respect to the parting plane.

Head

Handle

Transition

Pocket Recess

Thru Holes 
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Boss Feature 
with Draft

The first part of the Ratchet we will model is the Handle. The first 
feature in any model is sometimes referred to as the base feature. All 
other features are built onto the first feature. 

Building the 
Handle

The Handle has a 
rectangular cross 
section. It is extruded 
with draft an equal 
distance in opposite 
directions from the 
sketch plane. 

Design Intent of 
the Handle 

The Handle is a sketched feature that uses lines 
and mirroring to form the basic outline or profile. 
The profile is extruded in opposite directions, 
equally, with draft. The sketch creates a 
rectangular cross section that is extruded equally 
in opposite directions with draft. 

� Draft: The draft angle is equal on both sides of the parting plane

� Symmetry: Feature is symmetrical with respect to parting plane 

and the centerline axis of the Handle

A centerline, a piece of reference geometry, will be used to 

position and sketch the Handle sketch.

The centerline represents distance from the end of the handle to 
the center of the furthest hole and is also used in mirroring 
sketch geometry.

Procedure Begin by following this procedure:

1 New Part.

Open a new part using the Part_MM template on the Training 

Templates tab. Save the part and name it Ratchet.

2 Display off.

Toggle the display of relations off using View, Sketch Relations.

Handle Section

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 4 SolidWorks 2006 Training Manual
Modeling a Casting or Forging

102 Symmetry in the Sketch

Note Further lessons will assume that View, Sketch Relations is toggled off.

3 Sketch plane.

Select the reference plane Top as the sketch plane. Change the view to 
a Top view.

Introducing: Insert 

Centerline

Insert Centerline is used to create a reference line in a sketch. The 
centerline can be vertical, horizontal, or an arbitrary angle depending 
on how the inferences are used. Because the centerline is considered 
reference geometry, it does not have to be fully defined in the sketch.

Where to Find It � Click Tools, Sketch Entity, Centerline.
� Or, on the Sketch toolbar click Centerline .

Note Any piece of sketch geometry can be converted into construction 
geometry or vice-versa. Select the geometry and click the 

Construction Geometry  tool on the Sketch toolbar.

The PropertyManager can also be used to change 
sketch geometry into construction geometry. Select 
the geometry and click For construction.

4 Sketch a centerline.

Sketch a centerline running vertically from the origin. The length is 
not important.

Symmetry in 
the Sketch

Symmetrical geometry in a sketch can be created easily using the 
Mirror option. You can mirror as you sketch – real time mirroring. Or, 
you can select already sketched geometry and mirror it – after the fact 
mirroring. Also, Symmetric relations can be added to geometry after 
sketching.

In any case, mirroring creates copies that are related to the originals by 
the Symmetric relation. In the case of lines, the symmetric relation is 
applied to the endpoints of the lines. In the case of arcs and circles, the 
symmetric relation is applied to the entity itself. The three methods are 
listed below.

� Symmetry while sketching

� Symmetry after sketching

� Symmetry through relations
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Introducing: 

Dynamic Mirror

Mirroring requires a line, linear edge or centerline. The line is activated 
before sketching the geometry to be mirrored.

Where to Find It � From the Tools menu choose: Sketch Tools, Dynamic Mirror.

� Or, on the Sketch toolbar click Dynamic Mirror .

Symmetry While 

Sketching

Symmetric geometry can be created in real time as you sketch. The 
Dynamic Mirror method enables mirroring before sketching.

Symmetry after 
Sketching

Symmetry can be created by sketching one half of the geometry and 
using mirroring to create the other. The symmetry is applied after 
sketching.

5 Dynamic mirror.

Select the centerline and click the Dynamic Mirror tool. The 

Dynamic Mirror symbol  appears at both ends of the centerline.

6 Sketch line.

Sketch a line from the upper end of the centerline moving to 
the right. A mirror image of the line is created on the opposite 
side of the centerline.

7 Complete the sketch.

Add a line in the vertical direction and then horizontal, 
stopping at the centerline. Turn off the mirror tool.

Tip Do not cross the centerline while sketching in the Automatic 

Mirror mode. If you do, duplicate geometry can be created. 
Stopping at the centerline caused the symmetrical lines to be 
merged into a single line.
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Automatic 
Dimensioning of 
Sketches

Autodimension creates dimensions in a sketch. Several dimension 
styles, such as baseline, chain and ordinate are supported. The starting 
points for horizontal and vertical sets can be set. This tool does not add 
geometric relations to the sketch.

Introducing: Auto-

dimension 

Autodimension has options for dimension type, entities to be 
dimensioned and starting points.

Note A special option Centerline appears when centerline geometry is used 
in the sketch. Dimensions can be based from the centerline.

Where to Find It � Click Tools, Dimensions, Autodimension....
� Or, on the Dimensions/Relations toolbar, click the 

Autodimension  tool.

Underdefined sketch with 
geometric relations.

Chain option selected with 
start points at origin.

Note: Some dimensions 
have been moved for 
clarity.

Baseline option selected 
with start points at origin.

Ordinate option selected 
with start points at origin.
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8 Autodimension setup.

Click the Autodimension  tool.

Click in the Datum field for the Horizontal 

Dimensions and select the vertical 
centerline. For the Vertical Dimensions, 
select the endpoint of the centerline.

Set both Schemes to Baseline.

9 Dimensions.

The dimensions are added, changed and moved for 
clarity. 

Note Sketches dimensioned with Autodimension are fully defined but may 
not be dimensioned exactly the way you want. You can delete and 
replace dimensions if required.
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First Feature The first feature, is always a boss, and is the first solid feature created 
in any part. In this part, the first feature created is a Mid Plane 

extrusion.

10 Base/Boss Extrusion.

Click the Extruded Boss/Base tool  on the Features toolbar or click 
Boss/Base Extrude from the Insert menu.

11 Extrusion.

Choose the Mid Plane 

option from the list and enter 
a depth of 15mm. Click 

Draft  and set the angle to 
8°. The Draft Outward 
check box should be cleared.

Click OK to create the 
feature.

12 Completed feature.

The completed feature is shown at the right. 
Name the feature Handle.Pre-
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Sketching 
Inside the 
Model

The second feature in the part is the Transition, another boss that 
will connect the Head to the Handle feature. The sketch for this 
feature is created on a standard reference plane. 

Design Intent of 
the Transition

The Transition feature is a 
simple circular profile that is 
extruded up to the existing Handle 
feature.

� Centering: The circular profile 
is centered on the Head feature. 

� Length: The length of the 
section is determined using 
existing locations.

13 Showing the Front plane.

Switch to an isometric view and 
select the Front Plane from the 
FeatureManager design tree. It will be 
highlighted on the screen.

To make sure the plane stays visible, 
right-click the Front Plane in the 
FeatureManager design tree, and select 
Show from the menu. The plane will appear shaded and transparent.

14 Plane settings and changes.

There are settings to determine how that planes will appear on the 
screen. For shaded planes, click Tools, Options, System Options, 

Display/Selection and select the Display shaded planes check box. 
Set the color of the plane using Tools, Options, Document 

Properties, Plane Display.

Transition Section
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Any plane, system or user generated, can be resized 
by dragging its handles. Resize this plane so that its 
borders lie closer to the boundaries of the feature. 

The planes can also be automatically sized to the 
model. Right-click the plane and choose AutoSize.

Circular Profile The sketch for the Transition feature has very simple geometry 
and relations. A circle is sketched and related to a position on the 
previous feature to define it. This relation will keep the Transition 
centered on the Handle feature.

15 Open a new sketch.

With the Front Plane still selected click the Sketch tool . The 
plane is now a sketch plane.

Introducing: View 

Normal To

The View Normal To option is used to change the view orientation to a 
direction normal to a selected planar geometry. The geometry can be a 
reference plane, sketch, planar face or feature that contains a sketch.

Tip Clicking the Normal To icon a second time will flip the orientation 
around to the opposite side of the plane.

Where to Find It � Click Normal To  on the Standard Views toolbar.
� Or, press the Spacebar and double-click Normal To.

16 Normal To view orientation.

Using the View Orientation dialog box, 
change to the Normal To orientation. To 
do this, select the Front plane and 
double-click the Normal To option in the 
View Orientation dialog box. This orients 
the view so you can see the plane’s true 
size and shape and makes sketching 
easier.

Tip You can also select the plane and click the Normal To tool  on the 
Standard Views toolbar.
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Introducing: 

Sketched Circles

The circle tool is used to create circles for cuts and bosses in a sketch. 
The circle is defined by either Center or Perimeter creation. Center 
requires two locations: the center, and a location on its circumference. 
Perimeter requires locations that represent two (or optionally three) 
locations on the perimeter.

Where to Find It � From the Tools menu, select Sketch Entities, Circle or Perimeter 

Circle.

� Or, on the Sketch toolbar click Circle  or Perimeter Circle .

Sketching the 
Circle

Many inference points can be used to locate circles. You can use the 
center of previously created circles, the origin and other point locations 
to locate the circle’s center. In this example, we will automatically 
capture a coincident relation to the origin by sketching the center of the 
circle on it.

17 Add a circle and dimension it.

Using the Circle Tool, add the circle at 
the origin.

Add the diameter dimension to fully 
define the sketch. Set the value to be 
12mm. The sketch is fully defined.

Changing the 
Appearance of 
Dimensions

With the dimensioning standard currently in use, diameter dimensions 
are displayed with one arrow outside the circle. You can change the 
display so that two arrows are inside of the circle. 

18 Click the dimension.

Two small green dots will appear on the 
arrowheads of the dimension.
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19 Toggle the arrows.

Click one of the green dots to toggle the 
arrows to the inside of the circle. This 
works on all dimensions, not just diameter 
dimensions.

Click again to place the arrows outside.

20 Hide the Front Plane.

21 Change to Isometric view.

Unlike when you created the first 
feature, the system will not switch 
view orientations automatically for 
any other bosses or cuts. Use the 
View Orientation dialog box or the 
Standard Views toolbar to change 
to an Isometric view. 

Extruding Up To 
Next

The sketch will be extruded up to the next face(s) it encounters along 
its path. It is important to watch the preview graphics to determine that 
the boss is going in the proper direction, reversing the direction if 
necessary.

22 Up To Next extrusion.

Click Insert, Boss/Base, 

Extrude... and watch the preview 
display. Change the direction so 
that the preview shows the 
extrusion running towards the 
Handle.

Change the end condition to Up 

To Next.

Click OK.

Rename the feature to 
Transition.
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Up To Next vs. Up To 

Surface

The end conditions Up To Next and Up To Surface generate different 
results in many cases. The image on the left is for Up To Surface when 
the angled (red) face is selected. The extrusion is shaped by the selected 
surface. Only one surface selection is allowed. The image on the right 
is for Up To Next. All faces in the path of the extrusion are used to 
shape the extrusion.

Design Intent of 
the Head

The Head is a sketched feature that uses lines and tangent arcs to form 
the basic outline or profile. The profile is extruded in opposite 
directions, equally, with draft. This feature is the key feature of the part. 
It will contain pockets and holes used for the location of other parts.

The design intent of the Head is listed below:

� Arc Centers: The 
centers of the two 
arcs in the outline 
(profile) line up 
vertically in a Top 
view orientation. 
The radii are not 
equal, and can 
change to any 
value.

� Profile Location: 

The sketch geometry is located on the parting plane of the solid 
with the larger arc centered with respect to the model origin.

� Draft: The applied draft is equal on both sides of the parting plane.

� Thickness: The thickness of the part is equal on both sides of the 
parting line.

Parting Line
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� Symmetry: 

The geometry 
is symmetrical. 

23 Centerline.

Select the reference plane Top as the sketch plane. Orient the 
view to the same direction. Start off the sketch with a centerline 
as shown.

Introducing:

Centerpoint Arc

Centerpoint Arc creates an arc based on a center, start point and an 
end point. 

Where to Find It � From the Tools menu choose Sketch Entities, Centerpoint Arc....
� Or, right-click in the graphics window and select Centerpoint Arc.

� Or, on the Sketch toolbar, pick the Centerpoint Arc  tool.

24 Sketch a centerpoint arc.

Select the Centerpoint Arc tool  and click 
first at the origin (1).

Move out to establish the radius and start 
point and click again (2).

Move to establish the end point and click a 
final time (3).

Repeat the procedure for an arc on the open 
end of the centerline.

Head Section

1
2

3
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25 Complete the sketching.

Sketch a line from endpoint to endpoint. Note 
that the endpoints are not tangent to the line. Add 
these relations:

� Tangent between the line and each arc.

� Coincident between the centerline and each 
open arc endpoint.

26 Add dimensions.

Add one linear and two radial dimensions to the sketch.

Introducing: Mirror 

Entities

Mirroring requires a line, linear edge or centerline. This line defines the 
mirror plane which is always normal to the sketch plane and passes 
through the selected centerline.

Where to Find It � From the Tools menu choose: Sketch Tools, Mirror.

� Or, on the Sketch toolbar click Mirror Entities .

27 Mirror.

Click the Mirror tool . Select the 
two arcs and connecting line as 
Entities to mirror.

Click in Mirror about and select 
the centerline.

The geometry will be mirrored 
about the centerline.
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Driven Dimensions Driven or Reference Dimensions can be created in any sketch. 
SolidWorks guides you towards creating this type whenever 
dimensions are added to geometry that is already fully defined. A 
Driven dimension is indicated with a color difference. The driven 
dimension will always display the proper value but can never be used 
to force a change in the model.

Overdefined 

Sketches

If the status of the sketch changes to from fully defined to over defined 
(see Status of a Sketch on page 29), a diagnostic tool appears. This tool 
can be used to repair the sketch. Other unfavorable states can be 
repaired as well.

28 Angular dimension.

Click the Dimension tool and select the pair of 
angled lines. Position the dimension text below the 
sketch, between the lines.

29 Driven message.

The next message gives you the choice of making 
the dimension driving or driven. The default 
selection, Make this dimension driven, is 
controlled by Tools, Options. Select Leave this 

dimension driving and click OK. The sketch 
becomes Over Defined.

Resolve Conflicts The Resolve Conflicts option is used to repair Over Defined, No 
Solution Found, or Invalid Solution Found conditions in the sketch. 

Note General part editing and repairs will be discussed in Lesson 7:  Editing: 

Repairs.

Where to Find It � Click the Over Defined (or other condition) button in the lower 
right corner.

30 Over defined.

When the sketch becomes Over 
Defined, a message pops up from 
the lower right corner of the 
screen. Click the Over Defined 
button.
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31 Diagnose.

Click Diagnose to determine possible solution sets 
to resolve the over defined state.

Deleting and of these sets will remove the over 
defined state.

32 Delete.

Select the Distance1 relation and click Delete.

33 Conflict resolved.

Set the angle dimension to 20 degrees.

34 The extrusion.

Change to an Isometric view and 
click Insert, Boss/Base, Extrude... 
from the menu. Set the type to Mid 

Plane, depth to 20mm and draft to 
6°. Rename the latest feature to 
Head.

The three main features that make up 
the overall shape of the part are now complete. 

View Options The SolidWorks software provides you with many options for 
controlling and manipulating how models are displayed on your screen. 
In general, these view options can be divided into two groups. These 
groups correspond to the two sub-menus that are available on the View 
menu and the two groups of tools on the view toolbar.

Note These view options are available for use in single and multiple 
viewport situations. For more information, see Viewports on page 63. 
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� Display Options

� Modify OptionsPre-
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Display Options The following illustrations of the Ratchet illustrate the different 
types of display options.

Note The Perspective and Section view options can be applied to any type 
of view – wireframe, hidden line, or shaded. The Draft Quality HLR/

HLV tool  can be active with all view types but affects only the 
Hidden Lines Removed and Hidden Lines Visible options by making 
the display faceted and faster to manipulate.

Modify Options The modify options are listed below next to their corresponding tools. 
Your instructor will demonstrate these during class.

Note It is notoriously difficult to illustrate something as dynamic as view 
rotation via a medium as static as a printed manual. Therefore, the 
different view options are only listed and summarized here. Your 
instructor will demonstrate them for you in class.

Zoom to Fit: Zooms in or out so the entire model is visible.

Zoom to Area: Zooms in on a portion of the view that you select 

by dragging a bounding box. the center of the box is marked with 
a plus (+) sign.

Zoom In/Out: Zooms in as you press and hold the left mouse 

button and drag the mouse up. Zooms out as you drag the mouse 
down.

Zoom to Selection: Zooms to the size of a selected entity.

Wireframe Hidden Lines Visible Hidden Lines Removed

Shaded Perspective Section

Shadows in Shaded ModeZebra Stripes Shaded With Edges
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Rotate View: Rotates the view as you press and hold the left 

mouse button and drag the mouse around the screen.

Pan View: Scrolls the view so the model moves as you drag the 

mouse.

Middle Mouse 
Button Functions

The middle mouse button on a three button mouse can be used to 
dynamically manipulate the display. Using the middle mouse button 
you can:

� Rotate the view

Press and hold the middle mouse button. As you move the mouse, the 
view rotates freely.

Tip To rotate about a vertex, edge, axis or temporary axis:

Click the middle mouse button on the geometry. As you move the 
mouse, the view rotates about that selected geometry.

� Pan or scroll the view

Press and hold the Ctrl key together with the middle mouse button. The 
view will scroll as you drag the mouse.

� Zoom the view

Press and hold the Shift key together with the middle mouse button. 
The view will zoom larger as you drag the mouse upward; smaller as 
you drag the mouse downward.

Note In a drawing, only the Zoom and Pan functions can be used.

Keyboard 
Shortcuts

Listed below are the predefined keyboard shortcuts for view options:

� Arrow Keys  . . . . . . . . . . . . . . . . Rotate the view

� Shift+Arrow Keys  . . . . . . . . . . . Rotate the view in 90° increments

� Alt+Left or Right Arrow Keys  . Rotate about normal to the screen

� Ctrl+Arrow Keys . . . . . . . . . . . . Move the view

� Shift+z  . . . . . . . . . . . . . . . . . . . . Zoom In

� z. . . . . . . . . . . . . . . . . . . . . . . . . . Zoom Out

� f . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom to Fit

� Ctrl+1  . . . . . . . . . . . . . . . . . . . . . Front Orientation

� Ctrl+2  . . . . . . . . . . . . . . . . . . . . . Back Orientation

� Ctrl+3  . . . . . . . . . . . . . . . . . . . . . Left Orientation

� Ctrl+4  . . . . . . . . . . . . . . . . . . . . . Right Orientation

� Ctrl+5  . . . . . . . . . . . . . . . . . . . . . Top Orientation

� Ctrl+6  . . . . . . . . . . . . . . . . . . . . . Bottom Orientation

� Ctrl+7  . . . . . . . . . . . . . . . . . . . . . Isometric Orientation

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 4
Modeling a Casting or Forging

Using Model Edges in a Sketch 119

� Ctrl+8  . . . . . . . . . . . . . . . . . . . . . View Normal To

� Spacebar  . . . . . . . . . . . . . . . . . . View Orientation dialog

Using Model 
Edges in a 
Sketch

The first Cut feature to be added is the Recess, a pocket that is 
extruded down from the top face of the Head. This feature allows for 
the placement of a cover plate over the ratchet gears. Since the cover is 
the same general shape as the top face, it would be helpful to take 
advantage of the edges of the Head when sketching the profile for the 
Recess cut. We will do this by making an Offset of the edges of the 
Head.

Zoom to Selection The Zoom to Selection option zooms in on a selected entity, making it 
fill the screen.

35 Select face and zoom.

Select the top face of the Head 

and click Zoom to Selection . 
That face will fill the graphics 
window.

Sketching an 
Offset

Offsets in a sketch rely on existing model edges or sketch entities in 
another sketch. In this example we will utilize the model edges of the 
Head. These edges can be chosen singly, or as the boundary of an 
entire face.When possible, it is a good idea to pick the face because the 
sketch will regenerate better if subsequent changes add or remove 
edges from the face.

The edges are projected onto the plane of the sketch, regardless 
whether they lie on that plane or not.

Introducing: 

Offset Entities

Offset Entities is used to create copies of model edges in a sketch. 
These copies are offset from the original by some specified amount.

Where to Find It � From the Tools menu, select Sketch Tools, Offset Entities....

� Or, on the Sketch toolbar click Offset Entities .
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36 Offset the face boundaries.

Select the top face and click the 
Sketch tool. With the face still 
selected click the Offset tool on 
the toolbar. Set the distance value 
to 2mm and Reverse the 
direction if necessary, moving the 
offset to the inside.

37 Resulting Offset.

The offset creates two lines and two arcs. This 
geometry is dependent on the solid face it came 
from and will change with the solid. The sketch 
is automatically fully defined and ready to 
extrude as a cut. 

38 Settings for the cut.

Choose a Blind cut with 2mm for the depth value 
and click OK.

39 Rename the feature.

Change the name of the feature to Recess. 

Creating 
Trimmed Sketch 
Geometry

The Pocket is another cut feature, applied to a planar face of the 
model. This sketch uses overlapping circles that are trimmed to create a 
single contour. The centers of the circles are related to existing circular 
centerpoints.

40 Sketch circles.

Select the top, inner face created by the last feature 

as the sketch plane. Using the Circle tool , 
create a circle using the existing centerpoint 
location as the circle’s origin. Snapping to this 
location will relate the circle to it automatically. 
Create a second circle off to the side of the model.
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41 Relate the centers.

Click Add Relation  to open the Add 

Relations PropertyManager. Select the second 
circle and the edge of the cut. Choose the 
Concentric option and click OK. Concentric 
forces the two arcs (the circle and the circular 
edge) to share a common center. This will pull 
the circle into position.

Trim and Extend Sketch entities can be trimmed shorter using the Trim option. In this 
example, the overlapping portions of the circles will be removed. There 
are several trimming options: Power Trim, Corner, Trim away inside, 
Trim away outside and Trim to closest. They can also be lengthened 
using Extend. They are discussed below.

Introducing: Trim Trim can be used to shorten sketch geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Trim.

� Or, on the Sketch toolbar click Trim Entities .

Power trim  
removes the portion of 
an entity that you drag 
over between 
intersections or to an 
endpoint.

The Corner  option 
is used to trim by 
keeping the geometry 
selected to a common 
intersection.
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Introducing: 

Extend

Extend can be used to lengthen sketch geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Extend.

� Or, on the Sketch toolbar click Extend Entities .

Use the Trim away 

outside  to keep the 
inside portions if 
geometry against a 
boundary. Select the 
two boundaries (B) 
first then the pieces of 
geometry to trim (T).

Use Trim away inside 

 to keep the outside 
portions if geometry 
against a boundary. 
Select the two 
boundaries (B) first 
then the pieces of 
geometry to trim (T).

Use Trim to closest 

 to trim selected 
geometry to the nearest 
intersection or remove 
a portion of the 
geometry between 
boundaries.

B

B
T

T

B

B
T

T

T

Select nearest the end 
to extend and click to 
extend to the next 
intersection.

Drag the nearest 
endpoint and drop it on 
the intersecting entity 
to extend.
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42 Trim the circles.

Click on the Trim tool and select the 
Power trim option. 

Rule Drag across the portions of the sketch 

entities that you want to remove.

The system will find the intersections 
between the circles and remove the 
excess.

43 Add dimensions.

Add dimensions to the arcs. This will fully define 
the sketch.

44 Turn off the dimension tool.

An easy way to turn off the dimension tool is to 
simply press the Esc key on the keyboard.

Modifying 
Dimensions

Since the sketch entities are arcs, the system automatically created 
radial dimensions. If you prefer diameter dimensions, you can quickly 
change the display options. For more in-depth dimension changes, 
right-click the dimension, and select Properties.

45 Diameter dimensions.

Select the dimensions, right-click and choose 
Display Options, Display As Diameter.
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Introducing: Offset 

From Surface

The Offset From Surface end 
condition is used to locate the end of 
an extrusion as a measurement from a 
plane, face or surface rather than the 
sketch plane of the feature.

In this example the end of the 
extrusion is measured from the 
bottom face of the part.

The Translate Surface option can be 
checked or cleared. Its meaning is 
explained below.

What the Translate 

Surface option 

does:

The Translate Surface option of the 
Offset From Surface end condition is off 
by default.

In the illustration at the right, both 
columns are positioned below two 
identical semi-circular reference surfaces. 
Both columns are extruded such that the 
top of each is 1.4” below the reference 
surfaces. The column on the left was 
extruded with the Translate Surface 
option on. The column on the right was 
extruded with the option off.

The Offset from Surface option in 
the Translate Surface option defines 
the end condition by linearly 
translating a copy of the surface in the 
direction of the extrusion. Without it, 
the copied surface is created by 
projection normal to the original 
surface. Hence the two different 
results.

Note In this example, the position of the planar face selected means that both 
options reach the same result.

46 Offset From Surface.

Click the Extruded Cut icon and choose the Offset From Surface end 
condition. Set the Offset Distance to 5mm.
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Introducing: Select 

Other

Select Other is used to select hidden faces of the model without 
reorienting it. 

Select Other 

Procedure

To select faces that are hidden or obscured, you use the Select Other 
option. When you position the cursor in the area of a face and press the 
right mouse button, Select Other is available as an option on the 
shortcut menu. The face closest to the cursor is hidden and listed as 1. 
in the dialog under --Hidden Faces--. Other visible faces are numbered 
and listed in the dialog. Moving over them in the dialog highlights them 
on the screen.

The reason the system hides the closest face is since that one was 
visible, if you wanted to select it you would have simply picked it with 
the left mouse button.

47 Face selection.

Right-click over the hidden bottom face and 
choose Select Other. Slide the cursor up and 
down the Select Other list to highlight possible 
face selections. Use the left mouse button to select 
the face directly or select the choice 2. Face from 
the list.

Rename the feature Pocket.

Tip Other faces can be added to the --Hidden Faces-- list. Right-click a face 
to hide it. Press Shift and right-click to unhide it and remove it from the 
list.

Measuring The Measure option can be used for many measurement tasks. Here it 
is used to measure the shortest distance between an edge and a plane. It 
can measure geometry including vertices, edges and faces.

Introducing:

Measure

The Measure command can calculate distances, lengths, surface areas, 
angles, circles and X, Y, Z locations of selected vertices. For circles and 
arcs, the center, minimum and maximum dimensions are available as 
shown below.
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Where to Find It � On the Tools toolbar, click the Measure tool .
� Or from the Tools menu choose Measure....

48 Measure between face and 

vertex.

Click the Measure tool  
and select the face and 
vertex shown.

The Normal Distance is 
5mm. Information for the 
combined selections is 
displayed.
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Tip The Status Bar at the bottom of the SolidWorks window displays some 
similar information when the Measure tool is off. If a circular edge was 
selected, the status bar would show the Radius and Center.

Using Copy and 
Paste

The Ratchet requires two through holes of different diameters. We 
will create one hole and copy and paste it to make the second.

Sketching the Hole Circular holes are very simple to create. A sketch circle, related to the 
model and dimensioned, is all you need. The Hole Wizard could also be 
used to create this hole.

49 Open a sketch.

Click on the inner bottom “figure eight” face and 
open a new sketch. 

50 Create a circular hole.

Sketch a circle centered on the upper center mark 
and add a dimension. Set the diameter to 9mm and 
create a Through All cut.

Name the feature Wheel Hole.

Copy and Paste 
Features

Simple sketched features and some applied features can be copied and 
then pasted onto a planar face. Multi-sketch features such as sweeps 
and lofts cannot be copied. Likewise, certain applied features such as 
draft cannot be copied, although fillets and chamfers can.

Once pasted, the copy has no ties or associativity to the original. Both 
the feature and its sketch can be changed independently.

Copying a Feature Copy features by selecting them and using the standard Windows 

shortcut Ctrl+C or picking the Copy  tool on the Standard toolbar. 
You can also select Copy from the Edit menu. Finally, you can employ 
the standard Windows “drag and drop” technique while holding down 
the Ctrl key.
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51 Identify the feature to copy.

The feature to be copied must be identified either 
in the FeatureManager design tree or on the 
model. For this example, select the feature 
Wheel Hole by picking it in the 
FeatureManager design tree. Next, copy it to the 

clipboard using the Copy  option on the 
Standard toolbar.

Note You may also use Ctrl+C or Edit, Copy to create a copy on the 
clipboard.

52 Select the face on which to paste. 

The copied feature must be pasted onto a planar 
face. Select the bottom inner face, the same one used 
for the sketch plane of the Wheel Hole.

53 Paste the feature.

Paste the copy using the Paste  tool, the shortcut 
Ctrl+V, or Edit, Paste.

54 Copy confirmation.

The Wheel Hole was Concentric to the smaller end of the “figure 
eight” face. The copy carries that Concentric relation with it, except 
the system now has a bit of a problem. It doesn’t know what edge to 
make it concentric to. Therefore, we are given three choices:

� Delete the relationship.
� Keep it even though it is unresolved (dangling).
� Cancel the copy operation altogether.

55 Click Delete.

Dangling 
Relations

Dimensions and relations are said to be dangling when they reference 
something that has been deleted or that is otherwise unresolved. 
Dangling relations can usually be repaired through one or more 
techniques. We will discuss repairing dangling relations later in the 
course in Lesson 7: Editing: Repairs.

56 Feature pasted.

The feature and its sketch are added to the 
FeatureManager design tree and the model. Note 
that the feature is not centered. That is because its 
sketch is, in fact, under defined.
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57 Find the sketch. 

Click the  sign preceding the pasted feature in the 
FeatureManager design tree.

Editing a Sketch Once created, sketches can be changed using Edit Sketch. This opens 
the selected sketch so that you can change anything: the dimension 
values, the dimensions themselves, the geometry or geometric 
relations. 

Introducing: 

Edit Sketch

Edit Sketch allows you to access a sketch and make changes to any 
aspect of it. During editing, the model is “rolled back” to its state at the 
time the sketch was created. The model will be rebuilt when the sketch 
is exited. 

Where to Find It � From the Edit menu, choose Sketch.
� Or, right-click the feature whose sketch you want to edit and select 

Edit Sketch.

Relate and Change 

the Sketch

Since the copy has no relations to the model geometry or the origin, the 
sketch is under defined and should be brought up to a fully defined 
state. Use geometric relations to do this.

58 Edit the sketch of the copied feature.

The copied feature includes both the feature itself and its sketch. The 
sketch defines the shape and size of the profile as well as the location. 
Right-click the feature or its sketch, and select Edit Sketch.

59 Relation and dimension.

The circle and the diameter dimension are in 
the sketch. No other relations or dimensions 
exist to locate the circle. Delete the 
dimension.

Click Add Relation . Select the edge of the 
circle and the edge of the solid and use 
Concentric. Or, use Coincident to align the 
origin and circle centerpoint. The sketch is 
now fully defined.

Add a Concentric Circle Dimension by 
dimensioning the circle and edge.
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60 Rebuild the model.

To cause the changes to the sketch to take effect, 

Rebuild the model by clicking the Rebuild  tool.

Rename the feature Ratchet Hole.

61 Fillets.

Add fillets on edges and faces as shown below.

Editing 
Features

The last fillet to create is around the upper and lower edges of the 
Head. Since this fillet has the same radius as the fillet on the ends of 
the Handle, we will edit this existing fillet to include the edges on the 
Head. This is a better technique than creating a new fillet and trying to 
figure out how to keep their radii equal. To do this we will edit the 
definition of the H End Fillets.

Introducing: 

Edit Feature

Edit Feature changes how a feature is applied to the model. Each 
feature has specific information that can be changed or added to, 
depending on the type of feature it is. As a general rule, the same dialog 
box used to create a feature is used to edit it.

R = 3mm

Name = Handle Fillets

R = 1mm

Name = H End Fillets

R = 2mm

Name = T-H Fillets
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Where to Find It � Right-click the feature to edit – either in the FeatureManager design 
tree or the graphics window, and select Edit Feature.

Editing the Fillet Edit the feature of the H End Fillets to include additional edges.

62 Select and edit the fillet.

Right-click the feature H End 
Fillets, and select Edit Feature. 
Select the additional edges around the 
upper and lower edges of the Head. 
The selection list should now indicate 
a total of 6 edges selected.

63 Save and close the part.
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Exercise 10:
Base Bracket

This lab reinforces the following skills:

� Sketching lines.
� Adding geometric relations.
� Sketching on standard planes.
� Sketching on planar faces.
� Filleting.
� Creating cuts, holes and bosses.

Design Intent Some aspects of the design intent for this part are:

1. Thickness of the Upper 
and Lower features are 
equal.

2. The holes in the Lower 
feature are equal diameter 
and will remain so.

3. The Upper and Lower 
features are flush along the 
back and right side.

Procedure Open a new part using the Part_MM template.

1 Create the Lower feature.

Use lines to sketch this profile. Add dimensions to fully define the 
sketch.

Lower
feature

Upper
feature
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2 Select a face as sketch plane.

Select the rear face that is 
hidden by the top face of the 
model as the sketch plane. Use 
Select Other or rotate the view 
to select it.

3 Create the Upper boss 

feature.

Sketch the lines and relate 
them to the existing edges 
where they should be 
coincident.

4 Extrude.

Extrude into the first feature a depth 
of 20mm.
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5 Create fillets and 

rounds.

Add the fillets in as 
few steps as possible.

Rename the features 
according to fillet 
size.

6 Holes.

Add the holes using as 
few features as possible. 
Make sure that the holes 
lie concentric to the 
fillet radii.

For the Hole Wizard, 
use ANSI Metric Drill 
Sizes.

7 Save and close the part.

20mm

18mm
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Exercise 11:
Ratchet Handle 
Changes

Make changes to the part 
created in the previous 
lesson.

This exercise uses the 
following skills:

� Editing sketches.
� Editing features.

Design Intent Some aspects of the design intent for this part are:

1. The part must remain 
symmetrical about the 
Right reference plane.

2. The Transition requires 
flats that are driven by the 
distance between them.

Procedure Open an existing part.

1 Open the part Ratchet 

Handle Changes.

The change will take place 
in the shape of the 
Transition feature.

2 Edit the sketch.

Right-click the 
Transition feature 
from the screen and 
choose Edit Sketch. 
Modify the sketch to 
add the equally spaced 
horizontal flats 8mm 
apart. Exit the sketch.

Transition
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3 Edit Feature.

Edit the H End Fillets feature 
to add more edges. Select the four 
new edges created by the flats. 
Click OK.

4 Resulting fillets.

The new edges become part of the 
fillet feature, causing the shape of 
the next fillet feature to update.

5 Save and close the part.
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Exercise 12:
Tool Holder

This lab reinforces the following 
skills:

� Sketching.
� Adding geometric relations.
� Trimming.
� Fillets.
� Creating cuts, holes and bosses.

Design Intent Some aspects of the design intent for this part are:

1. All fillets and rounds 0.0625” unless otherwise noted.
2. Circular edges of equal radii/diameter should remain equal.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.
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Exercise 13:
Idler Arm

Create this part using the dimensions provided. Use 
relations and equations where applicable to 
maintain the design intent. Give careful thought to 
the best location for the origin. 

This part can be constructed using only the Top, 
Front and Right reference planes.

This lab uses the following skills:

� Sketching with symmetry.
� Mid-plane and Through All extrusions
� Filleting.

Units: inches or mm

Design Intent The design intent for this part is as follows:

1. The part is symmetrical.
2. Front holes on centerline.
3. All fillets and rounds (highlighted red) are R 

0.125” or R 3mm unless noted.
4. Center holes in Front and Right share a 

common centerpoint.Pre-
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Dimensioned 
Views

Use the following graphics with the design intent to create the part in 
inches or mm. The metric values have been changed to be whole 
number values.

Dimensions in inches: 

Dimensions in mm:Pre-
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Exercise 14:
Pulley

This lab reinforces the following skills:

� Creating draft while extruding.
� Mid-plane extrusions.
� Filleting.

Design Intent Some aspects of the design intent for this part are:

1. All fillets are 1mm unless noted.
2. Draft is 6° on both body and hanger.

Procedure Open an existing part named Pulley.

1 Extrusion with draft.

Extrude the Base sketch (red) 
10mm using the Mid-plane end 
condition and 6° of draft.

2 Hanger.

Use the Hanger (blue) sketch and another Mid-

plane extrusion of 4mm with the same amount of 
draft.
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3 Cut and hole.

Create a cut using the Center Cut sketch 
(green). The cut is Through All in both 
directions.

Add a 5mm diameter hole.

Add the fillet (1mm) to the bottom edges after the 
cut.

Create a third Through All cut, 3mm, centered 
above the origin.

4 Fillets.

Add fillets of 0.5mm 
and 1mm as shown. 
Note that these fillets are 
very order dependent; 
the 1mm fillets must 
precede the 0.5mm 
ones.

5 Save and close the 

part.

0.5mm

1mm
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Lesson 5
Patterning

Upon successful completion of this lesson, you will be able to:

� Use several different types of patterns.

� Use geometry patterns properly.

� Use the Vary Sketch option.
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Why Use 
Patterns?

Patterns are the best method when creating multiple instances of one or 
more features. Use of patterns is preferable to other methods for several 
reasons.

� Reuse of geometry

The original or seed feature is created only once. Instances of the 
seed are created and placed, with references back to the seed.

� Changes

Due to the seed/instance relationship, changes to the seed are 
automatically passed on to the instances.

� Use of Assembly Component 

Patterns

Patterns created at the part level are 
reusable at the assembly level as 
Feature Driven Patterns. The pattern 
can be used to place component parts 
or sub-assemblies.

� Smart Fasteners

One last advantage with Smart 
Fasteners to automatically add 
fasteners to the assembly. These are 
specific to holes.
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Comparison of 
Patterns

There are many types of patterns available in SolidWorks and this table 
is intended to highlight the typical uses for each type.

� Seed

The Seed is the geometry to be patterned. It can be one or more 
features, bodies or faces.

� Pattern Instance

The Pattern Instance (or just Instance) is the “copy” of the seed 
created by the pattern. It is in fact much more than a copy because it is 
derived from the seed and changes with the seed. 

Pattern Type: Typical usage: Key:

Seed = 
Pattern Instance = 

Linear  . . . . . . . . 
One-directional array with equal 
spacing.

Linear  . . . . . . . . 
Two-directional array with equal 
spacing.

Linear  . . . . . . . . 
Two-directional array; pattern 
seed only.

Linear  . . . . . . . . 
One- or two-directional array. 
Selected instances removed.
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Circular . . . . . . . 
Circular array with equal spacing 
about a center.

Circular . . . . . . . 
Circular array with even spacing 
about a center. Selected 
instances removed or angle less 
than 360°.

Mirror. . . . . . . . . 
Mirrored orientation about a 
selected plane. Can use selected 
features or the entire body.

Table Driven . . . 
Arrangement based on a table of 
XY locations from a coordinate 
system.

Sketch Driven . . 
Arrangement based on the 
positions of points in a sketch.

Curve Driven. . . 
Arrangement based on the 
geometry of a curve. 
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Pattern Options Pattern features share several options. They are unique to this class of 

feature and will be discussed in detail later in this lesson.

Curve Driven. . . 
Arrangement of full or partial 
circular path.

Curve Driven. . . 
Arrangement based on the 
geometry of a projected curve.

Fill . . . . . . . . . . . 
Arrangement of instances to 
pattern based on a face.

Fill . . . . . . . . . . . 
Arrangement of shapes to pattern 
based on a face.

Pattern 

Feature

Select 

Feature, 

Bodies 

or Faces

Propagate 

Visual 

Properties

Pattern 

Seed Only

Skip 

Instances

Geometry 

Pattern

Vary 

Sketch

Use 

Shapes

Linear � � � � � �

Circular � � � �

Mirror � � �
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Flyout 
FeatureManager 
Design Tree

The Flyout FeatureManager 
design tree allows you to 
view both the Feature-
Manager design tree and the 
PropertyManager at the same 
time. This allows you to 
select features from the 
FeatureManager when it 
would otherwise be obscured 
by the PropertyManager. It is 
also transparent, overlaying 
the part graphics.

The flyout FeatureManager design tree is activated automatically with 
the PropertyManager. It may appear collapsed and can be expanded by 
clicking on the plus “+” sign prefix.

Note The options Linear Sketch Step and Repeat and Circular Sketch 

Step and Repeat can be used within a sketch to create copies of sketch 
geometry. They do not create pattern features.

Linear Pattern The Linear Pattern creates copies, or instances, in a linear pattern 
controlled by a direction, a distance and the number of copies. The 
instances are dependent on the originals. Changes to the originals are 
passed on to the instanced features.

Table 

Driven
� �

Sketch 

Driven
� � �

Curve 

Driven
� � � � � �

Fill
Features 
and 
Faces 
only

� � � � �
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Introducing: 

Linear Pattern

Linear Pattern creates multiple instances in one- or two-dimensional 
arrays. The axis can be an edge, axis, temporary axis or linear 
dimension. 

Where to Find It � On the Features toolbar click the Linear Pattern tool .
� From the Insert menu choose: Pattern/Mirror, Linear Pattern....

1 Open the part named 

Grate.

The part contains the seed 
feature that will be used in the 
pattern.

2 Direction 1.

Click Insert, Pattern/

Mirror, Linear Pattern.

Select the linear edge of 
the part and click the 

Reverse Direction , 
if necessary, to set the 
direction shown.

Select the three features 
shown in Features to 

Pattern.

Set the Spacing to 2” 
and Instances to 5.

Note The pattern label is attached to the geometry 
used to define the pattern direction or axis. It 
contains the key settings for Spacing and 
Instances and is editable. Double-click the 
setting to change and retype the value.

Right-click the label to access other pattern 
commands such as Reverse Direction and 
Geometry Pattern.
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3 Direction 2.

Expand the Direction 2 group box and select 
another linear edge.

Deleting Instances Instances that are generated by the pattern can be deleted by selecting a 
marker at the centroid of the instance shown in the pattern preview. 
Each instance is listed in array format (2,3) for identification.

The seed feature cannot be deleted.

4 Instances to Skip.

Expand the 
Instances to Skip 
group box and 
select the six center 
instance markers. 
The tooltip shows 
an array location 
that is added to the 
list when selected.

5 Completed 

pattern.

Click OK to add 
the pattern feature 
LPattern1.
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Geometry Patterns The Geometry Pattern option is used to minimize rebuild time by 
using the Seed geometry for all Instances in the pattern. It should only 
be used when the geometry of the seed and the instances are of 
identical or similar shape.

� Without Geometry 

Pattern

If the Geometry 

Pattern option is 
cleared, the end 
condition of the 
seed is used in the 
instances. In this 
example, the Offset 

From Surface end 
condition of the 
blue seed feature is 
applied in the 
orange instances, forcing them to use the same end condition.

� With Geometry 

Pattern

If the Geometry 

Pattern option is 
checked, the 
geometry of the 
seed is used. The 
geometry is copied 
along the pattern, 
ignoring the end 
condition.

6 Geometry Pattern.

Right-click the Linear Pattern feature and choose 
Edit Feature. Check the Geometry pattern option. 
Because the plate is constant thickness, the resulting 
geometry will look the same.

Circular 
Patterns

The Circular Pattern creates copies, or instances, in a circular pattern 
controlled by a center of rotation, an angle and the number of copies. 
The instances are dependent on the originals. Changes to the originals 
are passed on to the instanced features.
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Introducing: 

Circular Pattern

Circular Pattern creates multiple instances of one or more features 
spaced around an axis. The axis can be an edge, axis, temporary axis or 
angular dimension.

Where to Find It � On the Features toolbar click the Circular Pattern tool .
� From the Insert menu choose: Pattern/Mirror, Circular Pattern....

A Word About 
Axes

Axes are types of Reference Geometry that can be used with many 
pattern features to define direction or rotational axes. There are two 
types: Temporary Axes and Axes.

Temporary Axes Every cylindrical and conical feature has an axis associated with it. 
View the temporary axes of the part using View, Temporary Axes. 
One axis is displayed through each circular face in the model. 

Axes Axes are features that must be created using one of several methods. 
The advantages to creating an axis is that it can be renamed, selected by 
name from the FeatureManager and sized. Temporary Axes can be 
made permanent and given unique names using the One Line/Edge/

Axis option. See the Advanced Part Modeling manual for more 
information on creating axes.

1 Open the part named 

Circular_Pattern.

2 Temporary axes.

Click View, Temporary Axes to see the 
axes generated automatically for circular 
features. Select one of the temporary 
axes.
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3 Settings.

Click Insert, 

Pattern/Mirror, 

Circular Pattern....

Select the three 
features shown for 
Features to Pattern. 
Set the Angle to 360° 

and 4 instances.

Click Equal Spacing 
and click Geometry 

pattern.

Note The Reverse 

Direction option  
is meaningful only 
when the an angle 
other than 360° is 
used.

Mirror Patterns The Mirror Pattern creates a copy, or instance, across a plane or planar 
face. The instance is dependent on the original. Changes to the original 
is passed on to the instanced feature.

Introducing: 

Mirror Pattern

Mirror Pattern creates one instance of one or more features or a body 
across a plane. The plane can be a reference plane or planar face.

Where to Find It � On the Features toolbar click the Mirror Pattern tool .
� From the Insert menu choose: Pattern/Mirror, Mirror....

Note To mirror all the geometry of a part about a common face, select the 
common face as Mirror Face/Plane and the solid body as Bodies to 

Mirror. The common face must be planar.

1 Open the part named Mirror_Pattern.
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2 Mirror.

Click Insert, Pattern/

Mirror, Mirror and the 
Right plane. Select the 
library feature as the 
Features to Mirror.

Click OK.

Note Geometry Pattern can 
also be used with this feature.

Using Pattern 
Seed Only

The Pattern Seed Only option is used when a two direction pattern is 
created. The second direction defaults to patterning all geometry 
created by the first direction unless Pattern Seed Only is used to 
pattern only the original or seed geometry. It is commonly used to 
prevent overlapping results when the two directions use the same 
vector.

1 Open the part named Seed_Pattern.

2 Direction 1.

Click Insert,

Pattern/Mirror,

Linear Pattern.... 
Select the linear edge 
as the Pattern 

direction, 30mm as the 
Spacing, 2 as the 

Number of Instances.

For Features to 

Pattern, select the 
library feature.
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3 Direction 2.

For Direction 2, select the 
linear edge on the opposite 
side as the direction, 
reversing the arrowhead. Set 
the instances to 2, spacing to 
50mm.

Note As seen in the preview, the original (seed) feature is patterned in both 
directions. 

4 Pattern seed only.

Click Pattern seed 

only to remove the 
extra instance.

Set the Direction 2 

Spacing to 30mm.

Curve Driven 
Patterns

The Curve Driven Pattern creates copies, or instances, in a linear 
pattern controlled by a curve. The instances are dependent on the 
originals. Changes to the originals are passed on to the instanced 
features. The curve can be an entire sketch, edge or single sketch entity. 
This example will use a sketch that contains several converted model 
edges.

Tip A 3D curve can be used to drive the pattern. An additional face 
selection for the Face normal is required.
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1 Open the part named Curve_Pattern.

Introducing:

Convert Entities

Convert Entities enables you to copy model edges into your active 
sketch. These sketch elements are automatically fully defined and 
constrained with an On Edge relation.

Where to Find It � On the Tools menu click Sketch Tools, Convert Entities.

Or, on the Sketch toolbar click Convert Entities .

2 Select tangency.

Select the top face and create a new 
sketch. Right-click the outer edge and 
select Select Tangency. 

Click Convert Entities  to copy 
the edges into the sketch. 

Close the sketch.

3 Curve driven pattern.

Click Insert, Pattern/Mirror, 

Curve Driven Pattern....

Select the sketch with the 
converted edges as the 
Pattern Direction and the 
library feature as the 
Features to Pattern.

Click Equal Spacing and set 
the number of instances to 5.

Tranform curve and Align 

to seed are used as defaults.
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4 Offset curve.

Click the Curve Method 

Offset Curve to position the 
instances using the same 
offset as the seed.

5 Align to seed.

Align to seed (leftmost 
illustration) translates the 
geometry along the curve 
direction without rotation of 
the instances.

Tangent to curve 
(rightmost illustration) 
rotates the geometry with 
changes in the curve 
direction.

6 Completed pattern.

Click Tangent to curve and OK. 
Note that the last instance straddles 
the edge of the solid body.
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Table and 
Sketch Driven 
Patterns

The Table and Sketch Driven Patterns creates copies, or instances, in 
a linear arrangement controlled by sketch points or a table of XY 
values (Hole Chart). The instances are dependent on the originals. 
Changes to the originals are passed on to the instanced features.

Introducing: Sketch 

Driven Pattern

Sketch Driven Pattern creates multiple instances based on points in a 
selected sketch. The sketch must exist before the pattern is created.

Where to Find It � On the Features toolbar click the Sketch Driven Pattern tool .
� From the Insert menu choose: Pattern/Mirror, Sketch Driven 

Pattern....

Tip Only point geometry is used by the Sketch Driven pattern. Other 
geometry, such as construction lines, can be used but will be ignored by 
the pattern.

1 Open Table&Sketch_Driven.

2 Sketch.

Open a new sketch on the face and create 
a construction line starting at the center 
of the D25 feature.

Add points to the sketch and make them 
coincident with the line.

Dimension and fully define the sketch. 

Close the sketch.
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3 Sketch driven pattern.

Click Pattern/Mirror, Sketch 

Driven Pattern... and select the 
new sketch and the Centroid 
option. Under Features to Pattern, 
select the D25 feature.

Tip The Centroid option locates the instances based on the centroid of the 
seed. If the seed geometry is asymmetric or made up of multiple 
features, use the Selected point option and select a position to use 
when locating the instances.

Introducing: Table 

Driven Pattern

Table Driven Pattern creates multiple instances based on a table of 
XY values. The XY locations are based on a selected Coordinate 

System feature. The Coordinate System must exist before the pattern 
is created.

Where to Find It � On the Features toolbar click the Table Driven Pattern tool .
� From the Insert menu choose: Pattern/Mirror, Table Driven 

Pattern....

Tip The table used in the pattern can be either: typed into the cells in the 
dialog or be taken from an existing table. The table file type can be 
either a *.sldtab or *.txt extension.

Introducing:

Coordinate System

Coordinate Systems create cartesian coordinate systems that can be 
used for properties, measurements or export output.

Where to Find It � From the Insert menu choose Reference Geometry, Coordinate 

System....

� Or click Coordinate System  on the Reference Geometry 
toolbar.
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4 Coordinate system.

Click Insert, Reference Geometry, 

Coordinate System and select the 
horizontal edge of the part as the X 

axis. Select the vertical edge as the Y 

axis and use the reverse buttons, if 
necessary, to reverse the axis 
directions. Click OK and rename the 
feature XY.

5 Table driven pattern.

Click Insert, Pattern/Mirror, Table Driven Pattern... and select the 
coordinate system XY and D35 feature. Type in the values for X and Y 
in Point 1, 2, 3 and 4 (0 is the seed).

Using Vary 
Sketch

Vary Sketch is a special case of the Linear Pattern that allows 
instances to change size based on geometric conditions. It requires that 
the linear dimension driving the shape is selected as the direction of the 
pattern. 
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1 Open the part named 

Vary_Sketch.

Edit the sketch for the 
cut feature. Double-
click and change the 
2” dimension, noting 
that it drives the size of 
the geometry.

Reset the dimension 
value.

2 Linear pattern.

Create a linear 
pattern of the cut 
feature. Select the 
2” dimension for 
Direction 1. The 
direction arrow 
should point away 
from center. 

Enter 0.75” for 
Spacing and 7 as 
the Number of 

Instances.

The preview shows that the pattern is created along the measurement 
direction of the dimension. The size of the cut is unchanged.

3 Select the Vary 

Sketch option.

The Vary Sketch 
option changes the 
shape along the 
direction vector.

Note The sketch has been 
shown for clarity.
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Pattern of a 
Pattern

Existing pattern features can be used in new patterns. The original and 
all pattern instances are used when the pattern feature is selected.

4 Circular pattern.

Double-click the cut feature to 
expose its dimensions. Insert a 
Circular Pattern. Select the 
30° dimension as the Pattern 

Axis.

5 Pattern feature.

Select the linear pattern feature as 
the Features to Pattern.

Set the Instances to 6 with Equal 

spacing.

Patterning 
Faces

Parts that have been imported through IGES, STEP or another method 
generally appear as a single Imported feature. They lack the 
individual features of native SolidWorks geometry.

Using the Faces to Pattern selection, faces can be selected and used as 
if they were individual features. The selected faces, in conjunction with 
other part geometry, must form a closed boundary. The result can either 
add or remove material.

Tip Solid bodies can be patterned using the Bodies to Pattern dialog.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 5 SolidWorks 2006 Training Manual
Patterning

164 Patterning Faces

1 Open the existing part Using Faces 

in Patterns.

The part contains imported geometry.

2 Circular pattern.

Click View, Temporary Axes and select the center 
axis as the Pattern Axis.

Close the Features to Pattern and open Faces to 

Pattern.

Set the pattern to Equal spacing with 4 instances.

3 Selections.

Select all faces of the object, including the hidden 
faces.

4 Preview.

The preview displays 4 instances. 

Click OK to add the pattern feature.

Tip Face selection can be used with any type of pattern. Instances can be 
skipped.
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5 Pattern of “holes”.

Create a second pattern using the 
cylindrical “hole” face of 8 instances.

A section shows how the geometry has 
been changed by the patterns. 

Fill Patterns The Fill Pattern uses existing features or standard shapes to fill a 
boundary face. Settings are used to determine the pattern layout, angle, 
distance and margin distances.

Topological 

Selections

The topological selections include the 
faces to fill, the direction and the features 
to pattern.

� Face(s) to Fill

The face or faces (coplanar) that the 
pattern will contour to and fill. Loops 
within the face are not patterned. 

� Pattern Direction

A model edge, axis or sketch line that 
defines the direction of the pattern.

� Feature(s) to Pattern

The selected feature or features to 
pattern. 

Note Predefined shapes (circles, squares, diamonds or 
polygons) can be patterned in place of existing 
geometry.

Feature to Pattern

Face to Fill

Pattern Direction
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Pattern Layout The Pattern Layout is used to select and arrange the pattern style. With 
each layout the numeric settings of spacing and distance take on 

different meanings. 

Numeric Settings Numeric settings determine the 
spacings, staggers and 
minimum edge distances used 
by the pattern as it fills.

These numeric settings are for 
the Perforation pattern used in 
the following example.

� Stagger Angle

The angle between the selected 
Pattern Direction and the rows of instances.

� Spacing

The minimum distance between similar rows of instances.

� Margin

The minimum distance between the edge of the face and an instance.

1 Open the existing part Perforation Area Pattern.

Perforation Circular

Square Polygon

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 5
Patterning

Fill Patterns 167

2 Face and direction.

Click Fill Pattern  and 
select the top face of the 
model. Click the edge 
shown as the direction 
(Direction 1).

Also, select the  

Perforation Pattern 

Layout button.

3 Settings.

Select the 1/8 
(0.125) Diameter 
Hole1 as the feature 
to pattern. Set 
Spacing, Margins and 
the Stagger Angle 
using the values 
shown. 

Note The Fill Pattern 
includes the Instances 

to Skip option like 
other patterns. It can be 
used to eliminate any 
unwanted instances.

4 Changes.

Delete the pattern. Add a 
Linear Pattern to copy 
the rectangular cut 
as shown. 

Recreate the pattern using 
the same selections. The 
pattern works around the 
new hole in the face.

Tip Rather than deleting the feature, Rollback could be used to insert the 
linear pattern prior to the pattern. Rollback will be discussed in Editing: 

Repairs, Rollback to Feature on page 241.
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Exercise 15:
Linear Patterns

Create feature patterns in this part 
using a Linear Pattern.

This lab uses the following skills:

� Linear patterns.
� Deleting pattern instances.

Procedure Open an existing part.

Note This part has been copied for use in linear, table driven and sketch 
driven patterns.

1 Open the part Linear 
Pattern.

The part includes the “seed” 
feature used in the patterns.

2 Linear pattern.

Create a pattern using the seed. Use the dimensions below.

3 Save and close the part.
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Exercise 16:
Table or Sketch 
Driven Patterns

Create feature patterns in this part 
using a Table Driven Pattern.

This lab uses the following skills:

� Coordinate systems.
� Table Driven Patterns.
� Sketch Driven Patterns.
� Table files.

Procedure Open an existing part.

1 Open the part

Table Driven Pattern.

The part includes the “seed” 
feature used in the patterns.

2 Table or Sketch driven pattern.

Use the dimensions below to define the sketch used with the Sketch 
Driven Pattern.

-or-

Create a Coordinate System at the 
center of the pattern hole 
feature and use the files
pattern file.sldptab or 
pattern file.txt to define 
the Table Driven Pattern. Create a 
pattern using the seed feature. 

3 Save and close the part.
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Exercise 17:
Skipping 
Instances

Complete this part using the 
information and dimensions 
provided.

This lab reinforces the following 
skills:

� Creating a linear pattern.
� Skipping instances.
� Patterning a pattern.
� Editing a feature.

Procedure Create a new part with Inch units.

1 Base feature.

Create a block 
3”x12”x0.75”. It will be 
useful to have a reference 
plane centered along the long direction.

2 Seed.

Create the seed feature using the Hole 
Wizard and an ANSI Inch drill.

3 Pattern.

Pattern the hole, skipping instances as 
shown in the diagram below.

4 Pattern of a pattern.

Pattern the pattern to create a symmetrical arrangement of holes.

5 Change.

Change the hole to 5/16” diameter and rebuild.

6 Save and close the part.
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Exercise 18:
Linear and 
Mirror Patterns

Complete this part using the information and 
dimensions provided.

This lab reinforces the following skills:

� Creating a Linear Pattern.
� Creating a Mirror Pattern using features.
� Creating a Mirror Pattern using a body.

Procedure Open the existing part Linear & Mirror.

1 Linear pattern.

Using the existing feature, create a Linear Pattern 
that results in three grooves that are spaced 0.20”.

2 Mirror features.

Using a single pattern feature, create the duplicate 
boss and cut as shown.

3 Symmetry.

Use a third pattern feature to create the full model 
from the half model.

4 Save and close the part.
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Exercise 19:
Curve Driven 
Patterns

Create feature patterns in this 
part using a Curve Driven 
Pattern.

This lab uses the following 
skills:

� Offset Curve.
� Using the Hole Wizard.
� Curve Driven Patterns.

Procedure Open an existing part.

1 Open the part Curve 

Driven Pattern.

2 Sketch.

Open a sketch on 
the front face of the 
cam and create a 
5.5mm offset of the 
outer profile. 
Rename the sketch 
Curve Sketch.
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3 Hole Wizard.

Add a Countersink with 
the following options:

� Ansi Metric

� Flat Head Screw

� M3.5

� Through All

Add two geometric 
relations as follows:

� Horizontal with 
respect to the origin.

� Coincident to the Curve Sketch.

4 Curve Driven Pattern.

Pattern the feature with the 
Number of Instances to 
20 and Equal spacing.

5 Save and close the part.
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Exercise 20:
Using Vary 
Sketch

Edit a pattern in this part to use Vary 
Sketch.

This lab uses the following skills:

� Edit Feature.
� Using the Vary Sketch option.

Procedure Open an existing part.

1 Open the part

Vary Sketch Lab.

The part includes the “seed” 
feature used in the patterns.

2 Edit Pattern.

Edit the pattern feature and 
make changes to use the Vary 
Sketch option as shown.

3 Changes.

Change the spacing to 0.375” 
and the number of instances to 7.

4 Save and close the part.
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Lesson 6
Revolved Features

Upon successful completion of this lesson, you will be able to:

� Create revolved features.

� Apply special dimensioning techniques to sketches for revolved 
features.

� Use the multibody solid technique.

� Create a sweep feature.

� Create circular patterns of features.

� Calculate the physical properties of a part.

� Perform rudimentary, first past stress analysis.
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Case Study: 
Handwheel 

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 
following list. 

� Design intent

The part’s design intent is outlined and explained.

� Revolved features

The center of the part is the Hub, a revolved shape. It will be created 
from a sketch with a construction line as the axis of revolution.

� Multibody solids

Create two discrete solids, the Hub and the Rim, connecting and 
merging them using a third solid, the Spoke.

� Sweep features

The Spoke feature is created using a sweep feature, a combination of 
two sketches that define a sweep profile moving along a sweep path.

� Circular patterns

Rather than model the same spoke multiple times, we will create a 
pattern of evenly spaced Spokes around the centerline of the Hub.

� Analysis

Using tools that are included in the SolidWorks software, you can 
perform basic analysis functions such as mass properties calculations 
and first-pass stress analysis. Based on the results, you can make 
changes to the part’s design.
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Design Intent The design intent of this part is shown below:

� Spokes must be evenly spaced.
� The center of the rim of the handwheel lies at the end of the spoke.
� The spokes pass through the center of the hub.

Revolved 
Features

The Hub is a revolved feature. It is the first feature created by 
revolving geometry around an axis. Revolved features require 
axisymmetric geometry and a centerline (used as the axis) in the sketch. 
This revolved feature will be used as the center of the wheel. Under the 
right circumstances, a sketch line may also be used as the centerline.

Procedure To begin this case study:

1 Open a new part using the Part_MM template.

Sketch Geometry 
of the Revolved 
Feature

Geometry for the revolved feature is created using the same tools and 
methods as extruded features. In this case, lines will be used to form the 
shape – a cylinder with a chamfered edge. The centerline is used as the 
axis of revolution and for locating geometry.

2 Rectangle.

Right-click the Right Plane and select Insert 

Sketch. Create a rectangle from the Origin 
approximately 50mm high by 30mm wide.

Rim

Handwheel
Hub

Spoke

Diameter
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3 Convert to construction.

Select the vertical line shown and click Construction 

Geometry  on the Sketch toolbar. The line is 
converted into a construction line.

Introducing:

3 Point Arc

The 3 Point Arc option allows you to create an arc based on three 
points, the two endpoints followed by a point on the curve.

Where to Find It � From the Tools menu choose Sketch Entities, 3 Point Arc.

� Or, on the Sketch toolbar click 3 Point Arc .

4 Insert 3 Point Arc.

Begin the arc by positioning the 
cursor on the left vertical line and 
dragging downwards along that 
edge. Release the mouse button 
and then select and drag the point 
on the curve away from the 
sketch.

5 Trimming.

Use the Trim with the Power Trim option and trim 
away the portion of the line inside the arc.

Rules Governing 
Sketches of 
Revolved Features

In addition to the general rules governing sketches that 
were listed in Lesson 2: Introduction to Sketching, some 
special rules apply to sketches of revolved features:

� A centerline or sketch line must be specified as the 
axis of revolution.

� The sketch must not cross the axis.

The axis of revolution for the revolve must be selected 
before creating the revolved feature.

Note that in this example, the right vertical sketch line could be used as 
the axis of revolution.

Not Valid
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Dimensioning the 
Sketch

Revolved geometry is dimensioned like any other with one additional 
option. Dimensions that measure diameters on the finished feature can 
be changed from linear to diameter dimensions.

6 Arc dimension.

Dimension the arc by selecting on the 
circumference of the arc and the vertical line it 
sits on. The result is a dimension between the 
line and the tangent of the arc.

7 Finished dimension.

Change the Value to 4mm.

8 Vertical dimensions.

Using the Vertical Dimension tool , create the 
vertical linear dimensions shown at the right. The 
Smart Dimension icon will also work.

Diameter 
Dimensions

Some dimensions should be diameter dimensions in the finished 
revolved feature. For these dimensions, always select the centerline 
(axis of revolution) as one of the picks. You then have your choice of 
either a radius or diameter dimension, depending on where you place 
the dimension text. If you don’t pick the centerline, you won’t be able 
to change the dimension to a diameter.

Note This option is available only if a centerline is used as the axis of 
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revolution. Diameter dimensions are not restricted to use in revolved 
feature sketches.

9 Dimension to centerline.

Dimension between the centerline and the 
outer vertical edge to create a horizontal 
linear dimension.

Do not click to place the dimension text just 
yet.

Notice the preview. If you place the text now, 
you will get a radius dimension.

10 Move the cursor.

Move the cursor to the right of 
the centerline. The preview 
changes to a diameter 
dimension.

11 Resulting dimension.

Click to place the dimension text. Change 
the value to 25mm and press Enter.

Normally, a diameter dimension should 
have a diameter symbol preceding it thus: 

. When the revolved feature is 
created from the sketch, the system will 
automatically add the diameter symbol to 
the 25mm dimension.

Note If you inadvertently place the dimension text in the wrong place, and 
get a radius dimension instead of a diameter you can fix it. Right-click 
the dimension, and select Properties... Click the Diameter dimension 
check box to make the dimension a diameter dimension.
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Creating the 
Revolved Feature

Once the sketch is completed, it can be made into a revolved feature. 
The process is simple, and a full (360°) revolution is almost automatic.

Introducing: 

Revolved Feature

The Revolve option allows you to create a feature from an 
axisymmetric sketch and an axis. This feature can be a base, boss or cut 
feature. The axis can be a centerline, line, linear edge, axis or 
temporary axis. If only one axis selection is present, it is used 
automatically. If more than one is present, you must select it.

Where to Find It � From the Insert menu choose Boss/Base or Cut, Revolve....

� Or use the Feature toolbar tool: .

12 Make the feature.

Click Boss/Base, Revolve... from the Insert menu. A message will 
appear indicating that the sketch is an open contour and asking if you 
want to close the contour automatically. Click Yes.

The PropertyManager appears 
with these default end 
conditions:

One Direction

Angle 360°

Accept these defaults by 
clicking OK.

13 Finished feature.

The solid revolved feature is created as the first feature 
of the part.

Rename it Hub.
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14 Edit the sketch.

Right-click the Hub and select Edit Sketch.

Note You can also right-click the feature in the 
FeatureManager design tree and achieve the same 
result.

15 Normal To.

Click Normal To  on the Standard Views toolbar to change the view 
so you can see it true size and shape.

16 Fillet settings.

Select the  tool and set the value to 5mm. Make 
sure the Keep constrained corners option is 
checked.

17 Selections.

Select both endpoints of the arc, as 
indicated. When each is selected, the fillet 
will appear. The dimension drives both but 
only appears once, at the first selection.

Since the endpoints that were filleted had 
dimensions, Virtual Sharp symbols are 
added where the corners were. These 
symbols represent the missing corners and 
can be dimensioned to or used within 
relations.

Note Notice the 25mm dimension. As mentioned 
in step 11 on page 183, a diameter symbol 
now precedes the dimension.

Close the PropertyManager.

Pick here
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18 Rebuild the model.

To cause the changes to take effect click the 

Rebuild  tool.

Building the 
Rim 

The Rim of the Hand-
wheel is another revolved 
feature. It too is revolved 
360°. The profile of the 
Rim is an oval shape, 
made up of two 180° arcs 
and two lines.

The Rim will be created as 
a separate solid body, not 
merged to the Hub.

19 Sketch.

Create a new sketch on the Right reference plane. Orient the model in 
the same direction.

20 Horizontal centerline.

Sketch a short horizontal centerline 
somewhere off of the model.

21 Offset with cap ends.

The Offset Entities tool has a Cap ends 
option that creates Arcs to close the ends 
of a Bi-directional offset. Select the 
centerline and offset using the options 
shown.
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22 Add dimensions.

Dimension the sketch as shown in the illustration at the 
right.

Introducing: Point The sketch entity Point can be used to locate a position in a sketch that 
other geometry (endpoints for example) cannot.

Where to Find It � Click Point  on the Sketch toolbar.
� Or from the Tools menu, click Sketch Entities, Point.

23 Add a point.

Click Point  and add a point at the midpoint of 
the centerline.

24 Rotation axis.

Add a centerline using the 

Centerline  tool, setting 
Vertical and Infinite length. 
Place the line at the origin. 
This will be the axis of 
revolution for the revolved 
feature.

25 Add dimensions.

Add dimensions from 
the centerline to the 
point and the arc center 
to the Hub edge.

The sketch is now fully 
defined.

26 Potential ambiguity.

This sketch contains two 
centerlines. The system 
will not know which 
centerline is intended to be the axis of revolution. The centerline to be 
used can be selected either before or after selecting the Revolve tool.
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27 Completed feature.

Select the infinite vertical 
centerline. From the 
Insert menu, choose 
Boss/Base, Revolve.... 
Use an angle of 360°.

Rename the feature to 
Rim.

Multibody Solids Multibody solids occur when there is more 
than one solid body in a part. In cases where 
discrete features are separated by a distance, 
this can be the most efficient method in 
designing a part.

The Solid Bodies folder holds the 
bodies and also lists how many bodies are currently 
housed in the folder (2). The bodies can be merged 
or combined later to create a single solid body.

For more information on multibody parts, see the 
Advanced Part Modeling training manual.

Building the 
Spoke 

The Spoke feature is created using an Sweep feature. The sweep 
pushes a closed contour Profile along an open contour Path. The Path 
is sketched using lines and tangent arcs. The profile is then sketched 
using a circle. The feature will bridge the space between the existing 
Hub and Rim features and combine them into a single solid body.

The Spoke feature is important because it will be patterned to create 
any number of evenly spaced spokes.

28 Setup.

Setup for sketching:

� Create a new sketch using the Right reference plane.
� Show the sketches of the Hub and Rim.
� Change the display to Hidden Lines Visible.
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29 Sketch line.

Sketch a horizontal Line 
running from the centerline 
inside the Hub boundaries.

30 Tangent arc.

Create a Tangent Arc from 
the line endpoint in the 
direction shown. The actual 
values are not important as 
you sketch. They will be 
defined by dimensions later.

31 Connecting tangent arc.

With Tangent Arc still 
selected, continue sketching 
by using the previous arc’s 
endpoint as a start. Sketch this 
arc tangent to the first, ending 
at a horizontal tangency posi-
tion.

Tip When the vertical inference line coincides with the arc’s center, the 
tangent of the arc is horizontal.

32 Horizontal line.

Sketch a final Line. It is 
horizontal, with its length 
to be determined by 
dimensioning.

33 Relations.

Drag and drop the left 
endpoint of the line onto the 
point of the Rim sketch. A 
Coincident relation is added.

Add another relation between 
the line at the opposite end 
and the centerpoint of the arc.
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34 Return to a shaded display.

Completing the 
Path and Profile 
Sketches

The geometry sketched will act as the “centerline” for the profile 
sketch.

35 Add dimensions.

Add an Equal relation to the 
arcs. Dimensions are added 
to define the shape. Picking 
end points and center points 
allows for more options 
when the creating the 
dimensions.

36 Exit sketch.

Right-click in the sketch and 
choose Exit Sketch to close the sketch without using it in a feature.

37 Profile.

Sketch a circle on the 
Front plane and 
dimension the 
diameter.

38 Drag relation.

Drag the centerpoint of the circle 
and drop it on the endpoint of the 
line in the previous sketch. A 
coincident relation is added 
between them. Exit the sketch.

Introducing:

Insert, Boss, Sweep

Insert, Boss, Sweep creates a feature from two sketches: a sweep 
section and sweep path. The section is moved along the path, creating 
the feature.

Where to Find It � Click Sweep Boss/Base  on the Features toolbar.
� Or, click Insert, Base/Boss, Sweep.

Note The Sweep command is covered in depth in the Advanced Part 

Modeling course.
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39 Sweep.

Click the Sweep  icon 
and select the closed contour 
sketch as the Profile and the 
open contour sketch as the 
Path.

40 Results.

Name the new feature 
Spoke. The Solid 
Bodies(1)folder reflects 
the merging of solid bodies 
into one.

41 Temporary axes.

Display the temporary axes using View, 

Temporary Axes.

42 Pattern the Spoke.

Click Circular Pattern . Select the 
temporary axis as the center of rotation for the 
pattern. 

Click in the Features to Pattern list to make it 
active. Select the Spoke.

Set the Number of Instances to 3 with Equal spacing.

Rotate View The Rotate View tool  allows you to rotate the view of the model 
freely. To restrict that motion, you can choose an axis, a line or edge, a 
vertex, or a plane. Click the Rotate View tool and the center axis.

The same result can be obtained using the middle mouse button 
rotation. Select the temporary axis using the middle mouse button, and 
drag with the middle mouse button.

Note If you turned off the temporary axes after you made the circular pattern, 
you will either have to turn them back on or show the Rim sketch in 
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order to have an axis or line (centerline) to rotate about.

43 Rotate.

Rotate about the axis by dragging the mouse. 
Switch axes by simply clicking another axis or 
other acceptable choice.

Turn off the Temporary Axes.

44 Add fillets.

To complete the model, 3mm 
fillets are added to the 
highlighted faces of the model. 
Selection of a face selects all 
edges of that face.

Face selections make the model 
better suited to withstand 
dimensional changes.

Chamfers Chamfers create a bevel on the edge of a model. In many ways, 
chamfers are similar to fillets in that you select edges and/or faces in 
the same way.

Introducing:

Chamfer

Chamfer creates a bevel feature on one or more edges or vertices. The 
shape can be defined by two distances or a distance and an angle.

Note Sketch Chamfers can be added to the sketch rather than to the faces and 
edges of the solid model.

Where to Find It � From the Insert menu choose Features, Chamfer....

� Or, on the Features toolbar, pick the Chamfer  tool.
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45 Chamfer.

Add a Chamfer 
feature using the top 
edge of the Hub 
feature. Set the 
distances using the 
values shown at 
right.

Edit Material The Edit Material dialog is used to add and edit the material associated 
with a part. The material is used for calculations that rely on material 
properties, including Mass Properties and COSMOSXpress. The 
material can vary by configuration. For more information on 
configurations, see Lesson 9: Configurations of Parts.

Where to Find It � Click Edit Material  on the Standard toolbar.

RealView Graphics If you have an NVIDIA graphics accelerator, you may be able to use 
the RealView Graphics option. It provides high-quality, real time 
material shaders when available.

Tip Part templates (*.prtdot) can include a predefined material.

Where to Find It � Click RealView  on the View toolbar.

Note If RealView Graphics are not available, the icon will be grayed out.

46 Open HW_Analysis.

Close the current part and open the existing part HW_Analysis. This 
part has additional features needed for use in the analysis section of this 
lesson.
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47 Materials.

Click the Edit Material icon  and select Copper 

and its Alloys, Aluminum Bronze from the 
Materials group box. 

48 Physical properties.

The Physical Properties are those assigned by the 
chosen material.

49 Visual Properties.

The Visual Properties are those assigned by the 
chosen material. This includes a Material color, 
Texture and associated Material crosshatch.

If RealView graphics are not available, the option, 
under Advanced graphics, is grayed out and the 
Standard option is chosen.

A change in material changes 
the color of the part, unless 
Use material color is 
unchecked.

The material name is also 
updated in the 
FeatureManager.
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Mass Properties One of the benefits of working with a solid model is the ease with 
which you can perform engineering calculations such as computing 
mass, center of mass, and moments of inertia. The SolidWorks software 
does all this for you with a simple click of the mouse.

Note Section Properties can also be generated from a planar face or a 
sketch in a model. The sketch can be active or selected.

Introducing:

Mass Properties

Mass Properties is used to generate the mass properties of the entire 
solid. The properties include mass, volume and a temporary display of 
the principal axes.

Where to Find It � On the Tools toolbar click the Mass Properties tool .
� From the Tools menu choose Mass Properties....

50 Mass properties.

Select the Mass Properties... 
option from the Tools menu. 
The Density set with Edit 

Materials is used.

The results of the calculations 
are displayed in the dialog 
box.

Note For those parts that do not 
posses an accurate physical 
description, you can use 
Assigned Mass 

Properties. The settings 
include Mass and the 
location of the Center of 

Gravity (XYZ).
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51 Change the settings.

To change the settings, click the Options... 
button and set the Material Properties. 

This would only change the mass properties 
for this calculation, not the actual material 
properties set by the Material Editor. Click 
Cancel.

52 Material Editor.

To change the Material Properties, use Edit 

Material. See Edit Material on page 193.

Mass Properties 
as Custom 
Properties

Components of the Mass Properties of a part can be carried with the 
part as a Custom Property. This information can be extracted by a Bill 
of Materials report.

53 File properties.

Click File, Properties and click the Custom tab. Type in the Name 
mass. The Type Text appears automatically. Assign the mass 
property component by selecting Mass from the Value/Text 

Expression dropdown list. A SolidWorks special property and 
Evaluated Value are created. 

Note The Configuration Specific tab can also be used. This would allow the 
property to vary by configuration. Configurations will be discussed in 
Lesson 9: Configurations of Parts.

COSMOSXpress COSMOSXpress is a first pass stress analysis tool for SolidWorks 
users. It helps you judge whether your part will withstand the loading it 
will receive under real-world conditions. COSMOSXpress is a subset 
of the COSMOSWorks product.
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Overview COSMOSXpress uses a wizard 
to provide an easy to use, step-
by-step method of performing 
design analysis. The wizard 
requires several pieces of 
information in order to analyze 
the part: materials, restraints 
and loads. This information 
represents the part as it is used. 
For example, consider what 
happens when you turn the 
handwheel. The hub is attached 
to something that resists 
turning. This is represented by 
a restraint - the hub is 
restrained so it doesn’t move. A force is applied to the hole in the rim as 
you attempt to turn the handwheel. This is a load. What happens to the 
spokes? Do they bend? Will they break? This depends on the strength 
of the material the handwheel is made of, the physical size and shape of 
the spokes, and the size of the load.

Mesh In order to analyze the model, COSMOSXpress 
automatically meshes the model, breaking it up 
into smaller, easier-to-analyze pieces. These 
pieces are called elements.

Although you never see the elements, you can 
set the coarseness of the mesh prior to the 
analysis.

Results The analysis produces results in the forms of Factor of Safety, Stress 

Distribution and Deformed Shape.

Using the 
Wizard

The design analysis wizard walks you through the steps of analysis, 
from Options to Results. The steps are:

� Options

Setup the type of units that are commonly used for materials, loads and 
results.

� Material

Choose a material for the part from the standard library or input your 
own.

� Restraint

Select faces of the part that remain in place (fixed) during the analysis. 
These are sometime called constraints.

� Load

Add external loads such as forces and pressures to induce stress and to 
deform the part.

Externally applied Load

Restraint
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� Analyze

Run the analysis, optionally setting the coarseness of the mesh used.

� Results

View the results of the analysis: Factor of Safety (FOS), Stress and 
Deformations. This is sometimes called postprocessing.

Where to Find It � From the Tools menu, select COSMOSXpress....

1 Start COSMOSXpress.

Click Tools, 

COSMOSXpress.... The 
analysis wizard appears.

Phase 1: Options The Options dialog contains settings for the System of units and 
Results location.

2 Click Options....

Set the units to English 

(IPS) and check Show 

annotation for 

maximum and 

minimum in the stress 

plot.

Click Next.

Phase 2: Material The wizard automatically advances to the next phase as you complete 
the previous one. As you complete each phase in the wizard, a green 
check mark  is added to the tab.

The next phase is selecting the Material. You can choose from libraries 
of standard materials or add your own.
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3 Current material.

The current material, 
selected within 
SolidWorks, should be 
Aluminum Bronze from 
the Copper and its 

alloys list.

To change the material, 
select it from the list. 
This is the same list that 
appears when using Edit 

Material.

Click Next.

Phase 3: Restraint Restraints are used to “fix” faces of the model that should not move 
during the analysis. You must restrain at least one face of the part to 
avoid analysis failure due to rigid body motion.

4 Introductory screen.

Click on the blue 
hyperlinks (such as 
Restraints) for on-line 
help.

Click Next.

5 Face selection.

Select the cylindrical 
face and the flat face that 
form the D-shaped hole.

Click Show symbol to 
see a visual display of 
the restraints.
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Click Next.

6 Restraint added.

You can Add, Edit, or 
Delete restraint sets 
from this menu.

Although 
COSMOSXpress allows 
you to create multiple 
restraint sets, there is 
little value in doing so 
because the sets are 
combined during 
analysis. In the full 
COSMOSWorks product, multiple restraint sets are more useful. They 
allow you to create different analysis cases using different sets of 
restraints and loads.

Click Next.

Phase 4: Load The Load tab is used to add external forces and pressures to faces of 
the part. Force implies a total force, for example 200 lbs, applied to a 
face in a specific direction. Pressure implies that the force is evenly 
distributed on the face, for example, 300 psi, and is applied normal to 
the face.

Note The specified force value is applied to each face. For example, if you 
select 3 faces and specify a 50 lb. force, COSMOSXpress applies a 
total force of 150 lbs. (50 lbs. on each face).
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7 Introductory screen.

In this example, we will 
use a Force type load. 
Click Next.

8 Load type.

Click Force as the type 
of load and click Next.

9 Select the face.

Select the cylindrical face as shown and click Next.

10 Direction of the force.

Click Normal to a reference plane and select the Right Plane. Set 
the value of the force to 1000 lb. 

Click Show symbol to make sure that the load is applied in the desired 
direction. If it is not, click Flip direction. In this example the direction 
really does not matter.
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Click Next.

11 Completed load set.

The completed load set 
is listed as Load1. Like 
restraint sets, they can be 
edited or deleted from 
this dialog.

Click Next.

Phase 5: Analyze COSMOSXpress prepares the model for analysis and then it calculates 
displacements, strains, and stresses.

12 Analyze screen.

The required information 
has been provided and 
the analyzer is ready.

Click Yes, and then click 
Next.

Note Click No if you want to 
set the size of the 
elements. Specifying a 
smaller element size 
gives more accurate 
results, but requires more time and resources.
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13 Start the analysis.

Click Run to begin the 
analysis. A status 
window appears. The 
stages of the analysis 
process are displayed 
with elapsed time.

Phase 6: Results The Results tab is used to display the results of analysis. The first 
result is the Factor of Safety (FOS) which compares the yield strength 
of the material to the actual stresses.

Factor of Safety COSMOSXpress uses the maximum von Mises stress criterion to 
calculate the factor of safety distribution. This criterion states that a 
ductile material starts to yield when the equivalent stress (von Mises 
stress) reaches the yield strength of the material. The yield strength 
(SIGYLD) is defined as a material property. COSMOSXpress 
calculates the factor of safety at a point by dividing the yield strength 
by the equivalent stress at that point.

At any location, a factor of safety that is:

� Less than 1.0 indicates that the material at that location has yielded 
and that the design is not safe.

� Equal to 1.0 indicates that the material at that location has just 
started to yield.

� Greater than 1.0 indicates that the material at that location has not 
yielded.
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14 Factor of safety.

The FOS is listed as less 
than 1. This indicates 
that areas of the part are 
overstressed and will 
fail.

Click Show Me to dis-
play a colored image rep-
resenting the factor of 
safety. Red areas indicate 
where the factor of safety 
is less than one.

Click Next.

15 Result types.

There are other ways to 
look at the results: stress, 
displacement and 
deformation.

The following are some examples of the different ways to display the 
results. The Stress Distribution and Deformed Shape graphics can 
be animated and saved as *.avi files. Your instructor will 
demonstrate these animations in class.

Note The displays are exaggerated by the Deformation Scale.
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� Stress Distribution

� Displacement Distribution

� Deformed Shape

This is best seen by viewing the animation.
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� HTML Report

� eDrawing of analysis results

16 Close and Save.

Click the Close button. You will be asked if you want to save the 
COSMOSXpress data. Click Yes.

Updating the 
Model

Changes performed in SolidWorks are detected by COSMOSXpress. 
Changes can be made to the model, materials, restraints or loads. The 
existing analysis can be Updated to show the newest results.
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17 Edit profile sketch.

Expand the Spoke 
feature and edit the 
profile sketch. Select the 
circle and click For 

construction. 

Introducing: 

Insert Ellipse

Sketching an ellipse is similar to sketching a circle. Position the cursor 
where you want the center and drag the mouse to establish the length of 
the major axis. Then release the mouse button. Next, drag the outline of 
the ellipse to establish the length of the minor axis.

Important! To fully define an ellipse you must dimension or otherwise constrain 
the lengths of the major and minor axes. You must also constrain the 
orientation of one of the two axes. One way to do this is with a Hori-

zontal relation between the ellipse center and the end of the major axis.

Where to Find It � Click Tools, Sketch Entity, Ellipse.

� Or, click Ellipse  on the Sketch Tools toolbar.

18 Ellipse.

Click Ellipse  and 
position the centerpoint at 
the centerpoint of the 
circle. Move away from 
center and position the 
major and minor axes 
with additional clicks.

19 Relations and 

dimensions.

Add relations to make the 
major axis points 
Horizontal and one of the 
minor axis points 
Coincident to the circle. 
Add the dimension as 
shown.
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20 Rebuild the part.

The edited sweep profile is used 
with the same path to produce a 
different result.

21 Change material.

Change the material using 
right-click Edit Material. 
Select Aluminum Alloys, 

2018 Alloy.

The Visual Properties of 
the material are also 
applied by default. If you 
are using Advanced 

graphics and RealView, 
the part will appear 
similar to the one shown 
here.

22 Errors.

Start COSMOSXpress 
again and note the 
changes to the wizard. 
The Analyze and 
Results tabs have error 
markers.

Other changes (loads, 
restraints) can also be 
made at this point, prior 
to reanalyzing the part.
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23 Change load value.

Click the Load tab and click Edit.

Click Next and change the force value to 500.

24 Update.

Click Next and Update.

25 Results.

The factor of safety has increased with the change in geometry. The 
part is no longer overstressed.Pre-
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26 Reduced stress.

Along with the increase in the factor of safety comes the expected 
decrease in stress. The deformations are also smaller.
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Exercise 21:
Flange

Create this part using the dimensions provided. 
Use relations wisely to maintain the design 
intent.

This lab uses the following skills:

� Revolved features.
� Circular patterning.

Units: inches

Design Intent The design intent for this part is as follows:

1. Holes in the pattern are equally spaced.
2. Holes are equal diameter.
3. All fillets are equal and are R0.25”.

Note that construction circles can be created using the Properties of a 
circle.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 
create the part.

Top View

Front View
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Exercise 22:
Wheel

Create this part using the 
dimensions provided. Use 
relations wisely to maintain the 
design intent. 

This lab uses the following 
skills:

� Revolved features.
� Optional: Text in a sketch.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical about the axis of the hub.
2. Hub has draft.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 
create the part.

Front and Top views, and Section A-A from Front view.Pre-
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Optional: Text in a 
Sketch

Text can be added to a sketch and extruded to form a cut or a boss. The 
text can be positioned freely, located using dimensions or geometric 
relations, or made to follow sketch geometry or model edges.

Introducing:

Text Tool

The text tool allows you to insert text into a sketch and use it to create 
an extruded boss or cut feature. Since SolidWorks software is a true 
Windows application, it supports whatever fonts you have installed on 
your system.

Where to Find It � Click Tools, Sketch Entities, Text....

� Or, on the Sketch toolbar click Text .

1 Construction geometry.

Sketch on the front face and 
add construction lines and arcs 
as shown.

Tip Use Symmetric relationships 
between the endpoints of the 
arcs and the vertical centerline.

2 Text on a curve.

Create two pieces of text, one 
attached to each arc. They 
have the following properties:

� Text: Designed using

� Font: Courier New 11pt

� Alignment: Center Align

� Width Factor: 100%

� Spacing: 100%

� Text: SolidWorks

� Font: Arial Black 20pt.

� Alignment: Full Justify

� Width Factor: 100%

� Spacing: not applicable when using Full Justify

3 Extrude.

Extrude a boss with a Depth of 1mm and Draft of 1°.

4 Save the part and close it.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

214 Exercise 23

Exercise 23:
Compression 
Plate

Create this part using the 
dimensions provided. Use 
relations wisely to maintain the 
design intent.

This lab uses the following 
skills:

� Sketching.
� Revolved features.
� Symmetry.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical.
2. Ribs are equally spaced.
3. All fillets and rounds are 1mm.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Top view

Front view
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Bottom view

Right view

Detail A

Detail B
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Exercise 24:
Tool Post

Create this part using the dimen-
sions provided. Use relations 
wisely to maintain the design 
intent.

This lab uses the following skills:

� Sketching.
� Revolved features.
� Sketch offsets.

Units: inches

Design Intent The design intent for this part is as follows:

1. Part is symmetrical.
2. Center hole is though all.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Top view

Front view

Section A-A 
from Front view
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Exercise 25:
Sweeps

Create these three parts using swept features. These require a path and a 
section.

Units: millimeters

Cotter Pin The Cotter Pin uses a path that describes the inner edge of the 
sweep.

Paper Clip The Paper Clip is defined by a path that describes the centerline of 
the sweep.

Thanks to Paul Gimbel, TriMech Solutions, LLC for submitting these examples.
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Mitered Sweep The Mitered Sweep is defined by a path that describes the outer 
edge of the sweep.
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Exercise 26:
COSMOSXpress

Perform a first pass 
stress analysis on an 
existing part.

This lab uses the 
following 
COSMOSXpress skills:

� Assigning material 
properties.

� Defining restraints.
� Defining loads.
� Running an 

analysis.
� Displaying the results.

Units: inches

1 Open Pump Cover.

This part represents a cover that 
will be filled with oil under high 
pressure.

Start the COSMOSXpress wizard.

2 Set the units.

Click Options... and set the units to English (IPS) and check Show 

annotation for maximum and minimum in the result plots. Click 
Next.

3 Specify the material.

Select Aluminum Alloys and select 2014 Alloy from the list.

4 Define the restraint set.

Select the uppermost faces of the 
four tabs and the cylindrical faces 
of the four bolt holes.
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5 Define the load set.

Select Pressure for the type of 
load. Right-click one of the faces on 
the inside of the Pump Cover. Pick 
Select Tangency from the shortcut 
menu.

6 Set the pressure value and 

direction.

Set the pressure value to 500 psi. 
Click Show symbol and verify that 
the arrows are pointing in the 
correct direction.

7 Run the analysis.

Use the default mesh settings.

8 Results.

The factor of safety is less than 1 
indicating that the part is over 
stressed.

9 Stress distribution 

and deformation.

Display the stress 
distribution in the 
model. Play the 
animation of the 
deformation.

10 Change the material.

Change the material to 
Ductile Iron.

11 Update.

Click Update to rerun the analysis using the new material.

12 Factor of Safety.

The new factor of safety is in excess of 1.

13 Close and save.

Click Close. Click Yes to save the COSMOSXpress data.

14 Save and close the part.
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Editing: Repairs

Upon successful completion of this lesson, you will be able to:

� Diagnose various problems in a part and repair them.

� Utilize all the available tools to edit and make changes to a part.Pre-
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Part Editing The SolidWorks software provides the capability to edit virtually 
anything at any time. In order to emphasize this, the major tools for 
editing parts are covered and reviewed here in one lesson.

Stages in the 
Process

Some key stages in the process of modifying this part are shown in the 
following list. Each of these topics comprises a section in the lesson.

� Add and delete relations

Sometimes the relations in a sketch must be deleted or changed due to 
changes in the design.

� What’s Wrong?

When errors occur, the What’s Wrong option can be used to 
investigate and pinpoint the problem.

� Edit sketch

Making changes to the geometry and relations of any sketch can be 
done through Edit Sketch.

� Check sketch for feature

Check Sketch can check a sketch for problems, verifying its suitability 
for use in a feature. You must Edit Sketch before using Check Sketch 

for Feature.

� Edit feature

Changes to how a feature is created are done through Edit Feature. 
The same dialog that is used to create a feature is used to edit it.

� Edit sketch plane

Sketched on Front instead of Top? Use Edit Sketch Plane to 
transfer the sketch from the current plane to a different plane or face.

� Reorder

Features that have been created in the wrong order can be reordered by 
simple dragging in the FeatureManager design tree.

� Rollback

Rollback and roll forward are used to visit previous stages of the 
model. This allows you to see the model in earlier versions and add in 
missing features.

� Change dimension value

This is probably one of the most typical changes. If design intent was 
properly captured, changes in dimensions cause changes in the size of 
individual features and ultimately the entire model.
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Editing Topics Editing covers a wide range of topics from fixing broken sketches to 
reordering things in the FeatureManager design tree. These topics can 
be summarized as repairing errors, interrogating the part, and changing 
the design of the part. Each is described below.

Information from a 
Model

Nondestructive testing of a model can yield many important insights as 
to how the model was created, the relationships that were established, 
and changes that can be incorporated. This section will focus on using 
editing tools in conjunction with rollback to “interrogate” the model.

Finding and 
Repairing 
Problems

Finding and repairing problems in a part is a key skill in solid 
modeling. Many changes that are made to a given part (Edit Feature, 
Edit Sketch and Reorder, to name a few) can cause features down the 
line to fail. Pinpointing the problem area and finding the solution will 
be discussed in this section.

Problems can occur in sketches or any other feature of the part. 
Although there are many types of errors, there are some that occur 
more often than others. Dangling dimensions and relations are very 
common, as is extraneous geometry in sketches. Using some of the 
tools available in the SolidWorks software, problems can be easily 
diagnosed and repaired.

Opening a part that has errors can be confusing. One error near the 
beginning of the process can often cause many later features to fail 
along with it. Repairing that initial error may fix the rest of the errors as 
well. Some repairs will be made to this model before interrogating and 
changing it.

Procedure We will begin by opening an existing part.

1 Open the part named Editing CS.

This part was built and saved with numerous errors.

2 Rebuild errors.

Upon opening, the system displays a 
message box, labelled with the part 
name and the phrase What’s Wrong. 
Each error is listed by feature name in 
the scrollable dialog.

Only a portion of the model is visible; 
errors have caused some features to 
fail.
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What’s Wrong 
Dialog

The What’s Wrong dialog lists all the errors in the part. The errors 
themselves are broken down into Errors that prevent features from 
being created and Warnings that do not. The other columns offer some 
help in diagnosing the problem including a preview in some cases.

Tip The columns of the dialog can be sorted by the column headers. Click 
on the Type header to sort by Error and Warning types.

Tip Click the question mark  to open on-line help regarding this type of 
error.

Note The display of this error dialog is controlled by the option Show errors 

every rebuild on the Tools, Options, System Options, General 
menu. This option must be enabled in order for this message to appear. 
There are several controls:

� Through the Tools, Options... dialog
� Through the message dialog itself: Display What’s Wrong during 

rebuild

� Through the message dialog itself: display of just errors (Show 

errors), just warnings (Show warnings) or both
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3 FeatureManager design tree.

The FeatureManager design tree lists many errors 
indicated with markers. The markers placed next 
to the features have particular meanings:

� Top Level Error

The Top Level Error marker  marks an error 
in the tree below. Useful in assemblies and 
drawings to see part errors.

� Expand

An Expand marker  is placed next to a feature 
that has an error or warning on the feature 
beneath it. Expand the feature to see the problem. 
The text of the feature is shown in green.

� Error 

An Error marker  is placed next to a feature 
that has a problem and cannot create geometry. 
The text of the feature is shown in red.

� Warning

A Warning marker  is placed next to a feature 
that has a problem but creates geometry. This is 
common for “dangling” geometry and relations. 
The text of the feature is shown in green.

� Normal Features

Normal features that do not have warnings or errors appear with black 
text.

Where to Begin Features are rebuilt in sequence from the top of the tree. The best place 
to begin is at the first (base) feature with an error, in this case that is the 
feature Base_Plate. An error in the base feature may cause a series 
of errors in the child features.
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4 What’s Wrong?

The What’s Wrong option is used to highlight an error message for a 
selected feature. Right-click the Base_Plate feature and select 
What’s Wrong?. The message indicates that the sketch cannot be used 
for the feature because an endpoint is wrongly shared.

5 Edit the sketch.

The What’s Wrong message has indicated the sketch (Sketch1) as 
the problem. Edit the sketch of the feature.

Tip For Over Defined sketch problems, see Overdefined Sketches on 
page 114 of Modeling a Casting or Forging in Volume 1.

Check Sketch 
for Feature

Check Sketch for Feature allows you to check the validity of a sketch 

for use in a feature. This can be done either before the feature is created 

or, as in this example, after. Since different features have different sketch 

requirements – for example, revolved features require an axis of revolu-

tion – you select the type of feature for which the sketch is to be evalu-

ated. Any geometry that impedes the creation of that feature will be 

highlighted. It will also check for missing and inappropriate geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Check Sketch for 

Feature....

6 Check Sketch.

The Check Sketch for Feature... 
command checks for incorrect 
geometry in the sketch, compared to 
what is required by the Contour type. 
In this case the Feature Usage is set to Base Extrude because that is 
the type of feature this sketch belongs to. The Contour type is 
determined from the type of feature.

Click Check.
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7 Message.

A message appears stating the 
same message that we got from 
What’s Wrong and the system 
highlights the problem geometry, 
in this case, one of the three lines 
that share a common endpoint.

Click OK to close the message window and click Close to close the 
Check Sketch for Feature dialog box.

Box Selection Box selection allows you to select multiple sketch entities with a drag-
window. Entities are selected based on whether the window is dragged 
from right to left or left to right. The selection includes dimensions.

Left to right: Only the geometry 
completely within the window 
(the short line) is selected.

Right to left: The geometry 
within and crossing the window 
(short line and two long lines) is 
selected.

This is also called cross 

selection.

Tip Using Shift with the box selection maintains any previous selections. 
Using Control with the box selection clears previous selections.

These selection methods will not be used in this example. Instead, an 
automated repair method will be used.
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Repairing the 
Sketch

Making repairs to a sketch can be accomplished in several ways. In a 
simple case like this one, a single line is causing the error. That line was 
highlighted by Check Sketch for Feature. The line can simply be 
deleted and the Check Sketch for Feature command can be used 
again to confirm that the sketch is error free.

A more automated method using Repair Sketch can be used to fix the 
errors.

Introducing: 

Repair Sketch

Repair Sketch is used to analyze errors in a sketch and repair them. It 
can be used to repair errors that stem from small gaps, overlapping 
geometry and multiple short segments.

Where to Find It � From the Tools menu, select Sketch Tools, Repair Sketch.

� Or, on the 2D to 3D toolbar click the Repair Sketch  tool.

8 Repair.

Click Tools, Sketch Tools, Repair Sketch. The system deletes the 
offending line.

9 Check again.

Use Check Sketch for Feature again to see the result of the repair. 
The dialog displays no problems with the sketch.

10 Add dimensions and relations.

Dimensions and relations can be deleted during the process of repairing 
a sketch. Add replacement dimensions and relations and exit the 
sketch.

11 Remaining errors.

All the errors and warnings that remain are listed in the dialog. So that 
you don’t see this message dialog every time you make a correction, 
deselect the Display What’s Wrong during rebuild option. More of 
the model appears.

12 Next error.

The top error on the list is for Sketch2 under the feature 
Vertical_Plate. It contains Dangling sketch entities according 
to the message. Dangling sketch entities are found when dimensions or 
relations reference things that no longer exist.

Note Dangling dimensions and relations can 
be hidden from view. The Hide 

dangling dimensions and 

annotations option can be found under 
Tools, Options, Document Properties, 

Annotations Display.
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13 Edit the sketch.

Edit the sketch of the 
Vertical_Plate 
feature. Note that the 
85mm dimension is a 
different color than the 
other dimensions. This is 
the color used for dangling 
dimensions and relations. The dimension is trying to attach to geometry 
that no longer exists, and therefore it is considered dangling.

Reattach 

Dimensions

Dangling dimensions and relations can be quickly repaired by 
reattching them to the model.

14 Select the dimension.

Click on the 85mm 
dimension to see the drag 
handles. The end marked 
red is the dangling end. 
Dangling relations on 
geometry are marked in a 
similar fashion.

15 Drag and drop.

Drag the red handle and 
drop it on the bottom 
edge of the part when the 
edge cursor appears. If 
you try to drop it on an 
inappropriate location, 
the cursor will display the 

 symbol. Both the dimension and the geometry return to their normal 
colors. The dimension’s value updates to reflect the size of the 
geometry. If you need to change the dimension, double-click it.

16 Exit the sketch to rebuild the model.
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17 Remaining errors.

A few errors/warnings 
remain. The Rib_Under 
feature will be worked on 
next.

Edit the sketch of that 
feature.

18 Dangling relations.

One line of the sketch is 
shown in the dangling 
color. Click on that line to 
select it and display its 
drag handles. The red 
handle can be used in a 
drag and drop procedure, 
similar to what was done 
for the dangling 
dimension.

When you click on the line, its relations are displayed 
in the PropertyManager. The relation that is dangling 
is color coded the same as the sketch entity itself.

Note If you double-click the dangling entity, callouts also appear in the 
graphics window.

19 Reattach.

Drag the red handle onto 
the rightmost vertical line 
of the Base_Plate. 
The system transfers the 
collinear relation from the 
missing entity (the 
deleted plane) to the 
model edge. The sketch is 
no longer dangling.

Repairing Relations 

Using Display/

Delete Relations

Some relations, like coincident points, can only be repaired through the 
Display/Delete Relations command. This option allows you to sort 
through all the relations in a sketch.
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Introducing: 

Display/Delete 

Relations

Display/Delete Relations provides a way to systematically query all 
entities in a sketch. In addition, you can display the relations based on 
criteria such as dangling or over defined. You can also use Display/

Delete Relations to repair dangling relations.

Where to Find It � Click Tools, Relations, Display/Delete....
� Right-click in the sketch, and select Display/Delete Relations.

� Click Display/Delete Relations  on the Sketch toolbar.

20 Undo.

Click Undo to remove the last event, the repair of the dangling relation.

21 Display/Delete Relations.

Right-click, and select Display/

Delete Relations.

In the Filter list select Dangling. 
This displays only the relations 
that are dangling.

Select the Collinear relation.

22 Entities section.

Look at the lower section of the PropertyManager. 
There is a list of the entities used by this relation. 
One entity has a Fully Defined status, the other is 
Dangling.

Select the entity marked Dangling.
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23 Replacement.

Select the vertical 
edge of the 
Base_Plate.

Tip Select Other can be 
used to choose the 
edge.

Click Replace and 
then click OK.

24 Exit the sketch.

Exit the sketch to see 
the one remaining 
error. The marker is 
placed on the feature Rib_Fillet. Use What’s Wrong on the 
Rib_Fillet feature.

Highlighting 

Problem Areas

Certain error messages contain the preview symbol . If you click on 
that marker, the system will highlight the problem area in the model. If 
you use What’s Wrong on the feature directly, it automatically 
highlights the problem area.

25 Highlight message.

Click on the preview symbol to visually display the area in which the 
error occurs.

26 Graphic error display.

The area where the error 
occurs is highlighted with a 
mesh pattern. The fillet fails 
in this area. Close the 
message dialog.

27 Change the value.

Using the graphic and text 

information supplied by the 

system, it is clear that the 

problem lies in the radius 

value of the fillet. Set the value to something much smaller, for 
example 5mm, and rebuild.
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28 Model rebuilt.

The model is now rebuilt without any error or warnings.

Information 
From a Model

The part has some built-in problems 
related to the sequence of features. These 
problems will become evident when it 
comes time to make design changes. In 
order to understand the way that this part 
was constructed, we will walk through the 
steps of building it and introduce some of 
the tools that will be used. The design 
intent of the part will be revealed as the features are rebuilt one at a 
time.

Introducing: Go To The Go To... option can be used to search the text of the 
FeatureManager for a specific word or set of characters. Features are 
expanded to show any features found.

Where to Find It � Right-click the top level feature, and select Go To....

29 Go To.

Right-click the top level feature 
and select Go To.... Type the partial 
name sketch and click Start 

from the top.

30 Find Next.

Click Find Next until the last occurrence is found. 
The message This item was not found will 
appear.

The search expanded all the features that have 
sketches so that the sketches are visible.

Tip You can close all expanded features by right-
clicking in the FeatureManager and choosing 
Collapse Items.
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Introducing: The 

Rollback Bar

You can roll back a part using the Rollback Bar in the FeatureManager 
design tree. The rollback bar is a wide yellow line which turns blue 
when selected. Drag the bar up or down the FeatureManager design 
tree to step forward or backward through the regeneration sequence.

Where to Find It � Drag the rollback bar in the FeatureManager design tree.
� Or, right-click a feature, and select Rollback from the shortcut 

menu. This places the bar before the selected feature.
� Or, right-click in the FeatureManager and select Roll To Previous 

to move to the last position of the rollback bar. Select Roll to End 
to move the bar to after the last feature in the tree.

� Or, click Tools, Options, System Options, FeatureManager and 
click Arrow key navigation. This allows the arrow keys to move 
the rollback bar.

The focus must be set to the rollback bar by 
clicking on it. If the focus is set to the Graphics 
Area, the arrow keys will rotate the model.

Note The Rollback tool is also useful when editing large parts to limit 
rebuilding. Roll back to the position just after the feature that you are 
editing. When the editing is completed, the part is rebuilt only up to the 
rollback bar. This prevents the entire part from being rebuilt.

31 Roll the part back to the beginning.

Using Rollback, place the bar at the first feature 
in the FeatureManager design tree. This places the 
rollback bar after the feature Base_Plate. It 
can then be rolled forward one feature at a time.
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32 Feature Base_Plate.

The Base_Plate was created from a 
rectangle and extruded. To investigate this 
further, use Edit Feature on the feature.

33 Edit Feature.

The graphics show the sketch 
geometry and the preview. Cancel the 
dialog.

Roll forward one feature by dragging 
the marker or moving it down with the 
arrow key.

34 Feature Base_Fillet.

Fillets of equal radius are added to the front 
corners in this feature.

Roll forward to a position just before the 
Vertical_Plate feature.

35 Feature Vertical_Plate.

This feature was sketched on the rear face of 
the model and extruded towards the front.

36 Edit Sketch.

Edit the sketch of the feature 
Vertical_Plate to see the 
geometry and its connections points.
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37 Display/Delete Relations. 

Click Display/Delete Relations . Set the Filter 
to All in this sketch and click individual relations 
in the list to explore all of geometric relations on 
the sketch entities. The relations will explain how 
entities are attached to each other and to the rest of 
the model.

Close the dialog and close the sketch without 
making any changes.

38 Sketch geometry.

To see the sketch geometry more 
clearly, right-click Sketch2, and 
select Show sketch. The sketch 
icon appears in color when it is 
being shown. Using Hidden Lines 

Removed, the position of the 
sketch is clear.

Roll forward to a position just 
before the Circular_Plane feature.

39 Circular_Plane.

The plane was created for sketching 
the next feature, a circular boss. It 
lies behind Sketch2. 

40 Parent/Child relationships.

Check the relationships on the 
plane. Right-click the plane and 
select Parent/Child.... The Parent 
of the plane is the Base_Plate 
feature – the plane is dependent 
upon it. The Children are 
Sketch3 and the 
Circular_Boss; they are 
dependent on the plane.

Click Close and roll forward.
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41 Feature Circular_Boss. 

Circular_Plane was used for 
sketching Circular_Boss. The sketch 
was extruded through the part from the 
rear.

Roll forward to a position just before the 
Wall_Thickness feature.

42 Feature Rib_Under.

This feature was sketched as a rectangle 
and extruded up into the 
Circular_Boss. 

Rollback to a 
Sketch

If the rollback bar is dragged and dropped between an absorbed sketch 
and its feature, a dialog appears. The dialog tells you that you have 
chosen to rollback to an absorbed feature and that the feature will be 
temporarily unabsorbed so it can be edited. This changes the sequence 
so that the sketch precedes the feature.

43 Rollback to 

Sketch4.

Move the rollback bar 
to a position between 
the Rib_Under 
feature and its sketch 
Sketch4. Click OK 
when the message 
appears. 

Tip This technique is very 
useful when editing 
features that have 
multiple sketches such 
as Sweep and Loft 
features.

Sweeps and lofts are 
covered in the course 
Advanced Part 

Modeling.
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44 Roll Forward.

Roll forward to a position after Sketch4.

Introducing: Edit 

Sketch Plane

Edit Sketch Plane allows you to change the plane or face that a 
specific sketch is created on. The new sketch plane does not have to be 
parallel to the original.

Where to Find It � From the Edit menu, select Sketch Plane....
� Or, right-click the sketch select Edit Sketch Plane....

45 Edit Sketch Plane.

Right-click the Sketch4 feature and 
choose the option Edit Sketch Plane to 
determine which sketch plane was used. 
The highlighted face identifies the sketch 
plane.

Click Cancel and roll forward to a 
position after the Wall_Thickness 
feature.

Note The selection for Sketch Plane/Face can be cleared to force the sketch 
plane reference to dangle. A confirmation message appears in that case.

There is no selection for the sketch plane 
reference. Select OK if you would like this to be a 
gangling reference. 
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46 Feature Wall_Thickness.

The model was shelled out leaving both 
circular faces and the bottom face open. 
See the section cut at the right for details.

Roll forward to a position after the 
CounterBore feature.

47 Feature CounterBore.

The Hole Wizard was used to create a 
counterbore hole on the top planar face. 
However, due to the thin wall, it appears as 
a simple cut.

Roll forward to a position after the 
LPattern1 feature.

48 Pattern feature.

The CounterBore was patterned using a 
linear pattern, LPattern1.

Roll forward to a position after the 
Rib_Fillet feature.

49 Rib_Fillet feature.

The Rib_Fillet feature creates large 
fillets where the Rib_Under joins the 
Circular_Boss and Base_Plate.

Right-click and select Roll to End.
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50 Circ_Fillet feature.

This feature creates smaller fillets on both 
sides of the Vertical_Plate.

Rebuilding 
Tools

Rebuilding a model incorporates the changes that you have made. Slow 
rebuild times can slow down the modeling process significantly. There 
are some tools available to optimize rebuilding times.

Rollback to 
Feature

Rollback can be used to limit the rebuilding time by 
rolling back to the feature being edited. For example, 
if the Vertical_Plate is being edited, rollback 
to a position just after that feature.

Changes are made to the feature and it is rebuilt. Due 
to the rollback position, only the features before the 
bar are rebuilt, limiting the scope of the rebuild. The 
remainder of the part will be rebuilt when the bar is 
moved or when the part is saved.

Feature 
Suppression

Feature Suppression is a more permanent method 
of limiting rebuild time. Features that are suppressed 
are not rebuilt. Configurations can be used to arrange 
combinations of suppressed features.

Rebuild Feedback 
and Interrupt

During a rebuild, a progress bar and status are shown on the bottom bar 
of the SolidWorks window. The rebuild can be stopped by pressing the 
Esc (Escape) key. 
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Feature Statistics Feature Statistics is a tool that displays the amount of time it takes to 
rebuild each feature in a part. Use this tool to identify the features that 
take a long time to rebuild. Once they are identified, you can possibly 
edited them to increase efficiency, or suppress them if they are not 
critical to the editing process.

Introducing: Feature 

Statistics

The Feature Statistics dialog box displays a list of all features and 
their rebuild times in descending order.

� Feature Order 
Lists each item in the FeatureManager design tree: features, sketches, 
and derived planes. Use the shortcut menu to Edit Feature, Suppress 
features, and so on.

� Time%

Displays the percentage of the total part rebuild time to regenerate each 
item.

� Time

Displays the amount of time in seconds that each item takes to rebuild.

Where to Find It � From the menu, select Tools, Feature Statistics....

51 Feature Statistics.

Click Tools,

Feature Statistics....

The features are listed in 
descending order according to the 
amount of time required to 
regenerate them.
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Interpreting the Data The first thing to keep in mind is that the total rebuild time for this part 
is approximately 1/3 second, so a change to any one feature is not likely 

to make a significant difference.

The second thing is the number of significant digits and rounding error. 
For example, Feature1 may appear to take twice as long to rebuild 
as Feature2, 0.02 seconds versus 0.01 seconds. Does this indicate a 
problem with Feature1? Not necessarily. It is quite possible that 
Feature1 takes 0.0151 seconds while Feature2 takes 0.0149 
seconds, a difference of only 0.0002 seconds.

Use Feature Statistics to identify features that significantly impact 
rebuild time. Then either:

� Suppress features to improve performance.
� Analyze and modify features to improve performance.

What Affects 

Rebuild Time?

Features can be analyzed to determine why they behave as they do. 
Depending on the feature type and how it used, the reasons will vary. 

For sketched features, look for external relations and end conditions 
that reference other features. Keep these relations attached to the 
earliest feature possible. Do the same for sketch planes.

Tip In general, the more parents that a feature has, the slower it will rebuild.

See Repairing Relations Using Display/Delete Relations on page 231 
for an example of changing relations in a sketch.

For features applied to edges or faces, check the feature’s options and 
the position of the feature in the FeatureManager. See Edit Feature on 
page 253 for an example of changing relations in a feature.

In general, there are four tools available to modify features:

� Edit Feature

� Edit Sketch

� Edit Sketch Plane

� Delete Feature
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Exercise 27:
Errors1

Edit this part using the 
information and 
dimensions provided 
to repair the errors and 
warnings and 
complete the part.

This lab reinforces the 
following skills:

� Using What’s 

Wrong?

� Edit Sketch.
� Adding geometric 

relations.
� Edit Feature.
� Fixing rebuild 

errors.

Procedure Open the existing part Errors1 and make several edits to remove the 
errors and warnings from the part. Use the drawing below as a guide.

Tip Use Merge solids in the Mirror1 feature. The completed part should 
be a single solid body.

Before

After
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Exercise 28:
Errors2

Edit this part using the 
information and 
dimensions provided to 
repair the errors and 
warnings and complete the 
part.

This lab reinforces the 
following skills:

� Using What’s Wrong?

� Edit Sketch.
� Adding and deleting 

geometric relations.
� Edit Feature.
� Fixing rebuild errors.

Procedure Open the existing part Errors2 and make several edits to remove the 
errors and warnings from the part. Use the drawing below as a guide.

Before

After
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Exercise 29:
Copy and 
Dangling 
Relations

Complete this part by copying 
features and making repairs.

This lab uses the following 
skills:

� Copying features between 
parts.

� Editing sketches to repair 
dangling relations.

Units: millimeters

Procedure Open existing parts.

1 Open the BoneWrench and HexCut.

Open both files and click Window, Tile Vertically.

2 Copy Hex feature.

Control-Drag a face of the Hex feature and drop it onto the top planar 
face of the BoneWrench as shown.

Click the Dangle button on the Copy Confirmation dialog.
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3 Repair.

Edit the sketch with an 
error and select the inner 
construction circle. 

Drag and drop the red 
marker to an appropriate 
replacement reference.

Size the hexagon as 
shown below.

Locations Use the following 
graphics to locate and 
size a total of 4 copied 
cuts using the end 
condition Through All.

4 (Optional)Cosmetic fillets.

Optionally add the following fillets and rounds:

5 Save the parts and close them.

R2mm R1mm R0.5mm
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Lesson 8
Editing: Design Changes

Upon successful completion of this lesson, you will be able to:

� Understand how modeling techniques influence the ability to 
modify a part.

� Use Sketch Contours to define the shape of a feature.
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Part Editing The SolidWorks software provides the capability to edit virtually 
anything at any time. In order to emphasize this, the major tools for 
editing parts are used here to create a design change.

Stages in the 
Process

Some key stages in the process of modifying this part are shown in the 
following list. Each of these topics comprises a section in the lesson.

� Delete and rename feature

The Delete key is one of the most straightforward editing tools. 
Renaming features is useful for later use of the part.

� Use editing tools

Use common editing tools such as Edit Feature, Reorder and Edit 
Sketch to modify the geometry and design intent.

� Sketch contours

A single sketch can be used to create multiple features by using 
contours within the sketch.

� Adding textures

Texture maps can be added to the entire part or selected faces to 
provide a realistic appearance of materials or threads.

Design 
Changes

Some changes have to be made to the model. Some will change the 
structure of it, others only dimension values. Making design changes to 
a model can be as simple as changing the value of a dimension and as 
difficult as removing external references. This section steps through a 
series of changes to a model. The focus is on editing features rather 
than deleting and reinserting them. Editing allows you to maintain 
references to drawings, assemblies or other parts that would be lost if 
you deleted the feature.

Procedure We will continue editing the part that was repaired in the previous 
lesson.

Required Changes The changes to the model are 
as follows:

� The circular boss is 
centered over the rib.

� The rib is rounded at the 
end.

� The circular boss is 
tangent to the right edge.

� A cutout with holes is 
added to the base.

� Both holes are equal 
radius.

� Only the base is shelled.
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Deletions Any feature can be deleted from the model. Consideration should be 
given to what other features, other than the selected one, will be deleted 
with it. The Confirm Delete dialog lists Dependent Items that will be 
deleted with the selected one. The sketches of most features are not 
automatically deleted. However, the sketches associated with Hole 

Wizard features are automatically deleted when the hole is deleted. For 
other dependent features, deleting the parent will delete the children.

1 Open the part Editing CS Repaired.

2 Delete feature.

Select and delete the 
CounterBore feature. The 
check box, Also delete all child 

features, is already checked. The 
dialog indicates the LPattern1 
feature will also be deleted 
because it is a child of the 
CounterBore.

Click Yes to confirm the deletion.

3 Try to reorder.

Try to reorder the shell feature, Wall_Thickness, to a position 
immediately after the Base_Fillet. The cursor displays a “no 

move”  symbol and a dialog appears telling you that you cannot 
reorder because of parent/child relations. You cannot reorder a child 
before the parent.

Click OK.

4 Parent/Child.

Select the Wall_Thickness 
feature and click Parent/Child... 
from the right mouse menu. The 
dialog shows that the parents of 
the Wall_Thickness feature 
are Base_Plate and 
Circular_Boss.

The Circular_Boss references need to be removed in order for us 
to be able to reorder the feature.
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Edit Feature Edit Feature allows you to change a feature using the same dialog and 
user interface that was used to create it. Simple changes, like dimension 
values or directions, can be made along with more complex ones such 
as the removal or addition of selections.

5 Edit Feature.

Right-click the 
Wall_Thickness feature 
from the Parent/Child... 
dialog and select Edit 

Feature.

Select both of the 
highlighted circular 
faces. The Faces to 

Remove selection list 
will show only a single 
face.

When you reselect an 
already selected face, it 
acts like a toggle, 
deselecting it.

As an alternative, you can click on an item in the selection list and 
deselect it by pressing the Delete key on the keyboard. Sometimes this 
can be confusing because you might not always know which face is 
labeled Face<2>.

6 Changes to Parent/Child.

Editing the Wall_Thickness 
feature causes a change in the 
Parent/Child Relationship. The 
Parents section now lists only 
one feature, the Base_Plate.

Reorder Reorder allows for changes to the sequence of features in the model. 
Sequence changes are limited by parent/child relationships that exist.
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7 Reorder.

Drag the Wall_Thickness feature and reorder 
it by dropping it on the Base_Fillet. It is 
positioned after the Base_Fillet feature.

8 Results.

Now the shelling operation affects only the first 
and second features of the part.

Edit Sketch Edit Sketch opens the feature’s sketch for changes to dimension 
values, dimensions, and relations. In addition, geometry can be 
removed or added to the sketch.

9 Editing the sketch.

Edit the sketch of the 
Vertical_Plate 
feature.

10 Delete dimension.

Delete the horizontal linear dimension. This will cause the sketch to 
become under defined.

11 Add new relation.

Hold down Ctrl and select 
the rightmost vertical line 
and the arc. Right-click 
and select Tangent. This 
adds a Tangent relation 
between the line and the 
arc.
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12 Exit the sketch.

13 Resulting model.

This moves the 
Circular_Boss so 
that its cylinder face is 
tangent to the outer edge 
of the Base_Plate. 
The fillets update to the 
new positions.

14 Edit the Rib_Under sketch 

The Rib_Under sketch is still tied 
to its original relations, the outer 
edge of the Base_Plate.

15 Edit the sketch.

16 Display relations.

Show all the geometric relations in 
the sketch using the All in this 

sketch option. In order to 
reposition the rib, most of the 
relations must be deleted.

Select and remove these relations 
using the Delete button:

� Collinear relation to the vertical edge of the Base_Plate.
� Both Distance relations (the two dimensions).

Keep the Collinear relation to the Vertical_Plate and the 
Vertical relation on the left hand line.

17 New geometry.

Delete the bottom line of the 
rectangle and add a tangent arc. 
Dimension the sketch as shown.
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18 Vertical relation.

Deleting the Collinear relation 
leaves the right vertical line 
without any relation to keep it 
vertical. To fix this, add a 
Vertical relation to the 
rightmost line.

19 Temporary graphics.

Turn on display of Temporary 

Axes and relate the center of the 
arc to the temporary axis. This 
will center the rib on the circular 
boss.

20 Result.

The Rib_Under feature is now 
centered under the Circular_Boss. 
It has a rounded front edge and is also 
inside the edge of the boss by a small 
amount.

21 Edit Sketch Plane.

Expand the listing of the 
Circular_Boss feature. Right-click 
the sketch and select Edit Sketch Plane 
from the shortcut menu.

You do not have to edit the sketch.
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22 Face or plane selection.

The current plane used in the 
sketch is highlighted along with the 
sketch geometry. You can now 
choose a new sketch plane.

Select the rear face of the model 
and click OK.

23 Edited sketch plane.

The Circular_Boss feature has 
been edited. The sketch now 
references a model face rather than a 
plane.

24 Delete the plane.

Check the Parent/Child Relationships of the plane. The 
Circular_Plane now has no children.

Delete the plane.

25 Edit Feature.

Edit the Circ_Fillet 
feature. Add the edge shown and 
click Apply.
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26 Result.

The additional edge is filleted as 
part of the Circ_Fillet 
feature.

27 Save and Close.

An existing part will be used for 
the reminder of the case study.

Rollback Rollback is a tool that has many uses. Previously, it was used to “walk 
through” a model showing the steps that were followed to build it. It is 
also useful to add features at a specific point in the part’s history.

28 Open Partial_Editing CS.

Open an existing part that is identical except for one additional sketch, 
Contour Selection. The sketch contains two circles enclosed 
within a rectangle.

29 Reorder and rollback.

Reorder the Contour 
Selection sketch to a position 
between the Base Fillet and 
Wall_Thickness features.

Rollback to a position between 
the Contour Selection 
sketch and Wall_Thickness 
feature.

Sketch 
Contours

Sketch Contours allow you to select portions of a sketch that are 
generated by the intersection of geometry and create features. This way 
you can use a partial sketch to create features.

Another advantage of this method is that the sketch can be reused, 
creating separate features from different portions of the sketch.

Two commands, Contour Select Tool and End Select Contours, are 
used to start and end the contour selection process.
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Contours 
Available

There are often multiple Sketch Contours available within a single 
sketch. Any boundary generated by the intersection of sketch geometry 
can be used singly or in combination with other contours.

Using this sketch as an example, there are some of the possible regions, 
contours and combinations available for use.

Introducing: 

Contour Select Tool

The Contour Select Tool is used to select one or more contours for use 

in a feature. The cursor looks like this:  when the Contour Select 

Tool is active.

Where to Find It � Right-click in the graphics area and choose Contour Select Tool.
� Right-click a sketch and choose Contour Select Tool.

Introducing: End 

Select Contours

End Select Contours is used end the selection of contours.

Where to Find It � Right-click in the graphics area or on the sketch in the 
FeatureManager design tree and choose End Select Contours.

� Click the confirmation corner symbol .

Individual 

Regions

Individual 

Contours

Combined 

Contour 

Selection
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30 Extrude a cut.

Use the Contour Select Tool to 
select the rectangular region of the 
sketch.

Create a blind cut, 10mm deep into 
the model.

Rename the feature Hole_Mtg.

Shared Sketches A sketch can be used more than once to create multiple features. 

When you create a feature, the sketch is absorbed into the feature and 
hidden from view. When you activate the Contour Select Tool, the 
sketch is automatically made visible.

31 Add more cuts.

Select the sketch of the 
Hole_Mtg feature and click 

Extruded Cut  on the 
Features toolbar. 

Expand the Selected 

Contours list and select the 
two circular regions of the 
sketch.

Extrude the regions using the 
end condition Through All.

Rename the cuts Thru_Holes.

32 Roll to End.

Right-click in the 
FeatureManager design 
tree and select Roll to 

End. Note that the cut 
holes are used in the 
shelling operation to 
create additional, 
unneeded faces.
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33 Reorder.

Reorder the Thru_Holes feature to a 
position after the Wall_Thickness feature. 
The result is that the Thru_Holes feature is 
not affected by the shelling.

34 Change wall thickness.

Change the wall thickness to 6mm and rebuild 
to complete the model.

Copying Fillets A quick and easy way to create a new fillet is to copy it from an 
existing feature. The new fillet is the same type and size but unrelated 
to the original. 

35 Copy.

Hold down Ctrl and drag the Circ_Fillet feature onto the edge of 
the model. Release the mouse button.

The fillet can be copied from the FeatureManager design tree, or 
directly from the model.Pre-
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36 New fillet feature.

A new fillet feature is created on the edge. 

Edit the fillet and add the edge on the opposite side. Change the radius 
value to 3mm.

Chamfers can be copied using the same procedure.

37 Trimetric view.

Change the view orientation to a 
Trimetric view.

Introducing: Section 

View

Section View cuts the view using one or more section planes. The 
planes can be dragged dynamically. Reference planes or planar faces 
can be used. 

Where to Find It � Click Section View  on the View toolbar.
� Or, click View, Display, Section View.

38 Select Face.

Select the planar face indicated. It will be used 
to define the section plane.

Note You do not have to pre-select the section plane. 
If you do not, the system will use a default 
section plane, usually the Front.
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39 Section view.

Click Section View  to use 
the selected face as the 
section plane.

The Section 1 group box 
includes options for the 
Reference Section Plane, 
Section Direction, Offset 

Distance and Angles.

40 Drag the plane.

Using the arrows, drag in a 
direction normal to the plane and 
drop.

The plane angle can be changed by 
dragging the edges of the section 
plane.

41 Reverse section direction.

Click Reverse Section Direction 

 to reverse the direction of the 
section. 

Click Cancel to close the dialog.
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Adding 
Textures

Make the model look more realistic by adding Textures to faces, 
surfaces, bodies, features and components. The quality of the texture is 
influenced by the graphics adaptor. For more information, see RealView 

Graphics on page 193.

Where to Find It � Click Edit Texture  on the Standard toolbar.
� Or, right-click a face, feature or part and choose Appearance, 

Texture....

Note The textures are divided into folders such as Metal, Plastic and Stone 

with sub-folders. 

42 Geometry selection.

Right-click the top level feature (part name) and 
choose Appearance, Texture....

43 Texture selection.

Click the folders Metal 
and Cast. Select the 
texture Cast Rough 
from the Texture 

Selection list.

The texture is 
previewed in the 
Texture Properties 
group box.

All faces of the 
selected solid body 
share the same texture.
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44 Thread texture.

Select the two 
“hole” faces and 
right-click 
Appearance, 

Texture....

Choose the folder 
Thread and the 
texture Thread1.

Adjust the Scale of 
the texture using 

the Scale  slider.
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Exercise 30:
Changes

Make changes to the part created in the 
previous lesson.

This exercise uses the following skills:

� Deleting features.
� Using Link Values.
� Reordering features.

Procedure Use the following procedure:

1 Open the part Changes.

Several changes and additions will be 
made to the model.

2 Delete.

Delete the mounting holes, cutout and 
shell (Cut-Extrude1, 
Wall_Thickness and Cut-
Extrude2) from the model.

3 Equal thickness.

Set the thicknesses of the 
Base_Plate and 
Vertical_Plate to the same 
value, 12mm, using Link Values.
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4 Cut.

Remove the portion of the 
Vert_Plate on the right side of 
the Circular_Boss and 
Rib_Under.

Edit and Reorder features where 
necessary to maintain the filleting.

5 Fillet.

Add another fillet the same radius as 
the Circ_Fillet.

6 Counterbored holes.

Add two counterbored holes of the 
following size:

ANSI Metric

M6 Hex Cap Screw

Through All

Reorder features where necessary to 
avoid undercuts.

7 Save and close the part.
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Exercise 31:
Adding Draft

Edit this part using the information and 
dimensions provided. Use editing 
techniques to maintain the design intent.

This lab reinforces the following skills:

� Edit Sketch.
� Adding and deleting geometric 

relations.

� Edit Feature.
� Edit Sketch Plane.

Procedure Open the existing part Add Draft, and make several edits using the 
final drawing below. Change the model so that 5° of draft is added.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

270 Exercise 32

Exercise 32:
Editing

Edit this part using the information and dimensions provided. Use 
equations, relations or link values to maintain the design intent.

This lab reinforces the following skills:

� Edit Sketch and Edit Sketch Plane.
� Adding and deleting geometric relations.
� Edit Feature.
� Reorder.
� Inserting Dimensions.

Procedure Open the existing part Editing, and make several edits:

Change the existing part, editing and adding geometry and relations, to 
match the version shown below.
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Exercise 33:
Contour 
Sketches #1-#4

Create this part using the information provided. Extrude profiles to 
create the parts.

The existing part are Contour Sketches #1-#4.

#1

Depth: 50mm

and 30mm

#2

Depth: 3.5”, 1” 

and 2.5”

#3

Depth: 30mm and 

10mm

#4

Depth: 1.5” and 

0.5”
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Exercise 34:
Handle Arm

Create this part using the 
information and sketch provided. 
Extrude profiles to create the part. 

This lab reinforces the following 
skills:

� Contour selection.
� Extrusions.

Procedure Open an existing part.

1 Open the part named Handle Arm.

It contains a single sketch.

2 First feature.

Using the Contour Select Tool, select the proper 
geometry and extrude.

Depth = 0.75”.

3 Boss feature.

Using the same 
sketch, select 
contours and 
extrude.

Depth = 0.25”.

4 Cylindrical boss.

Using the same 
sketch, select 
contours and 
extrude.

Depth = 0.5”.
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5 Fillets.

Add fillets of 
radius 1/8”.

6 Rounds.

Add rounds of 
radius 1/32”.

7 Save and close 

the part.
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Exercise 35:
Oil Pump

Create this part using the information and 
sketch provided. Extrude profiles to create 
the part.

This lab reinforces the following skills:

� Contour selection.
� Extrusions.

Procedure Open an existing part.

1 Open the part named Oil Pump.

It contains a single sketch.

2 Boss feature.

Use Contour Select Tool and 
select the outermost circle. Extrude 
it a depth of 32mm to form the first 
feature.

Extrude the boss into the screen so 
the sketch lies on the front face.

3 Extrude a cut.

Select the figure-8 contour and extrude a 
cut to a depth of 22mm.
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4 Through All cuts.

There are six circles that represent 
through holes.

Tip To select multiple contours, hold down 
Ctrl and then select each contour.

Question Should these holes be created as a single 
feature? Or should they be made as three 
separate features, one for each size hole?

5 Last two cuts.

Extrude the last two contours to a depth 
of 19mm.

6 Hide the sketch.

7 Save and close the part.
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Exercise 36:
Using the 
Contour 
Selection Tool

Create this part using the information and sketch 
provided. Extrude profiles to create the part. 

This lab reinforces the following skills:

� Contour selection tool.
� Extrusions.
� Fillets.

Procedure Open an existing part.

1 Open the part named Idler_Arm_Contour_Selection.

It contains three sketches. Show all sketches.

2 First feature.

Right-click the Contour Select 

Tool and select the indicated 
geometry.

3 Extrude.

Click the Extrude tool and create 
the boss using Mid Plane and a 
Depth 55mm.

4 Bosses and cuts.

Using the same procedure, create the 
remaining bosses and cuts as shown. 

5 Fillets and rounds.

Use fillets and rounds of 3mm.

6 Save and close the part.
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Lesson 9
Configurations of Parts

Upon successful completion of this lesson, you will be able to:

� Use configurations to represent different versions of a part within a 
single SolidWorks file.

� Suppress and unsuppress features.

� Change dimension values by configuration.

� Suppress features by configuration.

� Understand the ramifications of making changes to parts that have 
configurations.
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Configurations Configurations allow you to represent more than one version of the part 
in the same file. For example, by suppressing the machined features 
(holes, chamfers, pockets, etc.) and changing dimension values in the 
parts at the top of the illustration, you can represent the rough forgings 
shown below them.

This lesson addresses the use of configurations in parts. Assembly con-
figurations are covered in another lesson.

Terminology Some of the terms used when discussing and working with 
configurations are explained below.

Configuration Name The Configuration Name appears in the ConfigurationManager. It is 
used to distinguish between configurations within the same part or 
assembly at the part, assembly or drawing level.

They can be created directly or indirectly through a design table.

Suppress/

Unsuppress 

Features

Suppress is used to temporarily remove a feature. When a feature is 
suppressed, the system treats it as if it doesn’t exist. That means other 
features that are dependent on it will be suppressed also. In addition, 
suppressed features are removed from memory, freeing up system 
resources. Suppressed features can be unsuppressed at any time.

Other Configurable 

Items

In addition to features, other items can be suppressed and unsuppressed 
using configurations:

� Equations

� Sketch Constraints

� External Sketch Relations

� Sketch Dimensions

� Colors

Sketch Planes and extrude End Conditions can be set differently on a 
configuration by configuration basis.
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Using 
Configurations

Both parts and assemblies can have configurations. Drawings do not 
have configurations of their own but drawing views can display 
different configurations of the files they reference.

Design Tables use more automated methods in the creation of 
configurations. For more information on design tables, see Design 

Tables on page 303.

Procedure In this lesson you will learn about using configurations within a part 
file. In Lesson 12: Bottom-Up Assembly Modeling, you will explore 
using configurations in conjunction with assemblies.

Begin this example by following this procedure:

1 Open the Ratchet Body.

This part is a copy of the one created in a previous lesson.

Accessing the 
Configuration-
Manager

Configurations are managed from within 
the same window that is occupied by the 
FeatureManager design tree. To switch the display within this window, 
use the tabs located at the very top of the window pane. Clicking the 

 tab will display the ConfigurationManager (shown at the upper 
right) with the default configuration listed. The default configuration is 
named Default. (Who says we don’t have a sense of humor?) This 
configuration represents the part as you modeled it — with nothing 
suppressed or changed. When you want to switch back to the 

FeatureManager display, click the  tab.
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Splitting the 

FeatureManager 

Window

Many times it is efficient to be able 
to access both the FeatureManager 
design tree and the Configuration-
Manager at the same time. This is 
particularly true when working with 
configurations. Rather than switch 
back and forth using the tabs, you 
can split the FeatureManager win-
dow top to bottom, creating two 
panes. One pane can show the 
FeatureManager design tree and the 
other can show the Configuration-
Manager.

To subdivide the FeatureManager 
window into two panes, drag the 
splitter bar downwards from the top 
of the window. Use the tabs to 
control what is displayed in each 
pane.

Adding New 
Configurations

Every part (and assembly) must have at least one configuration, and 
multiple configurations are common. There are several options beyond 
the Configuration name that you can set.

Bill of Materials 

Options

When the part is used in an assembly and further, a bill of materials, set 
the name that should appear under Part Number.

Advanced Options The advanced options include rules for creation of new features and 
color settings. Parent/Child options are for assemblies only.

� Suppress Features

This option controls what happens to newly created features when 
other configurations are active and this configuration is inactive. If 
checked, new features added with other configurations active are 
suppressed in this one.

� Use configuration specific color

Allows for different colors for each configuration using the color 
palette. Different materials may introduce different colors.
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2 Adding a new configuration.

Position the cursor within the ConfigurationManager 
and from the right-mouse menu, choose Add 

Configuration...

When you add a configuration that configuration becomes active. Any 
subsequent changes to the part (such as suppressing features) are stored 
as part of the configuration.

Tip Special characters such as the slash (/) are not allowed in the 
configuration name.

3 Add configuration.

The Add Configuration property manager is used 
to add configurations to the part. Give the 
configuration the name Forged, Long and 
optionally, add a comment.

Click OK.

4 Added to list.

The new configuration is 
added to the list and 
automatically made the active configuration. Notice that the name of 
the active configuration is shown in parentheses, appended to the part 
name icon.

Defining the 
Configuration

You define the configuration by turning off or suppressing selected 
features in the part. When a feature is suppressed, it still appears in the 
FeatureManager design tree but it is grayed out. This version of the part 
is saved or stored in the active configuration. You can create many 
different configurations within a part.You can then easily switch 
between different configurations using the ConfigurationManager.

Introducing: Parent/

Child Relationships

Parent/Child is used to display the dependencies between features. 
Both the features it is dependent upon (Parents) and the features which 
depend upon it (Children) are displayed.

Where to Find It � From the right-mouse button over a feature click Parent/Child.
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Introducing: 

Suppress

Suppress is used to remove a feature from memory, essentially 
deleting it from the model. It is used to remove selected features from 
the model to create different “versions” of that model. All the children 
of a feature that is suppressed are suppressed with it.

Unsuppress and Unsuppress with Dependents are used to reverse 
the effect of suppression on one (unsuppress) or more (unsuppress with 
dependents) features.

Where to Find It � From the right-mouse menu click Suppress.

� Or click the Suppress tool  on the Features toolbar.
� Or choose Edit, Suppress from the pulldown menu.
� Or click Suppressed in the Feature Properties dialog box.

5 Check Parent/Child.

Right-click the Recess feature 
and select Parent/Child. Expand 
the Pocket feature on the 
Children side to see other child 
features.

6 Suppress the Recess feature.

In the FeatureManager design tree, select the 
Recess feature. Right-click Suppress.

The system suppresses not only the Recess but also 
the Pocket, the Wheel Hole, and the Ratchet 
Hole. Why?

Because the Pocket, Wheel Hole, and Ratchet 
Hole are all children of the Recess. If you recall, 
the Pocket was sketched on the bottom face of the 
Recess. The two holes were then sketched on the 
bottom face of the Pocket. This is what established the parent-child 
relationships among them.

Rule Suppressing a feature automatically suppresses its children.

When the features are suppressed in the 
FeatureManager design tree, their 
corresponding geometry is suppressed in 
the model, too.
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Changing 
Configurations

To switch to a different configuration, simply double-click on the one 
that you want.

7 Switch back to the Default configuration.

Position the cursor over the Default configuration 
icon and double-click it.

The system keeps the Recess, Pocket, Wheel 
Hole, and Ratchet Hole features unsuppressed 
making them visible in both the FeatureManager 
design tree and the graphics windows. 

Renaming and 
Copying 
Configurations

We now have two configurations: Default and Forged, Long. 
The Default configuration represents the part in its machined state. 
However, the name Default is not too meaningful.

Configurations can be renamed in the same way as features. However, 
if a configuration is being referenced by another SolidWorks 
document, renaming that configuration can cause some difficulties.

A Better Approach Instead of renaming the default configuration we will make a copy of it 
and then rename the copy.

8 Copy the Default 

configuration.

Select the Default configuration 
and copy it using any of the 
standard techniques for copying a 
feature: Ctrl+C, Edit, Copy, or the 

 tool.

Paste the configuration using 

Ctrl+V, Edit, Paste, or the  tool.

Rename the copy to Machined, Long.

You now have configurations that represent the Ratchet Body in its 
forged and machined states.
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9 Create more configurations.

Using the same procedure, copy and paste the Forged, Long 
configuration. Rename it Forged, Short. Copy and paste the 
Machined, Long configuration, renaming it Machined, Short.

Changing 

Dimension Values

Configurations can also be used to control the value of a dimension. 
Each configuration can be used to change the dimension to a different 
value. The change can be configured for the active, specified, or all 
configurations.

In this example, the “Short” configurations will have a slightly 
shorter handle length.

10 Key dimension.

Double-click 
Machined, Short to 
make it the active 
configuration. Double-
click the Handle 
feature to expose the 
sketch dimensions.

Configure the dimension.

Double-click the 220mm dimension and 
change it to 180mm. In the dropdown, 
choose Specify Configuration(s). Click 
OK.

Select only the Forged, Short and 
Machined, Short configurations 
from the list and click OK.
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Note Features can be suppressed or unsuppressed 
in the active, specified, or all configurations 
using Properties.

Right-click the feature and select Feature, 

Properties. Check or clear Suppressed 
and select the configurations using the 
dropdown list.

11 Changes.

Rebuild the model to see the 
changes in the current 
configuration.

Editing Parts 
that Have 
Configurations

When configurations are added to a part, features may be automatically 
suppressed, dialogs list many additional options, and other strange 
things can happen. This section shows what happens when there are 
multiple configurations in the part being edited.

Every configuration in a part contains the same features. However, in 
different configurations, those features may have different suppression 
states, different dimension values, different end conditions, or even 
different sketch planes.

The table below list options that can be controlled using configurations.

Type Possibilities

Feature Suppress/Unsuppress by configuration

Equations Suppress/Unsuppress by configuration

Sketch Relations Suppress/Unsuppress by configuration

External Sketch 
Relations

Suppress/Unsuppress by configuration

Sketch Dimensions Suppress/Unsuppress by configuration

End Conditions Different end condition for each 
configuration

Sketch Planes Different sketch plane by configuration
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Note Colors, textures and materials can also be configured.

1 Open the part.

Open the part WorkingConfigs. This 
part has one configuration: Default. 
Configurations and new features will be 
added to the part.

2 Creating new configurations.

Switch to the Configuration Manager and right-click Add 

Configuration. Create a new configuration named keyseat.

3 Copy and paste.

Copy and paste keyseat to create another new configuration. Name 
it ports and make it the active configuration.

By default the option Suppress features is selected. This means that 
as new features are added, they are suppressed in all configurations 
except the active one.

4 Active configuration.

Make sure the configuration 
named ports is active. At this 
time, all three configurations are 
the same.

Tip Copy and paste makes a duplicate of the copied configuration. Note 
that the name in square brackets is the name that will appear in a BOM. 
This can be changed by changing the setting for the Part number 

displayed when used in a bill of materials in the Configuration 

Properties dialog.

Design Library The Design Library is a collection of features, parts and assembly files 
within the Task Pane. The files can be inserted into parts and 
assemblies to reuse existing data. The features folder will be used 
in this example.

The Features 
Folder

The features folder contains Library Feature (*.sldlfp) files. 
They can be added to a part by simply dragging and dropping them 
onto a planar face of the model. References needed by the feature are 
selected, attaching dimensions and relations. The references are 
followed by position and size change options to set the values of the 
dimensions in the feature.
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Default Settings The first of three library features will be inserted using the default 
settings for location and size.

5 Folders.

Click the Design Library and the pushpin.

Expand the features folder.

Expand the inch folder.

Click the fluid power ports folder.

6 Drag and drop.

Drag and drop the sae j1926-1 
(circular face) feature onto the planar 
model face as shown. The drop face is the 
Placement Plane for the feature.
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7 Settings and 

selections.

Select the configuration 
516-24 from the list. 
Select the Edge1 
(circular edge) reference 
as indicated in the 
preview window. 

The Link to library part 
option will create a link 
to update this part from 
changes in the library 
feature.

Checking Override 

dimension values 
allows the internal 
dimension values of the 
feature to be changed.

8 Feature.

The library feature is added to 
the FeatureManager as a library 
feature consisting of sketches, a 
plane and a cut. 

Note The “L” labels superimposed over the feature icons indicate a library 
feature.

Multiple 
References

Many features contain multiple references to faces, edges or planes. 
These are used to attach dimensions and set relations on geometry.

If the references are not properly attached to model geometry, they will 
become dangling. For more information, see Reattach Dimensions on 
page 230.
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9 References.

Drag and drop the sae j1926-1 
(rectangular face) feature onto 
the planar face. This feature requires the 
selection of two references, each being a 
linear model edge.

Select the 716-20 configuration. For 
the two References, select the shown in 
green edge followed by the red.

10 Dimension values.

Set each Locating Dimension 
to 0.5” by clicking the cell and 
typing.

Click OK.

11 Check configurations.

The new features are unsuppressed in the active configuration 
(ports) but suppressed in all the others.

12 Active configuration.

Make the configuration keyseat the active one.

Dropping on 
Circular Faces

Some features attach to circular faces of the target model and require 
the first “drop” face to be that face. In these cases, the Placement Plane 
is selected after the drop.
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13 Feature.

Open the keyways 
folder in the design 
library. Drag and drop 
the rectangular 
keyseat feature 
onto the circular face 
of the shaft.

Select ∅ 0.6875 
W=0.1875 
configuration and the 
planar end face as the 
Placement Plane. 

14 Reference.

Select the circular edge of the end 
face as the Reference.

15 Locating dimensions.

Set the Locating 

Dimensions to the 
values shown.
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16 Check configurations.

The new feature is unsuppressed in the active configuration 
(keyseat) but suppressed in all the others.

17 Save and close the file.
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Exercise 37:
Configurations

Use an existing part as the basis for a series 
of configurations. Create different versions 
by suppressing various features in each 
configuration.

This lab reinforces the following skills:

� Creating configurations.
� Suppressing features.

What is this Thing? The part used in this example is the 
main twin barrel component from a 
toy that shoots soft, foam rockets.

Procedure Open the existing part config part.

1 Create new configurations.

Manually create new configurations to match the conditions and names 
below. Add features to the model where required.

� Best model – Includes ammo 
holder and sight.

� Better model – Includes sight 
only.

Ammo holder
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� Standard model – Includes 
neither ammo holder nor sight.

� Section model – Shows a sec-
tion cut through the Standard 
model.

Note The Section configuration is created using a cut feature. To create 
the cut feature activate the Standard configuration. Then use the 
Front reference plane and the command Insert, Cut, With Surface..., 
cut the model.

2 Save and close the part.
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Exercise 38:
More 
Configurations

Use an existing part and create configurations. Create 
new features which are controlled by the configurations.

This lab reinforces the following skills:

� Adding configurations.
� Suppressing features.

Configurations allow the shape of the part to differ 
based on which features are displayed.

Procedure Open the existing part Speaker.

1 Create new configurations.

Using the names below, create four new configurations in the part. 
They represent two variations of the speaker and its function.
(C = Control, S = Slave and F = Front).

� 100CF
� 100SF
� 200CF
� 200SF

2 Configuration settings for volume control.

Add the feature volume control. Suppress and/or unsuppress the 
feature to get the shape shown here for the configurations listed above.

3 Configuration settings for rounded tweeter.

Add the feature rounded tweeter. Suppress the feature in both 
200 series configurations.

4 Configuration 200CF.

Switch to the configuration 200CF in the ConfigurationManager. 

100 Series 200 Series

100CF 100SF 200CF 200SF
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5 New cut.

Right-click the sketch 
opening locations, and 
select Show.

Add a new cut using the 
geometry shown. Set the 
dimension values for All 

Configurations.

Rename the feature 
tweeter.

Set the state to suppressed for the 100 
series and unsuppressed for the 200 
series configurations.

6 Save and close the part.Pre-
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Exercise 39:
Working with 
Configurations

Using an existing part with 
configurations, add new features and 
modify others.

This lab reinforces the following skills:

� Suppressing a feature using 
feature’s properties.

� Editing extrusion end conditions by 
configuration.

� Adding new features in a multi-
configuration environment.

Procedure Open the existing part Working with Configurations.

1 Configurations.

The part contains seven (7) configurations. They are:

� Default
� doublewall
� doublewall.simple
� singlewall
� singlewall.simple
� stepped
� stepped.simple

To begin with, they are all the same – copies of the Default 
configuration.

2 Select fillet and chamfer features.

Modify the three simplified configurations to suppress all fillets and 
chamfers within them. Press Shift and select the features 
fill060.vert, fill060.tb, and cham025.

3 Feature Properties.

Click Edit, Properties. Click Suppressed, 
Specify Configuration(s) and click OK.
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4 Configuration selection.

Select doublewall.simple, 
singlewall.simple and 
stepped.simple from the list. 
Deselect all others and click OK.

5 Changes.

The three features are 
suppressed in only the 
selected (simplified) 
configurations.

6 Active configuration.

Make singlewall the 
active configuration.

7 Modify end conditions.

Edit the definition of the 
center hole feature.

Set the Configurations to 
Specify Configurations and 
choose: 

� singlewall
� singlewall.simple
� stepped
� stepped.simple

Choose Up To Next as the end 
condition and click OK.
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8 Add a new feature.

Set the active configuration to stepped. 

Create a new sketch on the front face of the 
model and create a circle concentric to 
center hole. Add a dimension of 0.75” 
for All Configurations.

9 Cut.

Create a cut feature using the Up To Next 
end condition. The feature is added to all 
configurations, suppressed in all but the 
active one.

Name the feature step cut.

10 Feature Properties.

Right-click the new feature and select 
Feature Properties.... Make sure the 
Suppressed check box is cleared.

Select Specify Configuration(s) and click 
OK. Select the configurations stepped and 
stepped.simple and click OK.

Tip The configurations can also be differentiated by color. Use the 
Configurations group box on the Edit Color dialog.

11 Save and close the part.
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Lesson 10
Design Tables and Equations

Upon successful completion of this lesson, you will be able to:

� Link dimension values together to capture design intent.

� Create Equations.

� Automatically create design tables.

� Use existing design tables to create families of parts.

� Make detail drawings using more advanced types of drawing views.
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Design Tables Design Tables are the best way to 
create configurations of parts. They 
are used to control dimension values 
for families of parts, and 
suppression states of features. 
Design tables can be used to create a 
family of parts from a single part 
design. Since the SolidWorks 
software is an OLE/2 application, an 
Excel spreadsheet is used to lay out 
the design table so it can be imported into the SolidWorks document.

Key Topics The key topics covered in this lesson are shown in the following list.

� Link Values

Link values are used to set two or more dimensions equal.

� Equations

Equations can be used to create algebraic relationships between 
dimensions using mathematical operators and functions.

� Auto-create a Design Table

Design tables can be automatically created and edited after they are 
inserted. Design tables can be set so that you cannot change the model 
if those changes would update the design table.

� Making changes

Changes can be made to the existing design table by editing the table to 
add configurations, dimensions or features.

� Bi-directional Changes

Dimensions that appear in the design table are driven by it. Changes 
made to the dimensions in the model force the corresponding change in 
the design table.

� Inserting Blank Design Tables

Blank design tables are useful for many purposes including exploded 
views and multiple positions of a component in an assembly.

� Drawings with Configurations

Drawings with parts that have configurations provide many options for 
display. Any available configuration can be displayed in a model view.
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1 Open Socket.

The Socket part 
(shown here with 
Show Feature 

Dimensions and 
Show Dimensions 

Names on) contains 
two cut features that 
represent the 
overlapping hexagon 
cuts. They retain 
their original names.

2 Change value.

Double-click the sketch of the 6 Point feature and 
double-click the 0.5” dimension. Add 1/32” to the 
nominal value as shown. Rebuild the model.

Link Values Link Values can be used to set a series of dimensions equal by 
assigning them the same name. Changing the value of any of the linked 
dimensions changes all of them. The linking can be removed using 
Unlink Value. This option is superior to equations for setting several 
values equal to each other.

In this example there are two linear dimensions: one in each of the 
hexagon shaped cuts. Link values will be used to tie them together.

Where to Find It � From the Dimension Modify dialog, choose Link Value.
� Right-click one or more dimensions and select Link Values.

Note The dimensions being linked together must be of the same type. Link 
angular dimensions to other angular dimensions and so forth.

3 Access link values.

Double-click the same dimension as if to change the 
value. Using the dropdown menu, select Link Value.

4 Name the link 

value.

In the Shared 

Values dialog, 
type the name 
AcrossFlats 
and click OK.
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5 Link Value added.

The link value is added and is used as the 
dimension name. A prefix symbol is also 
added to identify this dimension as being 
linked.

Rebuild the model.

6 Equation folder.

The link value is listed under the Equations 
folder in the FeatureManager.

7 Add link value.

Double-click the sketch of the 12 Point feature and double-click the 
0.5” dimension. Select the link value AcrossFlats from the 
dropdown. The value of the existing link value is assigned to this 
dimension. Rebuild the model.

Note A link value will remain attached to a dimension unless it is removed 
using right-click Unlink Value. Changing the value of any linked 
dimension changes all linked dimensions.

Equations Many times you will need to establish a relationship between 
parameters that cannot be achieved using geometric relations or 
modeling techniques.

For example, you can use equations to establish mathematical relations 
between dimensions in the model. This is what we will do next.

This equation will establish a relationship between the diameter of the 
cylinder and the distance across the flats of the hex. As the distance 
across the flats increases, so will the diameter.

Note Simple equality statements within a part can be created more easily 
with Link Values than equations.
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Preparation for 
Equations

Although you can begin writing equations and applying them to the 
model with little or no preparation, it is a much better practice to make 
a small investment in time up front to achieve added benefit later on. 
You should consider the following:

� Renaming the dimensions

Dimensions are created by the system with somewhat cryptic default 
names. To make it easier for others to interpret the equations and 
understand what exactly is being controlled by them, you should 
rename the dimensions giving them more logical and easily understood 
names. Right-click a dimension and choose Properties to rename it.

Note When equations are used in an assembly, the full name uses the form: 
Name@FeatureName@PartName.

� Dependent versus independent

The SolidWorks software uses equations of the form Dependent = 

Independent. This means that in the equation A = B, the system solves 
for A when given B. You can edit B directly and change it. Once the 
equation is written and applied, you cannot directly change A. Before 
you start writing equations, you need to decide which parameter will 
drive the equation (the independent one) and which will be driven by 
the equation (the dependent one).

� Which dimension drives the design?

In this example, we will control the diameter of the cylinder based on 
the distance across the flats of the hex. This means the flat distance is 
the driving or independent parameter and the diameter is the driven or 
dependent one. The size of the hex drives the design. 

Functions The functions displayed as buttons on the Add Equation dialog box 
include basic operators, trig functions and many more.

Equation form The equation required in this example uses the distance across the flats 
of the hex as the driving dimension. This forces changes in the cylinder 
diameter, a feature that precedes it. The form is:

Driven Dimension = Driving Dimension + Constant

where:

Driven Dimension = CylinderDiameter@Sketch1

Driving Dimension = AcrossFlats@Sketch2

Constant = 0.25

Introducing: 

Equations

The Equations dialog can be used to add, edit, delete and configure 
equations. 
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Where to Find It � Click Equations  on the Tools toolbar.
� Or from the Tools menu, click Equations.
� Or right-click the Equations folder and choose an option.
� Or from the Dimension Modify dialog, choose Add Equation.

8 Add Equation.

Double-click the Cylinder feature 
and the diameter dimension (1”). In the 
dialog, choose Add Equation from the 
dropdown list.

9 Dimension added.

The dimension is added to 
the new equation on the 
left side of the equals sign.

10 Complete equation.

Click either of the link 
value dimensions and add 
“+ 0.25” to complete the 
equation.

Click OK to add the 
equation.
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11 List.

The current list of 
equations, including link 
values , is listed in the 
Equations dialog. Click 
OK and rebuild the model.

The Evaluates To column 
refers to the value of the 
CylinderDiameter@Sk
etch1 dimension. Changes 
to the 
AcrossFlats@Sketch2 
dimension force the 
evaluation to change. 

Tip If your equations make use of angular dimensions, select Radians or 
Degrees as the Angular Equation Units.

Note The driven dimension, 
CylinderDiameter@Sketch1 in this case, 
cannot be changed directly. Double-clicking it leads 
to a grayed out Modify dialog.

Global Variables Global Variables (or independent variables) can be added and used 
within equations to represent yield strength, poissons ratio or other 
constants. They can be used within equations.
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A Few Final Words 
About Equations

Equations are solved in 
the order in which they are 
listed. If you change a 
dimension and discover 
that it takes two rebuilds 
to update all of the part’s 
geometry, this may 
indicate that your 
equations are in the wrong 
order. Edit the equations 
and use the list to reorder 
them. Consider this example:

Given three equations: A=B, C=D, and D=B/2, consider what happens 
if you change the value of B. First, the system will compute a new 
value for A. When it evaluates the second equation, nothing is changed. 
When the third equation is evaluated, the changed value of B yields a 
new value for D. However, it isn’t until the second rebuild that this new 
value for D gets used to compute a new value for C. Reordering the 
equations thus: A=B, D=B/2, and C=D solves the problem.

Design Tables Design Tables are the best way to create configurations of parts. They 
are used to control dimension values for families of parts and 
suppression states of features. 

Auto-create a 
Design Table

The easiest way to create a Design Table in a part is to Auto-create it 
using existing configurations, dimensions and features. The existing 
information is automatically formatted into an Excel spreadsheet and 
updates automatically, by default bi-directionally.

Introducing: Insert 

Design Table

When you insert a design table, the SolidWorks window switches to 
Excel. That is, the toolbars become Excel toolbars instead of 
SolidWorks toolbars while the table is active.

There can only be one design table in each part. It is stored within the 
part document unless a linked design table is used.

Where to Find It � Click Insert, Design Table....

� Or, click Design Table  on the Tools toolbar.

FeatureManager 

Design Tree

When a design table is added to a part or assembly, this symbol 

 appears in the FeatureManager design tree.
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12 Insert a new design table.

Click Insert, Design Table.... For the Source select 
Auto-create to automate the creation of the design 
table.

� Source determines where information comes 
from. Blank creates a new, blank, design table. 
Dimensions and features can be added to the 
design table by double-clicking them. Auto-

create generates a design table from existing 
configurations, dimensions and features. From 

file imports an existing Microsoft Excel 
spreadsheet to use as the design table. Click 
Browse to locate the table. You can also select 
the Link to file check box, which links the 
spreadsheet to the model.

� Edit Control controls the ability to make bi-
directional changes. Selecting Allow model 

edits to update the design table means that 
changes can be made outside the table and it will 
still be updated.

� Options determines how new information in treated by the design 
table. If it is set to bi-directional, new features, configurations and 
dimensions changes force updates in the design table.

Tip Dimensions that are driven by the design table appear in a different 
color scheme. You can change the color of dimensions that are 
controlled by the design table to make them easier to identify.

Click Tools, Options, System Options, Colors.

Select the option Dimensions, Controlled by Design Table and edit 
the color.
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13 Dimensions to add.

The Auto-create option generates a list of 
the dimensions in the part that can be 
added to the design table. 

Press Ctrl and select these four 
dimensions:

CylinderDepth@Cylinder

AcrossFlats@Sketch2

HexDepth@6 Point

DriveSquare@Sketch4

Tip The dimensions that will be used in the table should be renamed to 
more meaningful names than their default ones.

14 Design table.

The selected dimensions are added to 
the design table with their associated 
values. Note that the long dimension 
names are automatically rotated 
vertical.

Excel Formatting The cells in the spreadsheet appear with the standard formatting but 
they can be changed at any time. Take advantage of the power of Excel 
to make the design table easier to read and use. You can:

� Change cell colors and borders
� Change text color, orientation and font
� Define functions between cells

All of these changes can make the design table more useful or just more 
readable.
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Anatomy of a 
Design Table

The design table contains rows and columns of information that are set 
into predefined cells of the Excel spreadsheet.

Properties Used in 

the Design Table

The Properties that live in Row 2 of the design table can be used to set 
a dimension value, suppress or unsuppress a feature or add a comment. 
The chart below summarizes the available properties and valid cell 
values.

Title

Properties

Configuration Cell Values

Property Header Example Cell Value Description

Dimension D3@Sketch2 Number The value should be 
appropriate for the 
dimension.

Tolerance $TOLERANCE@D1@
Sketch1

Tolerance type (text); 
Maximum Variation 
(number); Minimum 
Variation (number)

The format sets the type 
and values separated by 
semi-colons (;) for a single 
dimension.

State $STATE@Fillet5 S, U, Suppressed, 
Unsuppressed, or blank.
Blank = Unsuppressed

Sets the state of a feature to 
be suppressed or 
unsuppressed.

Color $COLOR 32-bit integer number. Color value is derived from 
palette color or material.

Parent $PARENT Text Parent configuration name.

Comment $COMMENT Text Alpha-numeric.

User Notes* $USER_NOTES Text Alpha-numeric.
* Can be used as a column 
or row header.

Property $prp@prop_name Text A custom property name 
prop_name created in the 
table or through File, 

Properties.
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Adding New 
Headers

New property headers, feature or dimension based, can be added to the 
table by double-clicking. For a feature, double-click it in the 
FeatureManager or on the screen. The result is a $STATE property (see 
Properties Used in the Design Table on page 312). For a dimension, 
double-click it in the graphics area.

Note The next available cell in row 2 must be selected before double-
clicking.

15 Add feature.

Double-click the 12 
Point feature on the 
FeatureManager. It is added 
to the design table with the 
prefix $STATE@. The 
current state, 
UNSUPPRESSED, is also 
added.

Change the value UNSUPPRESSED to the abbreviation U.

Note The UNSUPPRESSED cells can be abbreviated as U. SUPPRESSED 
cells can be abbreviated as S. A lowercase u or s would be converted to 
uppercase.

Adding 
Configurations to 
the Table

Once the design table has been established, configurations and 
associated cell values can be added by typing. In this example, a new 
configuration name will be created and copied to generate more.

16 Add a new configuration.

Replace in the Default 
configuration name with 0.5 
Short 12 in the cell A3. Close the 
table.

17 Delete configuration.

Exit the design table confirming the creation of a 
new configuration.

In the Configuration Manager, make the new configuration active and 
delete Default.
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18 Add more configurations.

Right-click the Design Table 

feature  and select 

Edit Table. Add more 
configurations quickly by 
selecting cells A3-F3 and 
dragging the lower right corner 
of the selection box down to row 
5. Modify some of the cells as 
shown.

19 Configurations added.

Close the design table to add the new configurations. A message 
appears indicating the names of new configurations that have been 
added.

Tip If configurations are missing from the list, there is a problem in the 
design table. Often the problem is an inappropriate cell value. If so, a 
message will appear, stating that a value is invalid.

20 Resulting configurations.

Switch to the Configuration Manager and double-click each 
configuration to make it active.

Only one configuration can be active at any time.

21 Add configurations and 

comments.

Using copy and paste with 
editing, create as many 
additional configurations, and 
formatting as time permits.

0.5 Short 12 0.625 Short 12 0.75 Short 12
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22 Configurations created.

If all configurations are created, 
there are 6 configurations. For each 
size there is a 6 and 12 point version.

Existing Design 
Tables

Another way to add a design table is to create the table in Excel and 
insert it into the part. Here are some tips when using this method:

� Rename dimensions

As previously mentioned, the default dimension names are generally 
non-descriptive. Rename them by editing the Properties of the 
dimension and modifying the Name field.

� Copy dimension and feature names

The design table is very fussy about the spelling and case of dimension 
and feature names. Use copy and paste to extract the Full name of the 
dimension from the Properties dialog and add it to the cell. For 
features, also use the Properties dialog.

� Fill in all cells

All the cells within the rows and columns that you create must have the 
appropriate type of data in them.

1 Open the part named Part_DT. 

The part, Part_DT, will be used to demonstrate the power of existing 
design tables.

The part has both revolved and extruded features. Note that multiple 
features are used where one revolved could be used. This allows the 
individual features to be suppressed.

2 Key dimensions.

Using properties, some 
key dimensions have 
been changed from 
their default names to 
something more 
descriptive. Only those 
that appear in the 
design table need to be 
changed.
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If the default names are used, comments can be added to the design 
table to describe the dimension further.

Tip When it comes time to copy the dimension names into the spreadsheet, 
it will be easier to select the names if they do not have embedded 
spaces.

Inserting the 
Design Table

After creating the design table, it has to be inserted into the appropriate 
SolidWorks part. To do this, use the following procedure:

3 Insert the design table into the part.

Click Design Table  or click Insert, Design 

Table.... For the Source select From file.

Select Link to file to tie the external file to the part. 
Click Browse..., and select the Excel file 
Part_DT.xls and click OK.

Note If Link to file is not used, the spreadsheet will be copied into the part 
document and stored there. 

4 Design table on screen.

The design table spreadsheet is linked into the part. Clicking outside 
the spreadsheet in the graphics window will close it.

In this example the existing design table has the same name as the part, 
Part_DT.

5 Successful configurations.

A successful process will include a dialog that lists the configurations 
that were created.

Click OK.
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6 Access the ConfigurationManager.

Access the ConfigurationManager and 
Show Configuration... for each of the 
new configurations.

Note that the configurations are not listed 
in the order they were in the spreadsheet. 
They are listed alpha-numerically. Also 
note that the Default configuration has 
a different icon than the rest.

7 Deleting a configuration.

To delete a configuration, Default in this case, it must not be active. 
Click on the name and press the Delete key. Click Yes on the dialog to 
confirm deleting the configuration.

8 Save.

When the part is saved a message appears indicating that the design 
table is also being saved.

9 Configurations established.

Six configurations are established for the part. Each one is shown 
below. The cutaway configuration is the only one that does not sup-
press the cutaway feature.

Inserting Blank 
Design Tables

The Blank option is useful when configurations are needed for 
purposes other than feature suppression or setting of dimension values. 
Some examples would be:

� Only Comments (row or column) are required in the table.
� Multiple exploded views of an assembly.
� Multiple positions of a component in an assembly.
� Features and dimensions are to be added manually.

cutaway w7-225 w7-25 w8-3

assy drawing
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Tip In general, if dimensions and features are to be controlled in the table, 
the Auto-create option is a better choice. The configurations can also 
be created outside a table, see Defining the Configuration on page 282.

Saving a Design 

Table

When you auto-create or insert a blank design table, the only place the 
table exists is embedded within the SolidWorks part. There may well be 
cases when you want to save the embedded table as an Excel 
spreadsheet.

Introducing: 

Save Table

Save Table allows you to save an embedded design table as an Excel 
spreadsheet.

Where to Find It � Right-click the design table , and select Save Table....

Other Uses of 
Configurations

Part configurations have numerous applications and uses. Some of the 
reasons for creating different configurations include:

� Application-specific requirements.
� Different product specifications such as a military and civilian 

version of a part.
� Performance considerations.
� Assembly considerations.

Application-specific 

Requirements

Many times the finished 
part model contains fine 
detail such as fillets and 
rounds. When preparing 
a part such as the one 
shown at the right for 
finite element analysis 
(FEA), it is desirable to 
simplify the part. By suppressing the unnecessary detail features you 
can create a configuration specifically for FEA.

Another application that might require a specialized model 
representation would be rapid prototyping.

Performance 

Considerations

Parts with complex geometry such as swept and lofted features, 
variable radius fillets, and multi-thickness shells have a tendency to tax 
system resources. You might want to consider defining a configuration 
that suppresses some of these features. This will allow you to improve 
system performance when working on other, unrelated areas of the 
model. When you do this, however, be sure to take into account parent/
child relations. You cannot access, use, or reference suppressed features 
– therefore they can’t serve as parents.

Assembly 

Considerations

When working on complex assemblies that contain large numbers of 
parts, using simplified representations of those parts can improve 
system performance. Consider suppressing unnecessary detail such as 
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fillets, leaving only critical geometry that is needed for mating, 
interference checking, and defining fit and function. When you add a 
component to an assembly, the Insert, Component, From File... 
browser allows you to choose the configuration of the part to be shown. 
To take best advantage of this, you have to plan ahead, defining and 
saving the configuration when the component is built.

Similar parts that have the same 
basic shape can be defined as 
different configurations and used 
in the same assembly. The part 
shown at the right has two 
configurations. For an example 
showing how to use two 
different configurations of a part 
within an assembly see Using 

Part Configurations in 

Assemblies on page 396.

Modeling 
Strategies for 
Configurations

When you model a part that will be used with configurations – whether 
or not it is driven by a design table – you should give some thought to 
what you want the configurations to control. Consider, for example, the 
part used in the previous procedure.

One way a part like this can be modeled is to make a single sketch of 
the profile and build the part as a single revolved feature.

Although that approach seems efficient, having all the information 
contained in a single, monolithic feature really limits your flexibility. 
By breaking the part down into smaller, individual features, you gain 
the flexibility of being able to suppress features such as fillets or cuts.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 10 SolidWorks 2006 Training Manual
Design Tables and Equations

320 More About Making Drawings

More About 
Making 
Drawings

Drawings were first introduced in Lesson 3. In this section we will 
explore some additional detailing topics. These topics include: Named 

Views, Section Views, Detail Views and Ordinate Dimensions.

1 Open the drawing named Part_DT.

Drawing 
Properties

The drawing properties control many characteristics of each drawing 
sheet. Settings can be different for each drawing sheet.

Introducing: 

Drawing Properties

View scale, paper size, sheet format and type of projection are all set or 
changed through the Sheet Setup dialog.

Where to Find It � With the cursor over the drawing, right-click and select 
Properties....

� Or, right-click the sheet icon  in the FeatureManager, 
and select Properties....

2 Sheet setup.

Right-click the 
sheet, and select 
Properties.... 
Set the Standard 

sheet size to
B-Landscape, 
Scale to 1:2 and 
clear Display 

sheet format. 
Click OK.
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3 View scale.

Changes to the sheet view scale affect all views which do not use a 
custom scale.

4 Change configuration.

Click in the drawing view 
and choose More 

Properties... from the 
Model View 
PropertyManager.

Click Use named 

configuration and select 
the configuration w7-
225.

5 Tangent edges.

Right-click in the drawing view and select Tangent 

Edge, Tangent Edges Removed.
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Simple Section 
View

You can create several types of section views. The simple section view 
uses a single line to form the cutting plane.

Introducing: 

Section View 

Section View creates a full or partial section view based on a cutting 
line and a direction. A single sketch line is used for the section line.

The fastest way to create the section is to click the tool first. This 
switches on the line tool for sketching the section line. When the line is 
completed, a preview of the section view appears.

Where to Find It � From the menu click Insert, Drawing View, Section.

� Or, on the Drawing toolbar click the Section View  tool.

6 Click the Section View tool.

Click Section View . In the Top view, 
sketch a vertical line through the center of the 
part. Use the cursor feedback to align the line 
with the axis that runs through the center of the 
part. The line should extend well beyond the 
extents of the part.

7 Place the section view.

Move the cursor to the left of the view and 
place the section view by clicking the left 
mouse button.

The drawing view Section A-A is 
aligned to the source view and comes with 
a label beneath it. The cross hatching is 
automatic and reflects the type specified in 
the part document under Tools, Options, System Options, 

Drawings, Area Hatch/Fill.

Detail Views Detail Views can be created using a closed sketched shape in an 
activated source view. The detail can use a scale multiplier to scale it n 
times larger than its source, default 2x. The contents of the detail view 
is determined by what is enclosed within the sketch. The sketch must 
be a closed contour but can be constructed of any sketch geometry 
types.

Introducing: 

Detail View 

Detail View creates a new view of an area enclosed by a set of closed 
sketch geometry.
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The fastest way to create the detail is to click the tool first. This 
switches on the circle tool for sketching the detail circle. When the 
circle is completed, the detail appears.

Where to Find It � From the menu click Insert, Drawing View, Detail.

� Or, on the Drawing toolbar click the  tool.

8 Sketch the detail circle.

Click the Detail tool. In the Section 
view, sketch a circle as shown.

Use the cursor feedback to place the 
center of the circle on an endpoint of an 
edge. Drag the circle diameter to enclose 
the lower portion of the part.

9 Place the detail.

Position the view on the drawing by clicking 
the left mouse button. Set the detail view 
state to Hidden Lines Removed.

10 Insert Model Items.

Model items can be added to all views, selected 
views or selected features within a view.

Select the section view, then click Insert, Model 

Items.... 

Select Marked for drawing, Import from: 

Entire model and Destination view(s) 

(selected view).

Click OK.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 10 SolidWorks 2006 Training Manual
Design Tables and Equations

324 More About Making Drawings

11 Dimensions in section view.

All the applicable dimensions are 
added to the section view.

12 Deleting dimensions.

Dimensions deleted at the 
drawing level are not deleted 
from the model. 

Delete the dimensions for the 
depth of the part.

Annotations Many annotation symbols can be added to a drawing. They include:

� Datum Features

� Geometric Tolerance Symbols

� Notes

� Surface Finishes

� Weld Symbols

� Hole Callouts

� Balloons

� Cosmetic Threads

Introducing: Datum 

Feature Symbol

The Datum Feature Symbol can be attached to model edges in the 
drawing views.

Where to Find It � On the Annotations toolbar, click Datum Feature .
� Or, click Insert, Annotations, Datum Feature Symbol....
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13 Add a Datum Feature Symbol.

Insert a Datum Feature with the Label A. Select the 
leftmost vertical model edge in the section view.

Click OK.

Ordinate 
Dimensions

In Lesson 3 you saw that you can manually add dimensions in the 
drawing document. These are reference dimensions, and are driven. 
That means you cannot edit the value of reference dimensions to 
change the model. However, changing a dimension in the model 
updates the driven dimension in the drawing.

SolidWorks supports several kinds of dimensions including Ordinate 

Dimensions. Ordinate dimensions are a set of dimensions measured 
from a zero ordinate in a drawing or sketch. They are measured from 
the axis you select first. The type of ordinate dimension (horizontal, 
vertical, or angular) is defined by the orientation of the points you 
select.

Ordinate dimensions are automatically grouped to maintain alignment. 
When you drag any member of the group, all the members move 
together. To disconnect a dimension from the alignment group, right-
click the dimension, and select Break Alignment.

If adjacent dimensions are very close together, the leaders are 
automatically jogged as needed to prevent overlapping text. Drag 
handles are displayed at the bends when you select an ordinate 
dimension with a bent leader. You can remove the bend, or add a bend 
to a different ordinate dimension.

Where to Find It � Click Horizontal Ordinate Dimension  on the Dimensions/
Relations toolbar.

� Click Tools, Dimensions, and Horizontal Ordinate.
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14 Add ordinate dimensions to the detail view.

Click Horizontal Ordinate Dimension  on the 
Dimensions/Relations toolbar.

Select the leftmost edge of the part.

Click to position the 0 dimension.

Click the remaining edges you want to dimension. As you 
do so, each new ordinate dimension will automatically be 
placed on the drawing.

Parametric Notes Using notes you can add text to a drawing. A note can be free floating 
or placed with a leader pointing to a face, edge, or vertex in the 
drawing. The note can contain simple text, symbols, parametric text, 
and hyperlinks. The leader can be straight or bent.

A parametric note is one that is linked to the value of a document 
property, a custom property, or a configuration specific property. If the 
value of the property changes, the note text changes automatically.

Where to Find It � Click Note  on the Annotations toolbar.
� Click Insert, Annotations, Note....

15 Select the drawing view.

The note should be associated with the drawing view. To accomplish 
this, double-click the model view before you create the note.

16 Insert Note.

Click Note  on the Annotations toolbar. In 
the PropertyManager, under Leader, click No 

Leader  to create the text without a leader.

Click below the section line and type:
Model # 

Be sure to type a space after the # character.

17 Link to property.

Click Link to Property 

 on the Note 
PropertyManager.

Click Model in view to 

which the annotation is 

attached.

Select SW-Configuration 

Name from the list and click OK.
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18 Font.

Select the font to be 11 point and Center. Click OK.

19 Text of property.

The note shows the value of the property, the 
current configuration name, immediately.

This is a WYSIWYG display of the completed 
note.

20 Change the configuration.

Right-click Drawing View1 and choose Properties.... In the Model 

View PropertyManager, click More Properties.... Under 
Configuration information, click Use named configuration and 
select w8-3 from the list. All three views update to reflect the newly 
selected configuration. The dimensions also update to reflect the 
change in the model’s size. The text of the note also updates, showing 
the current configuration name. 

Introducing: Model 

View

Model Views are views which take their orientation and name from the 
View Orientation dialog in parts and assemblies. All standard views, 
user-defined views and the current view are eligible for use as a named 
view on a drawing sheet.

If the view selected in the model is a perspective view, that information 
is also carried into the drawing view

Where to Find It � Click Model View  on the Drawing toolbar.
� Or, click Insert, Drawing View, Model....
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21 Add a Model View.

Click Model View  on the Drawing toolbar.

To identify which model should appear in the view, click inside the 
Top view (Drawing View1).

Select *Isometric from the View Orientation and place the view on 
the drawing. Select cutaway as the configuration used in the view. 

Area Hatch When we created the section view, the software added the crosshatch 
automatically. You can also manually apply a crosshatch pattern to a 
solid face.

Where to Find It � Click Area Hatch/Fill  on the Drawing toolbar.
� Or, click Insert, Annotations, Area Hatch/Fill.

Note This is one of the few commands in SolidWorks that requires you to 
preselect the geometry. You must first select the face. Otherwise the 
command remains unavailable.
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22 Area Hatch.

Select the two cut faces of the model in the isometric view.

Click Area Hatch/Fill .

The Area Hatch/Fill dialog box appears. This allows you to change the 
style of the hatch pattern. 

Click OK.

23 Edit the hatch pattern.

Click the leftmost section of area hatch. Change the Angle to 90° and 
click OK.

This gives a more pleasing appearance to the hatch pattern.

Design Tables in a 
Drawing

The design table of a part 
can be shown on a 
drawing sheet. After 
selecting a view of the 
part, click Insert, 

Tables, Design Table... 
and place it on the 
drawing. Double-
clicking the table opens 
the referenced part and the design table within it.
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24 Insert the design table.

Click inside one of the drawing views. Since a drawing can contain 
views of several different models, you have to identify from which part 
the design table will be inserted.

Click Design Table  or click Insert, Tables, Design Table....

The design table appears in the upper left corner of the drawing. Drag it 
to where you want it on the drawing.

For more information about making drawings in SolidWorks, you 

should attend the SolidWorks Essentials: Drawings course.

In the Advanced 
Course...

In the advanced course Advanced Assembly Modeling, the concept of 
Configurations is carried into assemblies.

Assemblies can have configurations that are created manually or 
through a design table. While part configurations focus on features, 
assembly configurations focus on components, mates, or assembly fea-
tures. Assembly configurations can be used to control:

� Assembly Features
� Components
� Mates and Mate Dimensions

Design tables can also be used. At the assembly level there are more 
options available to control one or more component instances.
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Exercise 40:
Using Link 
Values

Create link values in an existing part and test it.

This lab reinforces the following skills:

� Creating link values.

Procedure Open the existing part named Link Values. Create a link value that 
makes all the fillets feature values equal.

1 Create link value.

Create and apply a link value named 
All_fillets&rounds to the dimension of 
the Rounds feature.

2 Apply link value.

Apply the link value to the remaining three 
fillet features:

Fillets.1

Fillets.2

Fillets.3

3 Test.

Test the links by changing any one of the four 
to 0.125” and rebuilding.

4 Save and close the part.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

332 Exercise 41

Exercise 41:
Using 
Equations

Create an equation using an existing 
part and test it.

This lab reinforces the following 
skills:

� Creating equations.

Procedure Open the existing part named Using Equations. The dimensions A, 
B and C shown above will be used to define the equation.

1 Write equation.

Write an equation that keeps the bolt 
circle diameter (A) centered between 
the outside edges of the hub (B) and 
flange (C). The (A) value should be 
driven.

2 Test equation.

Test the equation be changing 
the flange diameter to 12” and 
rebuilding the model. Test other 
values if you wish.

3 Save and close the part.

Tip If you are having trouble, the equation format should be:
A=(C-B)/2+B.

A

B

C
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Exercise 42:
Part Design 
Tables

Use an existing part as the basis 
for a design table. Use the 
dimensions and add them into a 
new design table.

This lab reinforces the following 
skills:

� Inserting design tables.
� Editing design tables.
� Adding properties.
� Using configurations.

Procedure Open the existing part Part Design Table. 

1 Design table.

Create a design table using Auto-create and edit it as shown.

2 Add dimensions.

CTRL-select all the dimensions, with the 
exception of D1@Main, in the 
Dimensions dialog.

Add them to the design table. The 
current values are added automatically.

3 Add feature.

Double-click the Holes feature to 
add it to the design table. The 
current state is added 
automatically.

4 Add configuration.

Type in the configuration name 
Size1 as shown. Copy the cells 
as shown.
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Copy the row, including the 
configuration, to add additional 
configurations.

5 Edit cells.

Edit the cells for the 
Size2 to Size5 
configurations. The 
changes are shown in 
bold red text.

6 Close the design table.

Click outside the design table to 
close it. It should create five 
new configurations. The names 
are the same names that appear 
in column A of the spreadsheet.

7 Try the configurations.

Choose each of the configurations from the ConfigurationManager and 
test them.

8 Edit the design table.

Edit the design table using Edit 

Table.... Set the state to 
suppressed for the Holes 
feature in configuration Size5. 
Click outside the design table to 
apply the changes.

9 Test the edited configuration.

Test the configurations, 
focusing on Size5. The 
feature Holes should be 
suppressed in that configuration.
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10 (Optional) Add 

spreadsheet 

functions.

Edit the Design Table to 
establish relationships 
between cells in the 
spreadsheet. Make the 
Side Radius (SideR) 
equal to half the center 
to center (CtoC) 
distance. For example, 
cell C3 will be = D3/2; 
cell C4 will be = D4/2 and so on.
A USER_NOTE entry can be added to explain the relationship between 
the columns.

11 (Optional) Changes.

Make the Size3 configuration active. Double-click 
the Holes feature and change the value of the 
BoltH dimension to 0.375” for This Configuration. 
Click OK on the message box.

12 Bi-directional 

changes.

The change is made to 
the active configuration 
for that dimension. The 
change to the model 
forces a change in the 
design table.

13 Save and close the 

part.
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Exercise 43:
Existing 
Configurations 
and Linked 
Design Tables

Use existing parts to automatically create design tables 
and link to external Excel spreadsheets.

This lab reinforces the following skills:

� Automatically creating design tables from existing 
configurations.

� Inserting design tables.
� Linking to external design tables.

Auto-create Open the existing part named Auto-Create. It contains several 
configurations but no design table.

1 Auto-create.

Insert a design table using the Auto-

create option.

2 Design table.

A design table is generated from the 
existing configurations.

3 Save and close the part.

Link to External 

Excel Spreadsheet

Open the existing part Linked. It contains no configurations except 
the Default.

4 From file.

Insert a design table using the From file option. Select the file Design 
Table.xls. Select the option Link to file.

5 Edit Excel file.

Open the linked Excel file 
Design Table.xls and add a 
new configuration G6 as shown.

6 Return to the part.

Save and close the spreadsheet. 
Return to the part to see the 
updates.

7 Save and close the part.
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Exercise 44:
Designing for 
Configurations

Create a new part and design table. 
Design the part with the use of 
configurations and design tables in 
mind.

This lab reinforces the following 
skills:

� Modeling for configurations.
� Creating design tables in Excel or within SolidWorks.
� Using configurations.
� Excel options.

Procedure Create a new part using the Part_IN template. Name the part 
Design for Configs. 

1 Default configuration.

Create the basic shape of the part as a revolved feature using the 
dimensions shown.

2 Dimension names.

Rename the overall diameter (5”) dimension to Main_OD.

3 Groove Feature.

Create a cut feature to represent the groove. Name the feature Groove.

Rename the dimensions of the groove to Groove_ID, Groove_OD 
and Groove_Depth.
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4 Counterbored hole.

Use the Hole Wizard to create a through all CBORE hole for a 1/2” 
Hex Head bolt.

The Hole Wizard generates dimensions with descriptive names. The 
names C'Bore Dia.@Sketch3, C'Bore Depth@Sketch3, 
Thru Hole Depth@Sketch3 and Thru Hole Dia.@Sketch3 
are generated automatically.

5 Design table.

Use Insert, Design Table with the Auto-create option to create a 
design table within the part. Use automated and double-click methods 
to create the table shown below. Rearrange columns if necessary.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

Exercise 44 339

6 Edit the design table.

Continue editing the design table, modifying it to include the values 
and additional configurations shown below. Add three more Groove 
configurations, suppressing all the Cbore features.

Note that the Default configuration has been replaced.

7 Test the configurations.

Check the four Groove 
configurations to see if they work 
properly. While one of the Groove 
configurations is active, delete the 
Default configuration.

Note You can add comments and other data to the spreadsheet by simply 
leaving a blank column between the design table data and the 
comments.You can also color blocks of cells to make it easier to 
recognize and associate groups of data.
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8 Add more configurations.

Edit the design table again and add four more configurations for the 
Cbore. Yellow indicates copied information, bold red changed.

9 Save the part.
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Exercise 45:
Drawings

Create a drawing of the part you built 
in the previous exercise.

This lab reinforces the following skills:

� Creating named views.
� Creating a section view.
� Showing different configurations of 

a part in drawing views.
� Creating a parametric note.
� Adding dimensions and annotations.
� Adding hole callouts.
� Inserting a design table into a drawing.

Procedure Create an A-size drawing similar to the one shown below.
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Lesson 11
Shelling and Ribs

Upon successful completion of this lesson, you will be able to:

� Apply draft to model faces.

� Use the rollback bar.

� Perform shelling operations to hollow out a part.

� Create reference planes.

� Use the rib tool.

� Create thin features.
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Shelling and 
Ribs

Creating thin walled parts involves some 
common sequences and operations, whether 
they are cast or injection molded. Both 
shelling and draft are used, as well as ribs. 
This example will go through the steps of 
adding draft, creating planes, shelling and 
creating ribs.

Stages in the 
Process

Some key stages in the modeling process of this part are given in the 
following list:

� Draft with a reference plane

Draft can be defined with respect to a reference plane and direction.

� Using planes

This part contains several features that are aligned to the centerline of 
the part itself. A centered plane is used for locating features.

� Shelling

Shelling is the process of hollowing out a part. You have the option of 
removing one or more faces of the part. A shell feature is a type of 
applied feature.

� Rib tool

The rib tool can be used to quickly create single or multiple ribs. Using 
minimal sketch geometry, the rib is created between bounding faces of 
the model.

� Thin features

The thin feature option creates revolves, extrusions, sweeps and lofts 
with thin walls of constant thickness.

Analyzing and 
Adding Draft

Draft is required for both cast and injection molded parts. Because draft 
can be created in several ways, it is important to be able to check the 
draft on a part and if necessary, add more.
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1 Open the part Shelling&Ribs.

Draft Analysis The Draft Analysis tool is useful in determining whether the part has 
sufficient draft to be removed from the mold based on a set draft angle.

Where to Find It � Click Draft Analysis  on the Mold Tools toolbar.
� Or, click Tools, Draft Analysis....

2 Click Tools, Draft 

Analysis.

3 Direction of pull.

Select the rear planar face as 
the Direction of Pull. Click 
Reverse Direction so the 
pull direction arrow points 
as shown.

Set the Angle to 3° and 
click Calculate.

4 Results.

Colors are assigned to the faces according to the nature of their draft.

Find steep facesFace classificationRequire Draft
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The Face classification and Find steep faces options produce more 
specific results. Click OK to complete the command. The draft is 
insufficient.

5 Rollback.

Draft must be added at an earlier stage of modeling. 
Rollback to a position between the lower cut and 
Fillet1 features.

See Introducing: The Rollback Bar on page 235 for 
information on the rollback bar.

Other Options 
for Draft

So far we have seen one method for creating features with draft:

� Using the Draft option in the Insert, Boss/Base, Extrude... 
command.

There are times when this method does not address your specific 
situation. For example, because of the way we modeled the first 
feature, there isn’t any draft on it. Clearly, there has to be a way to add 
draft to faces after they are created.

Introducing: 

Insert Draft

Insert Draft enables you to add draft to faces of the model with respect 
to a neutral plane or a parting line.

Where to Find It � From the Insert menu, choose Features, Draft....

� Or, on the Features toolbar, click the Draft  tool.

Draft Using a 
Neutral Plane

The process of adding draft requires the selection of one Neutral plane 
and one or more Faces to draft. 
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6 Neutral plane draft.

Click Insert, Features, 

Draft... and choose Neutral 

Plane as the Type of Draft.

Select the rear planar face as 
the Neutral Plane. Set the 
Draft Angle to 3 degrees.

7 Faces to draft.

Select the eight 
faces to draft as 
shown at right.

Click Reverse 

Direction if 
necessary to point 
the arrow in the 
direction shown.

8 Completed 

draft.

Use Roll to End 
to rebuild all 
features of the 
model. The draft 
faces shown 
before (left) and 
after (right) rollback.
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9 Draft analysis recheck.

Recheck Draft Analysis using the same Direction of Pull and Draft 

Angle.

Shelling A shelling operation is used to “hollow out” a solid. You can apply 
different wall thicknesses to selected faces. You can select faces to be 
removed. In this example, all walls will have the same thickness: 2mm.

Order of 
Operations

Most plastic parts have rounded corners. If you add fillets to the edges 
before shelling and the fillet radius is greater than the wall thickness, 
the inside corners of the part will automatically be rounded. The radius 
of the inside corners will equal the fillet radius minus the wall 
thickness. Taking advantage of this can eliminate the tedious task of 
filleting the inside corners.

If the wall thickness is greater than the fillet radius, the inside corners 
will be sharp.

Introducing: 

Insert Shell

Insert Shell removes selected faces and adds thickness to others to 
create a thin walled solid. It can create multiple thicknesses in the same 
shelling command.

Where to Find It � From the Insert menu choose Features, Shell....

� Or, on the Features toolbar, click Shell .

Face Selection Shelling can remove one or more faces from the model or create a fully 
enclosed void. Here are some examples:

One face selected.
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10 Shell.

Click Insert, Features, 

Shell... and set the 
Thickness to 2mm.

Select the 4 faces shown as 
the Faces to Remove and 
check Show preview.

Click OK.

Tip Clear Show preview before selecting the faces, otherwise the preview 
will be updated with each selection, slowing down the operation.

One face selected.

Multiple faces selected.

No faces selected.
Note: The results are 
shown sectioned, using 
the Section View 
command.
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Reference Planes The Plane Wizard can be used to create a variety of reference planes 
using different geometry. Planes, faces, edges, vertices, surfaces and 
sketch geometry can all be used.

Where to Find It � Click Plane  on the Reference Geometry toolbar.
� Or, click Insert, Reference Geometry, Plane....

Shortcut Press Ctrl and drag an existing reference plane to create an Offset 
plane.

Here are some examples:

Select a planar model 
face or plane.

Optionally create a 
series of parallel planes 
each this distance apart.

Select a planar model 
face (or plane) and 
edge or axis.

Optionally create a 
series of angled planes 
this angle apart.

Select three vertices...
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or a line and a vertex.

Select a face and a 
vertex.

Select a sketched line 
and an endpoint.

Shortcut to above:
Select an edge and 
click Insert, Sketch.
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11 Parallel to plane 

at a point.

Show the sketch of 
the Stand Offs 
feature. Click 
Insert, Reference 

Geometry, 

Plane... and click 
Parallel Plane at 

Point. Select the 
Top plane and the 
point indicated.

Rename the plane thru standoff.

Ribs The rib tool, Insert, Features, Rib..., allows you to create ribs using 
minimal sketch geometry. The tool prompts you for the thickness, 
direction of the rib material, how you want to extend the sketch if 
necessary, and whether you want draft.

Select a cylindrical face 
and a reference plane.
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Rib Sketch The rib sketch can be simple or complex. It can be as simple as a single 
sketched line that forms the rib centerline, or it can be more elaborate. 
Depending on the nature of the rib sketch, the rib can be extruded 
parallel or normal to the sketch plane. Simple sketches can be extruded 
either parallel to or normal to the sketch plane. Complex sketches can 
only be extruded normal to the sketch plane. Here are some examples:

Simple sketch 
extruded parallel to 
the sketch plane.

Simple sketch 
extruded normal to 
the sketch plane.

Complex sketch 
extruded normal to 
the sketch plane.
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Introducing: 

Insert Rib

Insert Rib creates a flat topped rib either with or without draft. The rib 
is based on a sketched contour line that defines the path of the rib. A 
full round fillet can be added to round off the rib.

Where to Find It � From the Insert menu choose Features, Rib....

� Or the pick the Rib  tool on the Features toolbar.

12 Sketch line.

Create a new sketch on the
thru standoff plane. Click the 
view Normal To and use the Alt 

+Arrow (left and right) to rotate the 
view.

Sketch a line, underdefined and 
dimensioned as shown. Note that 
the line is Vertical.

13 Rib tool.

Click the Rib tool 
and set the 
parameters shown:

� Thickness: 2mm

Create rib on 

Both Sides of 

sketch 

� Extrusion 

direction:

Parallel to 

Sketch 

� Draft : 3° 

outward

Look at the Flip 

material side arrow which indicates the direction the rib will be 
extruded. If necessary, reverse the direction.
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14 Detailed preview.

Click Detailed Preview and 
clear Highlight new or 

modified faces to see a 
preview of the rib.

The completed rib extends 
down to the bottom face and 
along both ends of the 
sketched line.

Click OK.

15 Offset distance.

Select the thickness face 
and use the Plane tool 
to create a new 
reference plane Offset 
by 2mm to the inside. 
Rename the plane 
lin_patt.

16 Sketch line.

Using the new plane, sketch a 
vertical line to represent a rib. Add 
the dimension but leave the sketch 
under defined.

Sketch Patterns You can pattern sketch entities in either a linear or circular pattern. This 
is referred to as “step and repeat”. Once you create the pattern, the 
sketch entities are related with a Patterned relation. You can edit the 
definition of a step and repeat pattern once it is created.

Introducing: Linear 

and Circular Pattern

Sketch patterns are an efficient way to replicate sketch geometry 
without having to draw each entity. They are particularly useful for 
features such as ribs or as the basis of a feature pattern.
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Where to Find It � On the Sketch toolbar click Linear Pattern  or Circular 

Pattern .
� Or click Tools, Sketch Tools, Linear Pattern... or Circular 

Pattern....

17 Copies.

Click Linear Pattern 
and Add dimension. 
Add 4 copies of the line 
with the Spacing 
18mm. The dimension 
is added automatically.

18 Rib.

Click the Rib tool. 
Click the Normal to 

Sketch option and 
point the arrow towards 
the material. For the 
remaining options, 
repeat those used in the 
previous rib feature.

Full Round 
Fillets

The Full Round Fillet option creates a fillet that is tangent to three 
adjacent sets of faces. Each face set can contain more than one face. 
However, within each face set, the faces must be tangent continuously.
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Introducing: Full 

Round Fillets

A full round fillet does not need a radius value. The radius is 
determined by the shape of the faces you select.

Where to Find It � From the Insert menu choose Features, Fillet/Round....

� Or click Fillet  on the Features toolbar.

19 Full round.

Click Fillet icon 
and the Full round 

fillet option. 
Under Items To 

Fillet, select one 
face in each set as 
shown.

20 Save and close 

the file.

Center face is removed

Side faces are trimmed
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Thin Features Thin Features are made by using an open sketch profile and applying a 
wall thickness. The thickness can be applied to the inside or outside of 
the sketch, equally on both sides of the sketch or unequally on either 
side. Thin feature creation is automatically invoked for open contours 
that are extruded or revolved. Closed contours can also be used to 
create thin features.

Thin features can be created for extrudes, revolves, sweeps and lofts.

1 Open Thin_Features.

Revolve, open

Revolve, closed

Extrude, open

Extrude, closed
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2 Thin revolve.

Select the strainer sketch and 
the Revolve tool. When the 
system asks whether the sketch 
should be automatically closed, 
click No.

Set the Direction 1 thickness to 
0.20” and the direction to the 
outside.

3 Thin extrude.

Select the bracket sketch and 
the Extrude tool. Set it to Mid-

Plane and 0.20”. Click Auto-
fillet corner and set the Fillet 

Radius to 0.125”.

4 Preview.

Click Detailed Preview  to view 
the auto fillets. Click the button again 
to dismiss the preview.
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5 Direction.

Set the direction of the extrude 
towards the base feature and use 
Up To Next. Click OK.

Note This example offers another 
comparison between Up To Surface 
(top) and Up To Next (bottom).
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Exercise 46:
Pump Cover

Create this part using the 
dimensions provided. Use 
relations wisely to 
maintain the design 
intent.

This lab uses the 
following skills:

� Sketching.
� Extrusions.
� Shelling.
� Mirroring features.

Units: inches

Design Intent The design intent for this part is as follows:.

1. The tabs are all equal size and shape. 
2. Holes in the tabs are all equal.
3. All fillets are equal at radius 0.12”.
4. Wall thickness is constant.
5. Slot is centered on edge.
6. Excluding the slot, part is symmetrical about two planes. 

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Front view

Section A-A

Slot detail.
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Top view

Reverse Isometric
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Exercise 47:
Ceiling Fan Ball

Create this part using the 
information and 
dimensions provided.

This lab reinforces the 
following skills:

� Creating reference 
planes.

� Cut with Surface.
� Offset Entities.
� Convert Entities.
� Revolved bosses and 

cuts.

Procedure Use the Part_MM template.

1 Open a new part.

2 Sphere.

Create a sphere using a sketch and 
revolved feature.

3 Offset planes.

Create new reference planes 
offset from Top.

4 Cut with surface.

Create one cut feature for each 
of the reference planes created.
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5 Offset entities.

Offset from the cut edge and create a 
cut using the geometry.

6 Polygon and 

convert entities.

Use the Polygon 
tool to create a 
hexagon and modify 
it using Convert 

Entities.

Create a Cut.

7 Converted edge.

Covert the edge created by the cut with 
surface to create a Through All Cut.

8 Revolved cut.

Use converted and 
offset edges to create a 
sketch profile. 

Revolve that sketch 
using Mid-Plane and 
and angle of 180°.

9 Save and close the part.
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Exercise 48:
Motor Shield

Create this part using the 
dimensions provided. Use relations 
wisely to maintain the design 
intent. 

This lab uses the following skills:

� Sketching.
� Extrusions.
� Shelling.

Units: millimeters

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Right view: Radii 
and Diameters

Right view: 
Locations
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Right view: Interior 
cuts

Top view
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Exercise 49:
Arm

Create this part using the 
dimensions provided. Use 
relations wisely to maintain the 
design intent.

This lab uses the following 
skills:

� Sketching with symmetry.
� Thin features.
� Creating Full round fillets.
� Using the Offset from 

surface end condition.

Units: inches

Design Intent The design intent for this part is as follows:

1. Part is symmetrical.
2. All fillets and rounds 1/16”.

Dimensioned 
Views

Use the following graphics with the design intent to create the part. 
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Exercise 50:
Hook

Create this part using the 
dimensions provided. Use 
relations wisely to maintain 
the design intent.

This lab uses the following 
skills:

� Up To Surface.
� Thin features.
� Full round fillets.
Units: mm

Design Intent The design intent for this part is as follows:

1. Metal thickness is constant.
2. All chamfers 2mm X 2mm.

Dimensioned 
Views

Use the following graphics with the design intent to create the part. 
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Exercise 51:
Blow Dryer

Create this part by following the steps as 
shown.

This lab uses the following skills:

� Shelling.
� Ribs tool.
� Draft.
� Rollback.
� Linear patterns.
� Full round fillets.
� Hole wizard.

Procedure Open an existing part in the Exercises folder.

1 Open the part Blow Dryer.

2 Complete the part.

Complete the part using the following guidelines.

� Wall thickness is constant.
� Vents and ribs are the same size.
� All fillets and rounds 1mm except full rounds on ribs.
� Draft is 2 degrees. No draft on outlet face.

Note The draft feature should precede the existing fillets in the part. 

3 Save and close the part.
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Exercise 52:
Face Shield

Create this part using the information and 
dimensions provided.

This lab reinforces the following skills:

� Rollback.
� Creating reference planes.
� Creating reference axes.
� Cut with Surface.
� Hole Wizard holes.

Procedure Open an existing part in the Exercises folder.

1 Open the part

Face Shield.

2 Rollback.

Drag the rollback bar up to a position 
before the Initial Glass feature.

The new reference geometry can be 
placed before or after the feature. They 
will placed at the earliest possible 
position, before the feature.

3 Axis1.

Create Axis1 as the intersection of the Front and 
Right planes.

4 Plane1.

Create new reference plane At Angle 
of 20° from Front and about Axis1.
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5 Plane2.

Create Plane2 using a similar procedure 
as the previous plane.

6 Cuts with planes.

Cut the model geometry in 
sequence using reference 
planes Plane1 and 
Plane2.

7 Offset plane and axis.

Create the Plane3 as an offset from Top. Use Front and Plane3 
to create Axis2.
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8 Plane4.

Create Plane4 as an angle of 
25° from Plane3 about 
Axis2. Cut the model using 
that plane.

9 Rounds.

Add rounds of radius 1” to all four 
corners.

10 Hole wizard.

Create the reference planes Plane5 and Plane6 as shown. Add the 
7/16 (0.4375) Diameter Hole to the outer face and locate the 
center using the new planes. Mirror the hole feature.

11 Save and close the part.
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Lesson 12
Bottom-Up Assembly

Modeling

Upon successful completion of this lesson, you will be able to:

� Create a new assembly.

� Insert components into an assembly using all available techniques.

� Add mating relationships between components.

� Utilize the assembly-specific aspects of the FeatureManager design 
tree to manipulate and manage the assembly.

� Insert sub-assemblies.

� Use part configurations in an assembly.
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Case Study: 
Universal Joint

This lesson will examine assembly modeling through the construction 
of a universal joint. The joint consists of several components and one 
sub-assembly.

Bottom-Up 
Assembly

Bottom-Up assemblies are created by adding and orienting existing 
parts in an assembly. Parts added to the assembly appear as Component 

Parts. Component parts are oriented and positioned in the assembly 
using Mates. Mates relate faces and edges of component parts to planes 
and other faces/edges.

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 
following list. Each of these topics comprises a section in the lesson.

� Creating a new assembly

New assemblies are created using the same method as new parts.

� Adding the first component

Components can be added in several ways. They can be dragged and 
dropped from an open part window or opened from a standard browser.

� Position of the first component

The initial component added to the assembly is automatically fixed as it 
is added. Others components can be positioned after they are added.

� FeatureManager design tree and symbols

The FeatureManager includes many symbols, prefixes and suffixes that 
provide information about the assembly and the components in it.

� Mating components to each other

Mates are used to position and orient components with reference to 
each other. Mates remove degrees of freedom from the components.

� Sub-assemblies

Assemblies can be created and inserted into the current assembly. They 
are considered sub-assembly components. 
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The Assembly In this lesson we will make an assembly using existing components. 
The assembly is a universal joint, and is made up of a number of 
individual parts and one sub-assembly as shown below:

1 Open an existing part.

Open the part bracket. A new assembly 
will be created using this part.

The first component added to an assembly 
should be a part that will not move. By fixing 
the first component, others can be mated to it 
without any danger of it moving.

crank sub

Yoke_male

Bracket

pin[long]

pin[short]
(2 copies)

Spider

Yoke_female
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Creating a New 
Assembly

New assemblies can be created directly or be made from an open part 
or assembly. The new assembly contains an origin, the three standard 
reference planes and a special feature.

Introducing: Make 

Assembly from Part/

Assembly

Use the Make Assembly from Part/Assembly option to generate a 
new assembly from an open part. The part is used as the first 
component in the new assembly and is fixed in space

Where to Find It � Click Make Assembly from Part/Assembly  on the Standard 
toolbar.

� Or, click File, Make Assembly from Part.

Introducing: New 

Assembly

Create a new assembly file using a template. 

Where to Find It � Click New  on the Standard toolbar.
� Or, click File, New.... 

2 Choose template.

Click File, Make Assembly from Part and select the Advanced 

button from the New SolidWorks Document dialog. Select the 
Training Template Assembly_IN.

Shortcut Double-click the desired template to automatically open a new 
assembly document using that template.

Note The units of the assembly can be different from the units of the parts. 
For example, you can assemble a mixture of inch and millimeter parts 
in an assembly whose units are feet. However, when you edit the 
dimensions of any of the parts in the context of the assembly, they will 
be displayed in the units of the assembly, not those of the part itself. 
Using Tools, Options..., you can check the units of the assembly and if 
desired, change them.
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3 Locate component.

Place the component at the 
origin using the  cursor over 
the origin symbol. The part will 
appear in the assembly 
FeatureManager design tree as 
Fixed (f).

4 Save.

Save the assembly under the 
name Universal Joint. 
Assembly files have the file 
extension *.sldasm.

Close the bracket part file.

Position of the 
First 
Component

The initial component added to the assembly is, by default, Fixed. 
Fixed components cannot be moved and are locked into place wherever 

they fall when you insert them into the assembly. By using the  

cursor during placement, the component’s origin is at the assembly 
origin position. This also means that the reference planes of the 
component match the planes of the assembly, and the component is 
fully defined.

Consider assembling a washing machine. The first component logically 
would be the frame onto which everything else is mounted. By aligning 
this component with the assembly’s reference planes, we would 
establish what could be called “product space”. Automotive 
manufacturers refer to this as “vehicle space”. This space creates a 
logical framework for positioning all the other components in their 
proper positions.

FeatureManager 
Design Tree and 
Symbols

Within the FeatureManager design tree of an assembly, the folders and 
symbols are slightly different than in a part. There are also some terms 
that are unique to the assembly. Now that some parts and mates are 
listed there, they will be described.
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Degrees of 
Freedom

There are six degrees of freedom for any 
component that is added to the assembly 
before it is mated or fixed: translation 
along the X, Y, and Z axes and rotation 
around those same axes. How a component 
is able to move in the assembly is 
determined by its degrees of freedom. The 
Fix and Insert Mate options are used to 
remove degrees of freedom.

Components Parts that are inserted into the 
assembly, such as the bracket, 
are represented by the same top-
level icon as is used in the part 
environment. Assemblies can also 
be inserted and are shown with a 
single icon. However, when the 
listing of these icons is expanded, 
the individual components and 
even the component’s features are 
listed and accessible. 

� State of the component.

The part can be fully, over or 
under defined. A (+) or (-) 
sign in parentheses will 
precede the name if it is Over 
or Under Defined. Parts that 
are under defined have some 
degrees of freedom available. 
Fully defined ones have none. 
The Fixed state (f) indicates a component is fixed in its current 
position, but not mated. The question mark (?) symbol is for 
components that are Not Solved. These components cannot be 
placed using the information given.

� Instance Number.

The instance number indicates how many copies of a certain 
component part are found in the assembly. The name 
bracket<1> indicates that this is the first instance of the 
bracket.

� Component Part Folder.

Each component part contains the entire contents of the part, 
including all features, planes and axes.

Annotations The Annotations feature is used for the same purpose as in a part. 
Annotations can be added at the assembly level and imported to a 
drawing. Their display is also controlled by the Details option.
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Rollback Marker The Rollback marker can be used in an assembly to rollback:

� Assembly planes, axes, sketches

� Mates folder

� Assembly patterns

� In-context part features

� Assembly features

Any features below the marker are suppressed. Individual components 
cannot be rolled back.

Reorder Certain objects in an assembly can be reordered. They are:

� Components

� Assembly planes, axes, sketches

� Assembly patterns

� In-context part features

� Mates within the Mates folder

� Assembly features

Mate Groups The mating relationships in 
assemblies are grouped 
together into a Mate Folder 

named Mates. A mate group 
is a collection of mates that get solved in the order in which they are 
listed. All assemblies will have a mate group.

� Mates Folder

The folder used to hold mates that are solved together. Identified by 
a double paper clip icon .

� Mate

The relationships between faces, edges, planes, axes or sketch 
geometry that define the location and orientation of components. 
They are 3D versions of the 2D geometric relations in a sketch. 
Mates can be used to fully define a component that does not move, 
or under define one that is intended to move. Under no conditions 
should a component be over defined. The possible states for a mate 
are Under Defined, Over Defined, Fully Defined or Not Solved.
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Adding 
Components

Once the first component has been inserted and fully defined, other 
parts can be added and mated to it. In this example, the Yoke_male 
part will be inserted and mated. This part should be under defined so 
that it is free to rotate.

There are several ways to add components to the assembly:

� Use the Insert dialog.

� Drag them from the Explorer.

� Drag them from an open document.

All these methods will be demonstrated in this lesson, beginning with 
use of Insert Component. This is the same dialog that appears 
automatically when Make Assembly from Part is used.

Insert Component The Insert Component dialog is used to find, preview and add 
components to the current assembly. Click the Keep Visible (pushpin) 
button to add multiple components or multiple instances of the same 
component.

Where to Find It � Click Existing Part/Assembly  on the Assembly toolbar.
� Or, click Insert, Component, Existing Part/Assembly....

5 Insert Yoke_male.

Click Insert, 

Component, Existing 

Part/Assembly... and 
select the Yoke_male 
using the Browse... 
button. Position the 
component on the screen 
and click to place it.

The new component is 
listed as: 

(-) Yoke_male <1>

This means that the 
component is the first 
instance of Yoke_male 
and it is under defined. It 
still has all six degrees of 
freedom.
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6 Highlighting.

Clicking on a component in the 
FeatureManager design tree will cause that 
component to highlight (light green). Also, 
moving the cursor to a component in the 
graphics window will display the feature 
name.

Moving and 
Rotating 
Components

One or more selected components can be moved or rotated to 
reposition them for mating using the mouse or the Move and Rotate 

Component commands. Also, moving under defined components 
simulates movement of a mechanism through dynamic assembly 
motion.

Where to Find It Using the mouse:

� Drag and drop a component.
� Right-click a component, and select Move with Triad. 

Use the triad to move or rotate components along or 
around axes. Float over arrowhead: left-drag to move 
along the axis, right-drag to rotate about the axis.

Using the menus:

� From the pull-down menu choose: Tools, Component, Rotate or 
Move.

� Right-click the component, and select Move....
� Or, on the Assembly toolbar pick one of these tools:

Moves a component. This can also be used to rotate components 
that have rotational degrees of freedom.

Rotates the component in one of several ways: about its 
centerpoint; about an entity such as an edge or axis; or by some angular 
value about the assembly X, Y, or Z axes.

Note Move Component and Rotate 

Component behave as a single, 
unified command. By expanding 
either the Rotate or Move 
options, you can switch between 
the two commands without ever 
closing the PropertyManager.
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The Move tool has several options for defining the 
type of movement. The option Along Entity has a 
selection box, Along Assembly XYZ, By Delta 

XYZ, and To XYZ Position require coordinate 
values.

The Rotate tool also has options to define how the 
component will rotate.

7 Move.

Click on the component and drag it to move it 
closer to where it will be mated.

Other options for moving and rotating the 
component will be discussed later in this lesson. 

Mate to Another 
Component

Obviously dragging a component is not sufficiently precise for building 
an assembly. Use faces and edges to mate components to each other. 
The parts inside the bracket are intended to move, so make sure that 
the proper degree of freedom is left available.

Note The Standard Mates are discussed in this lesson. The Advanced 

Mates (Symmetric, Cam, Gear and Distance/Angle Limit Mates) are 
discussed in the Advanced Assembly Modeling manual.

Introducing: 

Insert Mate

Insert Mate creates relationships between component parts or between 
a part and the assembly. Two of the most commonly used mates are 
Coincident and Concentric.

Mates can be created using many different objects. You can use:

� Faces
� Planes
� Edges
� Vertices
� Sketch lines and points
� Axes and origins

Mates are made between a pair of objects.

Where to Find It � On the Insert menu, select Mate....
� Or, on the Assembly toolbar, click Mate .
� Or, right-click a component and choose Add/Edit Mates.
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Mate Types and 
Alignment

Mates are used to create relationships between components. Faces are 
the most commonly used geometry in mates. The type of mate, in 
combination with the conditions Anti-aligned or Aligned, determines 
the result.

Anti-Aligned Aligned

Coincident

(faces lie on the same 
imaginary infinite plane)

Parallel

Perpendicular

Aligned and anti-aligned do 
not apply to Perpendicular.

Distance

Angle
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Fewer options are available with cylindrical faces but they are every bit 
as important.

Common Buttons There are three buttons common to all the controls:

�  is Undo

�  is Flip Mate Alignment

�  is OK or Add/Finish Mate.

In addition to these, the Mate dialog itself also has specific mate 

alignment controls,  and .

Things you can 

mate to

There are many types of topology and geometry that can be used in 
mating.The selections can create many mates types.

Anti-Aligned Aligned

Concentric

Tangent

Topology/

Geometry
Selections Mate

Faces or 

Surface
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Tip Although planes can be selected on the screen if they are visible, it is 
often easier to select them by name through the FeatureManager. Click 
the “+” symbol to see the tree and expand individual components and 
features. 

Line or Linear 

Edge

Plane

Axis or 

Temporary 

Axis

Point, Vertex 

or Origin

Arc or Circular 

Edge

Topology/

Geometry
Selections Mate
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Mating Concentric 
and Coincident

The Yoke_male component is to be mated so that its shaft aligns with 
the hole and the flat face contacts the bracket inner face. 
Concentric and Coincident mates will be used.

8 Selection filter.

The selection filter option is very useful in mating. Since many mates 

require face selections, set the Select option to faces . Note that this 
filter will remain in effect until SolidWorks or the part is exited, or the 
filter is changed.

9 Mate PropertyManager.

Click on the Insert Mate tool  to access the 
PropertyManager. If the PropertyManager is open, 
you can select the faces without using the Ctrl key.

Mate Options Several mate options are available for all mates:

� Add to new folder

Creates a new folder to hold all the mates created 
while the Mate tool is active. The folder resides in 
the Mates folder and can be renamed.

� Show pop-up toolbar

Toggles the Mate Pop-up Toolbar on and off.

� Show preview

Shows the positioning created by the mate as soon as the second 
selection is made. It is not finalized until the dialog OK is clicked.

� Use for positioning only

This option can be used to position geometry without constraining it. 
No mate is added.
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Introducing: Mate 

Pop-up Toolbar

The Mate Pop-up Toolbar is used to make 
selections easier by displaying the available 
mate types on the screen. The mate types that are available vary by 
geometry selection and mirror those that appear in the 
PropertyManager. The dialog appears on the graphics but can be 
dragged anywhere.

Either the on-screen or PropertyManager dialog can be used. This 
lesson uses the on-screen dialog. All types are listed in the chart Mate 

Types and Alignment on page 386.

10 Selections and preview.

Select the faces of the Yoke_male and the 
bracket as indicated.

As the second face is selected, the Mate Pop-

up Toolbar is displayed.

Concentric is selected as the default and the 
mate is previewed.

11 Add a mate.

The faces are listed in the Mate Settings list. Exactly 
two items should appear in the list.

Accept the Concentric mate and click Add/Finish 

Mate (check mark).

12 Planar face.

Select the top planar face of the Yoke_male 
component.

13 Select Other.

Use Select Other to select the 
hidden face of the bracket on 
the underside of the top flange. 
Add a Coincident mate to bring 
the selected faces into contact.
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14 Mates listed.

The mates, concentric and coincident, remain listed 
in the Mates group box. They will be added to the 
Mates folder when the OK button on the 
PropertyManager dialog is clicked. They can also be 
removed from this group box so that they are not added. Click OK.

15 State of constraint.

The Yoke_male component is listed as under 
constrained. It is still able to move by rotating around 
the axis of its cylindrical surface. 

Test the behavior of the Yoke_male by dragging it.

16 Add the spider.

Use Insert Component to add the spider 
component.

17 Concentric mate for spider.

Add a mate between the spider and the Yoke_male.

Add a Concentric mate between the two cylindrical 
faces.

Turn off the face Selection Filter.

Width Mate The Width mate is the first of the Advanced Mates the Mate dialog. 
Selections include a pair of Width selections and a pair of Tab 

selections. The Tab faces are centered between the Width faces to 
locate the component. The spider component should be centered 
within the Yoke_male and Yoke_female components. 

Note The remaining advanced mates are discussed in the Advanced 

Assembly Modeling manual.

Width References The Width selections form the “outer” faces, used to contain the other 
component.
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Tab References The Tab selection(s) form the “inner” faces, used to locate the 
component.

18 Plane to plane mate.

Click Insert, Mate and select the 
Advanced Mates tab. 

Click the Width  mate and 
select the Width selections and 
Tab selections as shown. 

Width selections Tab selection(s) Result

(Front view)

(single selection)

(Front view)

(Front view)
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19 Results.

The mate keeps the spider centered inside the 
Yoke_male with equal gaps on each side.

20 Mates by component.

Expand the spider 
component in the 
FeatureManager. A folder 
named Mates in 
Universal Joint is 
added to each component 
that is mated. The folder 
contains the mates which 
use geometry of that 
component. 

The folder is a subset of the 
Mates folder which 
contains all mates.

Adding Components 

Using Windows 

Explorer

Another way to add components to the assembly is through Windows 
Explorer or My Computer. The part or assembly file(s) can be dragged 
and dropped into the active assembly.
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21 Open Explorer.

Size the Explorer window so 
the SolidWorks graphic area can 
be seen. Since SolidWorks is a 
native Windows application, it 
supports standard Windows 
techniques like “drag and drop”. 
The part files can be dragged 
from the Explorer window into 
the assembly to add them. Drag 
and drop the Yoke_female 
into the graphics area.

22 Concentric mate.

Select the cylindrical faces as shown and add a 
Concentric mate between them.

23 Plane to plane mate.

Add a Width mate between the spider and the 
Yoke_female.

The spider is centered on the Yoke_female 
component.
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24 Potential over defined condition.

Select the faces of the Yoke_female and 
bracket as shown. Because of the clearance 
between the Yoke_female and the bracket, a 
Coincident mate is unsolvable. The gap prevents 
coincidence.

If a Coincident mate was selected, a warning 
dialog would appear:

Warning: This mate is over defining the assembly. 
Consider deleting some of the over defining mates. 

Parallel Mate A Parallel mate keeps the selected planar faces or planes parallel to 
each other without forcing contact between them.

25 Set to Parallel.

Select the Parallel mate to maintain 
the gap between the faces.

26 Dynamic assembly motion.

Drag any of the under defined components to turn 
them all.

Displaying Part 
Configurations in 
an Assembly

When you add a part to an assembly you can choose which of its 
configurations will be displayed.

Or, once the part is inserted and mated, you can switch its 
configuration.
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The Pin The part named pin has two 
configurations: SHORT and 
LONG. Any configuration can be 
used in the assembly. In this case, 
two instances will use SHORT 
and one will use LONG.

Using Part 
Configurations 
in Assemblies

Multiple instances of the same part can be used in an assembly, with 
each instance referencing a different configuration. We will use 
multiple instances of a part with different configurations in this 
assembly.

There are two ways to create this type of configuration within a part:

� Applying different dimension 
values to individual 
configurations as shown at the 
right.

� Design tables.

Drag and Drop from 

an Open Document

The pin will be inserted by dragging it in from an open document 
window into the assembly.

Note If the bracket window is still open, close it before to the next step.

27 Drag and drop.

Open the part pin and tile the windows of the assembly and part. Drag 
and drop the pin into the assembly window by dragging the top-level 

component ( ) from the FeatureManager. An instance of the 
pin is added to the assembly.

LONG

SHORT
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Important! The pin is a component that 
contains multiple configurations. 
Components like this display the 
configuration they are using as 
part of the component name. In 
this case the configuration used 
by instance <1> is LONG. Each 
instance can use a different 
configuration.

28 Concentric mate.

Add a Concentric mate between the cylindrical 
face in the Yoke_female and pin.

The pin can be dragged while using the mate dialog. 
Drag it through as shown.

29 Tangent mate.

Add a Tangent mate between the planar end 
face of the pin and the cylindrical face in 
the Yoke_female.

The Second Pin Another instance of the pin is needed. This one will be the shorter 
version, SHORT. We will open the pin, tile the windows of the part 
and assembly, and show the part’s ConfigurationManager.
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Opening a 
Component

When you need to access a component while working in an assembly, 
you can open it directly, without having to use the File, Open menu. 
The component can be either a part or a sub-assembly.

30 Cascade the windows.

Click Window, Cascade to see both the part and assembly windows.

Switch to the ConfigurationManager of the pin.

31 Drag and drop a configuration.

Drag and drop the configuration SHORT into the graphics window of 
the assembly. You can drag and drop any configuration from the 
ConfigurationManager, not just the active one.

Other Methods of 

Selecting 

Configurations

To get the same result using Insert Component, browse for the part 
and associated configuration.

When using Explorer, parts that contain 
configurations trigger a message box 
when dragged and dropped. Select the 
desired configuration from the list.
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32 Second instance.

The second instance of the pin component is 
added, this time using the SHORT configuration. 
The component is added and it displays the 
proper configuration name in the FeatureManager 
design tree.

33 Mate the component.

Add Concentric and Tangent mates to mate the 
second instance of the pin.

Creating Copies 
of Instances

Many times parts and sub-assemblies are used more than once in an 
assembly. To create multiple instances, or copies of the components, 
copy and paste existing ones into the assembly.

34 Close the pin document and maximize the assembly window.

35 Drag a copy.

Create another copy of the pin component by 
holding the Ctrl key while dragging the instance 
with the SHORT configuration from the 
FeatureManager design tree of the assembly. The 
result is another instance that uses the SHORT 
configuration, since it was copied from a 
component with that configuration.

You can also drag a copy by selecting the component in the graphics 
window.

Component 
Hiding and 
Transparency

Hiding a component temporarily removes the component’s graphics 
but leaves the component active within the assembly. A hidden 
component still resides in memory, still has its mates solved, and is still 
considered in operations like mass property calculations.

Another option is to change the transparency of the component. 
Selections can be made through the component to others behind it.
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Introducing:

Hide Component

Show Component

Hide Component turns off the display of a component, 
making it easier to see other parts of the assembly. When a 
component is hidden, its icon in the FeatureManager 
design tree appears in outline form like this: .

Show Component turns the display back on.

Where to Find It � Click Hide/Show Components  on the Assembly toolbar. This 
acts as a toggle. If the component if visible, it will hide it. If the 
component is hidden, it will show it.

� Right-click the component and select Hide or Show.
� Right-click the component and select Component Properties... 

from the Component list. Select the Hide Component check box.
� From the pull-down menu, choose Edit, Hide or Edit, Show.

Introducing: Change 

Transparency

Change Transparency makes the component 
transparency 75% and switches it back to 0%. 
Selections pass through the transparent 
component unless the Shift key is pressed 
during selection. The FeatureManager icon does 
not change when a component is transparent.

Where to Find It � Click Change Transparency  on the Assembly toolbar. This 
acts as a toggle.

� Right-click the component and select Change Transparency.

36 Hide the bracket.

Change the view orientation by pressing Shift+Left Arrow 
once. Click on the bracket component and hide it using 

the Hide/Show Component  tool. Hiding removes the 
component’s graphics temporarily but leaves the mates 
intact. The FeatureManager design tree displays the 

component in outline when hidden .

Important! Use Hide Component not Hide Solid Body. Hide Solid 

Body will hide the solid within the part.
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37 Complete the mating.

Complete the mating of this component by adding 
Concentric and Tangent mates using Insert Mate.

38 Show the component.

Select the bracket again and click Hide/Show 

Component to toggle the graphics back on.

39 Return to previous view.

Previous view states can be recalled using the 

Previous View  button on the View toolbar. 
Each time you press the button, the view display 
backs up through the display list, whether the 
view state was saved or not. Click once to return to the previous 
Isometric view.

Component 
Properties

The Component Properties dialog controls several aspects of a 
component instance.

� Model Document Path

Displays the part file that the instance uses. To replace the file the 
instance references with a different file, use File, Replace....

� Visibility

Hides or shows the component. Also allows you to change the color of 
the component as it appears in the assembly.
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� Suppression state

Suppress, resolve or set the component to lightweight status.

� Solve as

Makes the sub-assembly rigid or flexible. This allows dynamic 
assembly motion to solve motion at the sub-assembly level.

� Referenced configuration

Determines which configuration of the component is being used.

40 Component properties.

Right-click the pin<3> component and select Component Proper-

ties... from the Component list. The Use named configuration 
option is checked and set to SHORT. This dialog box can be used to 
change the configuration, suppress, or hide an instance. If Referenced 

configuration is set to Use component’s “in-use” or last saved 

configuration, the saved configuration will be displayed.

Click Cancel.

Sub-assemblies Existing assemblies can also be inserted into the current assembly by 
dragging. When an assembly file is added to an existing assembly, we 
refer to it as a sub-assembly. However, to the SolidWorks software, it is 
still an assembly (*.sldasm) file.

The sub-assembly and all its component parts are added to the 
FeatureManager design tree. The sub-assembly must be mated to the 
assembly by one of its component parts or its reference planes. The 
sub-assembly is treated as a single piece component, regardless of how 
many components are within it.

A new assembly will be created for the components of the crank. It will 
be used as a sub-assembly.

41 New assembly.

Create a new assembly using the Assembly_IN template. 

Click Keep Visible  on the Insert Component 
PropertyManager and add the crank-shaft component. 
Locate it at the origin of the assembly. It is Fixed.

Name the assembly crank sub.
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42 Add components.

Using the same dialog, add the 
crank-arm and crank-
knob components.

Close the dialog.

Smart Mates Mates can be added between components while dragging and dropping 
them. This method, called Smart Mates, uses the Alt key in 
conjunction with standard drag and drop techniques.

These mates use the same Mate Pop-up Toolbar as the Mate tool uses 
to set the type and other attributes. All mate types can be created with 
this method.

Certain techniques generate multiple mates and do not use the toolbar. 
These require the use of the Tab key to switch mate alignment.

43 Smart Mate concentric.

Follow these steps to add a Concentric mate through the Smart Mate 

technique:

1. Click and hold the circular face 
of the crank-arm.

2. Press and hold the Alt key as 
you drag the component.

3. Move the component over the 
circular face of the crank-
shaft.

4. Drop the component when the 
 tooltip appears, indicating a 

concentric mate.
5. Confirm the Concentric type 

from the Mate Pop-up Toolbar.
A Concentric mate is added between the crank-arm and the 
crank-shaft components.
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44 Smart Mate parallel.

Spin the crank-arm around so 
the flat is selectable using 
dragging. Select the flat and Alt-

+drag it to the flat on the crank-
shaft. Drop the component when 
the  symbol appears, indicating 
a Coincident mate between planar 
faces.

Use the Mate Pop-up Toolbar to 
switch to a Parallel mate.

45 Coincident.

Select the edge of the crank-arm and Alt-

+drag it to the flat on the crank-shaft. Drop 
the component when the  symbol appears, 
indicating a Coincident mate between and edge 
and a planar face. Use the Mate Pop-up Toolbar 
to confirm the Coincident mate.

46 “Peg-in-hole”.

The “Peg-in-hole” option is a 
special case of the Smart 

Mate that creates two mates 
from one drag and drop. This 
operation is easier if the 
crank-knob has been 
rotated.

Select the circular edge on 
the crank-knob. Press Alt 
and drag it to the circular 
edge on the top of the 
crank-arm. 

Release the Alt key when the 
 symbol appears, 

indicating that both 
Coincident and Concentric 

mates will be added.

Press the Tab key, if necessary, to reverse the alignment. Drop the 
component.
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47 Save.

Save the assembly but leave it open.

Inserting Sub-
assemblies

Sub-assemblies are existing assemblies that are added to the active 
assembly. All of the components and mates act as a single component.

48 Select the sub-assembly.
Using Insert Component, the dialog is set to list any 
open parts or assemblies under Open documents. 
The crank sub is listed and selected.

49 Place the sub-assembly.

Place the sub-assembly near 
the top of the Yoke_male 
component.

Expanding the sub-assembly 
component icon shows all the 
component parts within it, 
including its own mate group.

Mating Sub-
assemblies

Sub-assemblies follow the same rules for mating as parts. They are 
considered components and can be mated using the Mate tool, 
Alt+drag mating or a combination of both.
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50 Smart Mate concentric.

Add a Concentric mate, using Alt+drag, 
between the cylindrical surfaces of the post on 
the top of the Yoke_male and the crank-
shaft.

51 Parallel mate.

Mate the flat on the Yoke_male with the flat in the 
D-hole in the crank-shaft using the Mate tool 
and a Parallel mate.

52 Alignment.

Click the Flip Mate Alignment 
button to test Anti-Aligned (above) 
and Aligned (right). Use the anti-
aligned condition for this mate.

Question: Why wouldn’t you use a Coincident mate here? 

Answer: Because unless the dimensions of the

flats and the diameters of the shaft and corre-

sponding hole are exactly right, a coincident mate

would over define the assembly.
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Distance Mates Distance mates allow for gaps between mating components. You can 
think of it as a parallel mate with an offset distance. There is generally 
more than one solution so the options Flip Mate Alignment and Flip 

Dimension are used to determine how the distance is measured and 
what the side it is on.

53 Select the faces.

Select the top face of the bracket and the bottom 
face of the crank-shaft component to create the 
mate.

54 Add a Distance mate.

Specify a distance of 1mm.

Note Even though the units of this assembly and all of its components are 
inches, you can enter metric values in the spin boxes. Just type mm 
after the number. The system will automatically convert it to 0.039 
inches.

Click Preview.

If the crank-shaft penetrates into the bracket select the Flip 

Dimension  button.

Click OK to create the mate.

Tip Double-clicking a Distance or Angle 
mate in the FeatureManager displays it 
on the screen. The value displays in the 
units of the assembly, in this case inches.

55 Select in the FeatureManager.

Select the sub-assembly crank sub in the 
FeatureManager design tree. All components in the 
sub-assembly will be selected and highlighted light 
green.
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56 Dynamic Assembly Motion.

Use Change Transparency on the yokes and pins. 
Move the handle to see the motion of the spider.

Use For Positioning 

Only

The mate option Use for positioning only can be used to position 
geometry without adding the restriction of a mate. This is a useful 
method for setting up a drawing view.

57 Mate.

Click the Mate tool and select Use for 

positioning only. Select the planar 
faces shown and a Parallel mate. 
Click OK.

The geometry is positioned like a 
parallel mate condition but no mate is 
added.

58 Save and close.
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Exercise 53:
Gearbox 
Assembly

Create this assembly by using mates 
only. No dimensions are provided.

This lab uses the following skills:

� Bottom-Up assembly creation.
� Adding components to an 

assembly.
� Creating mates between 

components using Insert Mate.

Units: inches

Design Intent The design intent for this part is as follows:

1. Files are found in the Gearbox Assy folder.
2. Component parts are mated as shown in the details.
3. Two instances of the Cover_Pl&Lug are required.

Part Design Use the following graphics along with the design intent to determine 
the shape and relationships within the assembly.

Procedure Open a new assembly using the Assembly_IN template.

1 Add the components.

Drag the component parts into a new assembly document.

2 Mate the components.

Mate the Housing to the origin of the assembly. Mate the other 
components to the Housing and each other.

Cover Plate

Main Housing

Offset Shaft

Cover_Pl&Lug (2 req'd)

Worm Gear Shaft

Worm Gear

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

410 Exercise 53

3 Cutaway of the assembly.

This cutaway shows the internal 
components of the assembly. Use this 
and the following details to mate 
components in the assembly.

4 Orientation of components.

The Cover_Pl&Lug components are oriented differently on the front 
and back. Note the position of the lug in these views.

Note You do not need to create these section views. They are provided for 
information purposes only.

� Top view.

This view shows the 
cutting line for 
Section B-B.
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� Section B-B.

Section B-B is cut from 
the Top view.

� Front view.

This view includes the cutting 
line for Section A-A.

� Section A-A.

Section A-A is cut from the Front 
view.
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� Detail C.

Detail C is taken from 
Section B-B and includes the 
mating of the groove.

5 Save and close the assembly.
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Exercise 54:
Part Design 
Tables in an 
Assembly

Using the parts 
included, complete this 
bottom up assembly. 
Use several configura-
tions of the same part in 
the assembly to create a 
set of allen wrenches. 

This lab reinforces the 
following skills:

� Configurations in a 
part.

� Part configurations in assemblies.
� Editing design tables.
� Bottom-up assembly design.
� Exploded views and explode lines.

Procedure Open an existing assembly.

1 Existing assembly.

Open the existing 
assembly named part 
configs. It is located 
in the folder named 
Part DT in Assy. The 
assembly contains three 
components, two of 
which have multiple 
instances. One 
component, the Allen 
Wrench, uses a 
different configuration 
for each instance.

2 Open part.

Select any instance of the 
Allen Wrench component 
and open the part.
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3 Design table.

Edit the design table that is embedded there. Change the values in the 
Length@Sketch1 column only.

4 Add and mate components.

Add and mate three more components, 
noting the configurations of the Allen 
Wrench parts. The sizes, positions and part 
names are detailed in the accompanying 
illustrations.

Hint With the part and the assembly both open, 
tile the windows. Switch to the 
ConfigurationManager in the part and drag 
in only the configurations that you need.

5 Save and close the assembly and the 

part.

Length@Sketch1

Size01 50

Size02 60

Size03 70

Size04 80

Size05 90

Size06 100

Size07 100

Size08 90

Size09 80

Size10 100
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Exercise 55:
Mates

Create this assembly by adding 
components to a new assembly and using 
Insert Mate.

This lab uses the following skills:

� Bottom-Up assembly creation.
� Adding components to an assembly.
� Creating mates between components 

using Insert Mate.

Units: inches

Design Intent The design intent for this part 
is as follows:

1. Files are found in the 
Mates folder.

2. Component parts are mated 
as shown in the details.

3. Two instances of the 
Brace and EndConnect 
are required.

4. Each Brace component is 
centered on the hole in the 
EndConnect component.

Tip Mates between planes can be used to center components.

Part Design Use the following graphics along with the design intent to determine 
the shape and relationships within the assembly.

Brace(2req'd)

RectPlate

EndConnect(2req'd)
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Exercise 56:
U-Joint 
Changes

Make changes to the assembly created in the 
previous lesson.

This exercises uses the following skills:

� Opening parts from the assembly.
� Changing part dimensions.
� Adding and deleting mates.
� Adding components.

Procedure Open an existing assembly.

1 Open the assembly named 

Changes.

The assembly is found in the U-Joint 

Changes folder.

2 Open the bracket component.

From the FeatureManager or the screen, 
open the component bracket<1> for 
editing.

3 Changes.

Double-click the first feature and change 
the dimensions that are shown as bold and 
underlined.

Rebuild the part.

4 Close and save.

Close the bracket part saving the 
changes that you have made. Respond 
Yes to rebuilding the assembly.

5 Changes.

The changes made in the part also appear in the 
assembly.

6 Turn the crank.

The crank should turn freely, turning the two yokes, 
the spider, and the pins with it.

7 Delete mate.

Expand the mate group and delete the mate 
Parallel2.

Bracket
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8 Turn the crank.

The crank should turn freely but it is no 
longer connected to the yokes and spider.

9 Insert a set screw.

Insert the existing component named 
set screw. Mate it to the small hole in the 
crank-shaft with a Concentric mate.

10 Hide component.

Hide the crank-shaft component. Add a 
Coincident mate between the flat faces of the 
set screw and the Yoke_Male.

11 Show component.

Show the crank-shaft component.

12 Turn the crank.

The crank should turn freely and once again, 
the two yokes, the spider and the pins 
should rotate with it.

13 Save and close the assembly.
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Exercise 57:
Gripe Grinder

Assemble this device by 
following the steps as 
shown.

This lab uses the 
following skills:

� Bottom-up assembly 
modeling.

� Dynamic assembly 
motion.

� Configuration of 
parts in an assembly.

Procedure Open a new assembly using the Assembly_IN template.

1 Add the component Base.

The parts for this assembly are in the 
folder named Grinder Assy.

Drag the Base into the assembly and 
fully constrain it to the assembly origin.

2 Add the Slider.

Add the Slider to the assembly. Mate 
it to one of the dovetail slots. A width 
and coincident mate are required.

3 Add a second copy of the Slider.

Mate it to the other dovetail slot. Both 
Sliders should be free to move back 
and forth in their respective slots.
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4 Crank assembly.

Open a new assembly using the 
Assembly_IN template. Build the 
Crank assembly as shown at the right. 
The Crank is shown in both exploded 
and collapsed states.

The Crank assembly consists of:

� Handle (1)
� Knob (1)
� Truss Head Screw (1)

[#8-32 (.5” long)] configuration
� RH Machine Screw (2)

[#4-40 (.625” long)] configuration

Note Both machine screws contain multiple 
configurations. Be sure you use the 
correct ones.

5 Insert the Crank assembly into the 

main assembly.

Tile the two assembly windows, and 
drag and drop the sub-assembly into the 
main assembly.

6 Mate the Crank assembly to the 

Sliders.

The two RH Machine Screws go 
into the holes in the Sliders. The 
underside of the Handle mates to the 
top face of one of the Sliders.

7 Turn the Crank.

The movement of the Knob follows an 
elliptical path. The movement of each Slider traces the major and 
minor axes of that ellipse.
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Lesson 13
Using Assemblies

Upon successful completion of this lesson, you will be able to:

� Perform mass properties calculations and interference detection.

� Create an exploded view of an assembly.

� Add explode lines.

� Generate a Bill of Materials for an assembly.
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Using 
Assemblies

This lesson will examine other aspects of assembly modeling using a 
version of the universal joint assembly. The completed assembly will 
be analyzed, edited and shown in an exploded state.

Stages in the 
Process

Some key stages in the analysis process of this part are shown in the 
following list. Each of these topics comprises a section in the lesson.

� Analyzing the assembly

You can perform mass properties calculations on entire assemblies. 
You can also perform static or dynamic interference detection.

� Editing the assembly

Individual parts can be edited while in the assembly. This means you 
can make changes to the values of a part’s dimensions while active in 
the assembly.

� Exploded assemblies

Exploded views of the assembly can be created by selecting the 
components and the direction/distance of movement.

� Bill of Materials

A BOM table can be generated from the assembly and placed on the 
drawing sheet. Associated balloons can be added to identify the items.
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Analyzing the 
Assembly

There are several types of analysis you can perform on an assembly. 
These include calculating the mass properties of the assembly and 
checking for interferences.

Mass Properties 
Calculations

Mass properties calculations were introduced in Lesson 6: Revolved 

Features. When working with assemblies, the important thing to 
remember is that the material properties of each component are 
controlled individually via the Material feature in the part. The material 
properties can also be set through Edit Material.

To review material properties, see Edit Material on page 193. To 
review mass properties calculations, see Mass Properties on page 195.

1 Open existing assembly.

Open the existing assembly UJ_for_INT.

2 Mass properties.

Click Mass Properties  on Tools toolbar.

3 Results.

The system performs the calculations and displays the results in a 
report window. The system also displays the Principal Axes as 
temporary graphics. Options can be used to change the units of the 
calculations. 

Click Close.

The symbols represent:

Output coordinate 

system
Principle Axes at 
the Center of Mass
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Checking for 
Interference

Finding interferences between static components in the assembly is the 
job of Interference Detection. This option takes a list of components 
and finds interferences between them. The interferences are listed by 
paired components including a graphic representation of the 
interference. Individual interferences can be ignored.

Introducing: 

Interference 

Detection

Interference Detection is used to find interferences (clashes) between 
component parts in an assembly. It can be directed to check all 
components in the assembly, or just selected ones.

Where to Find It � Click Interference Detection  on the Assembly toolbar.
� From the Tools menu choose: Interference Detection....

4 Click Tools, Interference Detection....

The Interference Detection PropertyManager opens.

5 Interference detection.

Select the top level component UJ_for_INT to 
check all the components in the assembly. The 
assembly UJ_for_INT.SLDASM appears in the 
Selected Components list.

Click Calculate.

6 Interferences.

The analysis has found three interferences among the 
selected entities. The listings Interference1, 
Interference2 and Interference3 are 
shown in the Results listing followed by a volume 
of interference. The interference is marked in the 
graphics window using a volume displayed in red. 
By default, the interfering components are 
transparent and the other components remain 
opaque. Click OK.

Interference1 Interference2 Interference3

bracket Yoke_male Yoke_male

crank-shaft crank-shaft crank-shaft
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7 Visual methods.

Areas of interference can sometimes be 
determined visually. Shaded (without edges) 
and Hidden Lines Visible displays can be 
used.

In this case, the crank-shaft volume 
overlaps that of the bracket.

8 Edit Feature.

Right-click the Distance1 mate 
and choose Edit Feature.

Click the Flip Dimension option 
and click OK.

9 Recheck the interferences.

Select the bracket, crank-shaft and 
Yoke_male components and click Interference 

Detection. As expected, No Interference is the 
result.
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Static vs. Dynamic 
Interference 
Detection

The problem with a static method of interference detection is that the 
components of an assembly may only interfere under certain 
conditions. What is needed is a way to detect collisions dynamically, 
while an assembly is moving.

Introducing: 

Collision Detection

Collision Detection analyzes selected components in the assembly 
during dynamic assembly motion, alerting you when faces clash or 
collide. You have the options of stopping the motion upon collision, 
highlighting the colliding faces, and generating a system sound.

Where to Find It � On the Move Component  or Rotate Component  
PropertyManagers, select Collision Detection.

10 Collision Detection.

Click Move Component  and 
check Collision Detection.

Check All components and Stop at 

collision.

Turn the U-joint by dragging the 
crank handle. When the inner edges 
of the two yokes collide, the system 
alerts you by highlighting the faces 
and generating a system sound.

11 Narrow the selection.

The option All components means collisions with 
all assembly components are detected. This puts 
more demands on system resources, especially in a 
large assembly. If you choose These components, 
only collisions with a group of assembly components 
that you select are detected.

Click These components and select the 
Yoke_female and Yoke_male components.

Click Stop at collision and then Resume Drag.

12 Turn off Collision Detection.

Click OK to close the PropertyManager.
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Performance 
Considerations

The are a number of options and techniques you can use to improve 
system performance during Dynamic Collision Detection:

� Click These components, instead of All components. In general, 
performance can be improved if you minimize the number of 
components the system has to evaluate. However, be careful that 
you do not overlook a component that does, in fact, interfere.

� Make sure Dragged part only is selected. This means only 
collisions with the component you are dragging are detected. If 
unchecked, collisions are detected for both the moving component 
and any components that move as a result of mates to the moving 
component.

� If possible, use Ignore complex surfaces.

Note The Dynamic Clearance option can be used to 
display the actual clearance between components as 
they move. A dimension appears between the 
selected components, updating as the minimum 
distance between them changes.

Correcting the 

Interference

Filleting or chamfering the edges of the yokes will eliminate the 
interference.

13 Open part.

In the FeatureManager design tree, right-
click the Yoke_female and select Open 

Part.

Add a 0.05” x 45 chamfer to the edges as 
shown. Save the changes.

14 Return to the assembly.

Click Window, UJ_for_INT.SLDASM or by using Ctrl+Tab.

When the software detects the change in the part, you will be prompted 
with a message asking if you would like to rebuild the assembly.

Click No in response to the message until all changes have been made.

15 Correct the Yoke_male component.

Open the Yoke_male using Open Part. Add a 
chamfer the same way as was done in the 
Yoke_female component. 

Save the changes and return to the assembly, 
clicking Yes on the Rebuild Assembly 
message.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual Lesson 13
Using Assemblies

Changing the Values of Dimensions 429

16 Check for interference.

Click Move Component. Click these options:

� Collision Detection

� All components

� Stop at collision

Test for interference by turning the crank. No collisions are detected.

17 Turn off the Move Component tool.

Changing the 
Values of 
Dimensions

Changing the value of a dimension in the assembly works exactly the 
same as changing that dimension in a part: double-click the feature and 
then double-click the dimension. SolidWorks uses the same part in the 
assembly or the drawing, so changing it in one place changes it in all.

The feature can be double-clicked from the FeatureManager or the 
screen, but the dimension will always appear on the screen.

18 Edit the crank-arm.

Double-click on the graphics of the crank-
arm part to access its dimensions. These are 
the dimensions used to build the part.

Change the length to 4”.

19 Edit the crank-shaft.

Change the value of the length to 2.5”. 
Notice that not only are the parts rebuilt and 
the assembly updated, the mating 
relationships ensure that the crank-arm 
moves up when the crank-shaft gets 
taller and the crank-knob moves when the 
crank-arm gets longer.
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20 Open crank-shaft.

Right-click the crank-shaft and select Open Part from the 
shortcut menu.

21 Part level changes.

Changing a part at the assembly level changes it at 
the part level and vice-versa. That is because it is the 
same part, not a copy. 

Change the value back to 1.5” and close the part, 
saving the changes.

22 Assembly update.

Changes have been made to a reference of the assembly, in this case the 
size of a part. Upon reentering the assembly, SolidWorks asks whether 
you want to rebuild. Click Yes.

23 Change values back.

Select and change the dimension of the crank-arm back to 3” and 
rebuild.

Using Physical 
Dynamics

Physical Dynamics is a method for visualizing assembly motion in a 
more realistic way. Expanding on the capabilities of dynamic collision 
detection, Physical Dynamics lets one object act upon another. When 
two objects collide, one will move the other according to the available 
degrees of freedom. Physical Dynamics propagates throughout the 
assembly. The dragged component can push aside a component, which 
then moves into and pushes aside another component, and so on.

Note Do not confuse Physical Dynamics with a kinematic analysis 
application such as COSMOSMotion. With Physical Dynamics, 
characteristics such as momentum, friction, or whether a collision is 
elastic or inelastic are not considered.

Where to Find It � On the Move Component PropertyManager, click Physical 

Dynamics.

What is this Thing? When you drag a component with Physical Dynamics enabled, at 
small symbol  appears on the component. This represents the center 
of mass. Physical Dynamics uses mass properties to compute how the 
forces acting on a component will make it behave as it collides with 
other components. Dragging a component by its center of mass exhibits 
different motion than dragging by a point on the component.
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Examples In the Physical Dynamics folder are some examples. They are 
illustrated in the chart below.

Simulation Element Description

Nested Slides As you drag the innermost 
slide, the next slide is 
contacted and pulled out as far 
as possible.

Clock As you drag the minute hand, 
the hour hand moves.

Geneva Wheel As you turn the input wheel, 
the pin engages and disengages 
the slots in the output wheel.

Limit Mechanism Rotate the cam wheel counter-
clockwise and the Y-shaped 
actuating lever oscillates back 
and forth.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 13 SolidWorks 2006 Training Manual
Using Assemblies

432 Using Physical Dynamics

Tips for Working 
With Physical 
Dynamics

There are some things you should keep in mind when you use Physical 

Dynamics.

1. Physical Dynamics depends on collision detection. It will not 
work if the assembly contains interferences. If the item you are 
dragging interferes with another component, the source of the 
interference is made transparent. Use Tools, Interference 

Detection to find and eliminate interferences before using 
Physical Dynamics. 

2. Use the appropriate mates to define the assembly. Highly 
unconstrained assemblies are less likely to be successful. Do not 
depend on Physical Dynamics to solve everything. For example, 
in the Nested Slides assembly, the appropriate mates were 
used to mate slide1 and slide2 so they each had only one 
degree of freedom. Then Physical Dynamics was used to handle 
the interaction of the pins and the slots.

3. Physical Dynamics does not work on assemblies that have 
symmetry mates. For more information about symmetry mates, see 
the advanced course Advanced Assembly Modeling.

4. Physical Dynamics can be computationally intensive. Limit the 
scope by selecting components in the Selected Items box, and then 
clicking Resume Drag. Items that are not in the list are ignored.

Bevel Gears Turn the handle on one gear, 
and the other gear rotates.

Rolling Balls Drag the individual balls so 
they collide with each other.

Simulation Element Description
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Physical 
Simulation

Physical Simulation allows you to simulate the effects of motors, 
springs, and gravity on your assemblies. Physical Simulation 
combines simulation elements with SolidWorks tools such as mates and 
Physical Dynamics to move components around your assembly. Use an 
assembly that has the mates to support the simulation effects.

Note Do not confuse Physical Simulation with a kinematic analysis 
application. With Physical Simulation, characteristics such as 
momentum, friction, or whether a collision is elastic or inelastic are not 
considered.

Simulation Toolbar The commands for Physical Simulation are located on the Simulation 
toolbar. The individual tools will be explained latter in this lesson.

Where to Find It � Click Simulation Toolbar  on the Assembly toolbar.
� Or, click View, Toolbars and select Simulation.

Toolbar Options There are several options for creating the simulation:

Stop Record or Playback Calculate Simulation

Reset Components Replay Simulation

Simulation 
Elements

There are several simulation elements that move components around in 
the assembly.

Simulation Element Description

 Linear Motor Linear Motors move components along a straight line path.

 Rotary Motor Rotary Motors move components about a selected axis, but they are 

not forces. Motor strength does not vary based on component size or 

mass. For example, a small component moves at the same speed as a 

large component if the Velocity slider is set to an equal value. You 
should not add more than one motor of the same type to the same 
component.

 Linear Spring Springs apply a force to a component. A spring with a higher spring 
constant will move a component faster than a spring with a lower 
spring constant. Also, a component with a smaller mass will move 
faster than a component with a larger mass if acted upon by springs 
of equal strength.

Motion due to a spring stops when the spring reaches its free length.

Motion due to motors supersedes motion due to springs. If you have 
a motor moving a component to the left and a spring pulling a 
component to the right, the component moves to the left.
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Animation 
Controller

The Animation Controller is 
invoked by the Replay Simulation 

 button on the Simulation toolbar.

Playback Options There are several options for replaying the simulation:

Start Rewind Play

Fast Forward End Pause

Stop Save as AVI Normal

Loop Reciprocate Slow Play

Fast Play

 Progress Bar

FeatureManager 
Design Tree

When you add simulation elements to an assembly, a 
Simulation feature is added to the FeatureManager. If 
you right-click on the Simulation feature, you can:

� Delete the Simulation feature, including all the simulation 
elements.

� Delete the replay of the simulation. This leaves the simulation 
elements intact.

� Reset the components to their positions prior to the simulation.

1 Add a rotary motor.

Click Rotary Motor  and 
select the circular edge of the 
crank-shaft as the 
Direction of the motor.

Tip Clicking the Numeric option 
allows you to set a real value 
for the angular velocity in the 
currents units. In this example 
it would be degrees per 
second.

 Gravity You can define only one gravity simulation element per assembly.

All components move at the same speed under the effect of gravity 
regardless of their mass.

Motion due to motors supersedes motion due to gravity. If you have 
a motor moving a component up and gravity pulling a component 
down, the component moves up without any downward pull.

Simulation Element Description
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2 Simulation folder.

When the Rotary Motor is added, a new Simulation 
folder is added to hold it.

3 Calculate the simulation.

Click Calculate Simulation  on the Simulation toolbar. Record 
approximately two complete revolutions of the crank-assy.

Note When you record a simulation, the components actually move within 
their degrees of freedom according to the simulation elements. The 
degrees of freedom are determined by the mates on the components and 
collisions with other components.

4 Stop recording.

Click Stop Record or Playback  on the Simulation toolbar.

5 Play the simulation.

Click Replay Simulation  on the Simulation toolbar to access the 
Animation Controller. Use any of the controller options to speed up, 
slow down, loop or reciprocate the playback.

6 Save and close.

Another Example The following section is another example of Physical Simulation where 
the motor is applied to one component and that motion affects several 
others.

1 Open an assembly.

Open the assembly 
machine.sldasm located 
in the Sarrus Mechanism 
folder.

2 Hide Component.

Switch to the Back Iso view 
and hide the Mount 
component.

This will make it easier to add 
a rotary motor to the shaft of 
the Wheel.
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3 Rotary Motor.

Click Rotary Motor  on the 
Simulation toolbar.

Select the cylindrical face of 
the shaft of the Wheel.

Click Reverse Direction and 
then click OK.

4 Show Component.

Switch back to the My Iso 
view, and show the Mount 
component. Record, stop and 
play the simulation in the 
same fashion as the previous 
one.

Other Examples You can use any of the assemblies in the Physical Dynamics 
folder to experiment with Physical Simulation.

Exploded 
Assemblies

You can make Exploded Views of assemblies automatically or by 
exploding the assembly component by component. The assembly can 
then be toggled between normal and exploded view states. Once 
created, the Exploded View can be edited and also used within a 
drawing. Exploded Views are saved with the active configuration.

Setup for the 
Exploded View

Before adding the Exploded View, there are some setup steps that will 
make the exploded view easier to access. It is good practice to create a 
configuration for storing an Exploded View and also to add a mate the 
holds the assembly in a “starting position”.

1 Open an assembly.

Open the assembly Launcher.sldasm 
located in the Exploded View folder.
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2 Add a new configuration.

Switch to the ConfigurationManager, right-click 
and select Add Configuration.

Type the name Exploded and add the configura-
tion.

The new configuration is the active one.

For more information on Assembly Configurations, see the Advanced 

Assembly Modeling manual.

Introducing:

Exploded View

Exploded View is used to move one or more components along an arm 

of the Move Manipulator  or triad. Each move direction and 

distance is stored as a step.

Where to Find It � From the Insert menu, pick Exploded View....

� Or, click Exploded View  on the Assembly toolbar.

3 Click Insert, Exploded View. 

The Exploded View dialog box 
appears. Explode Steps allows 
for individual movement of each 
component.

The Settings group box lists the 
components exploded in the 
current step along with direction 
and distance.

The Options group box includes 
the automation Auto-space and 
sub-assembly options.

Exploding a Single 
Component

One or more components can be moved in one or more directions. Each 
movement (one or more components) set by a distance and direction is 
considered one step.
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4 Select component.

Select the Arrow<3> component one the 
screen. A Move Manipulator appears at the 
center of the component bounding box. The 
Move Manipulator is aligned with the x leg 
along the length of the cylindrical face.

5 Drag explode.

Explode the component by 
dragging the red leg away from 
the assembly. The Explode 
Step1 feature is added. The 
component is listed beneath it.

Click off the component to 
complete the step.

Tip Selecting the step by name in the dialog displays the components in 
yellow with the blue arrow.

Move Manipulator 

and Drag Arrow

The Move Manipulator axes are 
used as vectors for the explode step. 
Once created, the step distance can 
be modified by dragging the blue 
arrow along the explode line.

If the Move Manipulator axes do not 
point in the desired directions, its 
orientation can be changed. Drag the 
manipulator origin and drop it on an 
edge, axis, face or plane to reorient it.
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Multiple 
Component 
Explode

Multiple components can be exploded along the same path or multiple 
paths. For multiple component selections, the last component selected 
determines the orientation of the Move Manipulator.

6 Selection.

Select the Arrow<1> 
component first followed by the 
remaining Arrow and both 
Nozzle components. 

Tip Making a multiple component selection can be made by clicking each 
one or using a drag-select window.

7 Paths.

Move the components along the 
red leg as shown. 

Re-select the same components 
and add another step.Pre-
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Add another step for just the 
Arrow components.

Sub-assembly 
Component 
Explode

Sub-assemblies can be treated in several ways. As single components, 
they can be moved as one. As individual components, each can be 
moved independently. If an exploded view of that sub-assembly 
already exists, it can be added to the current exploded view.

8 Sub-assembly as component.

Select the upper SUB_trigger 
component and move it with two 
steps as shown.Pre-
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Auto-spacing The Auto-space components after drag option is used to spread a 
series of components along a single axial step. The spacing can be set 
with a slider and changed after creation.

The Select sub-assembly’s parts option treats each sub-assembly 
component as an individual component.

9 Auto-space.

Click Select sub-assembly’s parts 
and Auto-space components after 

drag. Select the three components of 
the sub-assembly individually. Drag 
along the red leg and drop to space the 
components. A Chain step is added.

10 Adjust.

Drag the End Cap component using the 
blue arrow and drop it between the other 
two components. The spacing remains 
with a different order.

Reusing Explodes Exploded views created within sub-assemblies can be imported and re-
used.
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11 Move sub-assembly.

Clear the Select sub-assembly’s parts and Auto-space 

components after drag options. Drag the lower SUB_trigger sub-
assembly as shown. 

12 Reuse sub-assembly explode.

Select the sub-assembly and click Reuse sub-assembly explode.

Explode Line 
Sketch

Create lines as paths for the exploded view using Explode Lines. A 
type of 3D sketch called an Explode Line Sketch is used to create and 
display the lines. The Explode Line Sketch and Jog Line tools can be 
used to create and modify the lines.
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Explode Lines Explode Lines can be added to the explode line sketch to represent the 
explode path of the components.

Introducing:

Explode Line Sketch

An Explode Line Sketch allows you to semi-automatically create 
explode lines. To do this, you select model geometry such as faces, 
edges, or vertices, and the system generates the explode lines.

Where to Find It � On the Insert menu, click Explode Line Sketch.

� Or, click Explode Line Sketch  on the Assembly toolbar.

Introducing: 

Jog Line

Jog Line is used to break an 
existing line and create a series of 
90° lines. The jog lines are 
automatically constrained to be 
perpendicular and parallel to the 
original lines.

Where to Find It � On the Tools menu, click Sketch Tools, Jog Line.

� Or, click Jog Line  on the Explode Sketch toolbar.

13 Route line.

Click Explode Line Sketch to start the 3D 
sketch. Select the arc and circle edges as 
shown to create a route line between them. 
Various combinations of the Options can 
be used to get different results. 

Click OK.

14 Explode through component.

Select (in order) the circular edge 
of the Main Body<1>, the 
cylindrical face of the 
Nozzle<1> and the circular edge 
of the Arrow<1>. A continuous 
series of explode lines is created.

Before After
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15 Edit explode lines.

Move individual line segments by 
dragging the small arrows as 
shown. You can also click the 

small 3D arrows  at the ends of 
the explode lines to reverse their 
direction. Right-click OK.

16 Additional lines.

Add sets of explode lines to connect all the remaining components.

Customizing 

Toolbars

The Route Line and Jog Line tools are located on the Explode 
Sketch toolbar by default. You may decide it is more convenient 
to add these two tools to an existing toolbar, such as the Sketch Tools or 
Assembly toolbar. You can do this by clicking Tools, Customize..., 
and selecting the Commands tab. Select Explode Sketch from the 
Categories list, and drag the buttons onto the desired toolbar.

Animating 
Exploded Views

The Animation Controller can be used to animate the explode or 
collapse motion. 

Where to Find It � Right-click Animate Collapse from the ExplodeView1 feature.
� If the exploded view is collapsed, right-click Animate Explode 

from the ExplodeView1 feature.
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17 Animation toolbar.

Right-click on ExplView1 and 
choose Animate Collapse.

The dialog uses standard VCR-like controls including  Play.

For more information on the other options, see Animation Controller 

on page 434.

18 Save and close.

Collapse the assembly. Save and Close the assembly.

Assembly 
Drawings

Assemblies have several unique requirements when it comes to making 
detail drawings of them. In addition to specialized views, assemblies 
require a Bill of Material and Balloons to fully document the assembly.

1 New drawing.

Use Make Drawing from Part/Assembly  to create a new drawing 
using the A-Scale1to2 template.

2 Named View.

Using the automatic Model View dialog, add a named view of the 
assembly Launcher. Set the orientation to *Isometric with Scale 

1:4 and place it on the drawing. This view will be used to display an 
exploded view.Pre-
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3 View Properties.

Click More Properties to 
see that the Exploded 
configuration and Show in 

exploded state are 
selected.

Note The Show in exploded 

state option will appear 
only if there is an existing 
exploded view in the 
selected configuration.

Bill of Materials In an assembly drawing, a bill of materials report can be automatically 
created and inserted onto the drawing sheet.

Where to Find It � Click Bill of Materials  on the Table toolbar.

� Or from the Insert menu, select Tables, Bill of Materials....

4 BOM Settings.

Click in the exploded view and click Insert, 

Tables, Bill of Materials.... Select bom-
standard as the Table Template, Parts only as 
the BOM Type and Exploded as the 
Configurations.

Since both configurations contain the same 
components, either configuration will work.
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5 Bill of Materials.

The BOM will appear on the screen where you clicked when you 
selected the view.

You can resize the BOM columns by dragging them. The entire BOM 
can also be moved.

Adding Balloons The item numbers assigned by the bill of materials can be added to the 
drawing using Balloons. These balloons will assign the proper item 
number as they are inserted onto edges, vertices or faces.

Introducing: Auto 

Balloons

The Auto Balloon command is used to automatically label the 
components of an assembly drawing by item number and optionally 
quantity. There are several different shapes of balloons.

Where to Find It � On the Annotations toolbar, click Auto Balloon .
� Or, on the Insert menu, click Annotations, Auto Balloon....

6 Insert balloons.

Click on the Auto Balloon tool  and select the Square layout. 
Balloons with the correct item numbers are added. When you drag the 
item 1 balloon closer to the view, they all move.

7 Save and close the drawing and any other open files. 

In the Drawings 
Course...

The three sections about drawings covered in this course are just an 
introduction to the art of detailing. In the course SolidWorks Essentials: 

Drawings, you will learn about all aspects of making detailed drawings 
of piece parts and assemblies.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Lesson 13 SolidWorks 2006 Training Manual
Using Assemblies

448 In the Drawings Course...

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2006 Training Manual

Exercise 58 449

Exercise 58:
Using Collision 
Detection

Using the assembly 
provided, determine the 
range of motion of the 
clamp handle.

This lab reinforces the 
following skills:

� Collision Detection.
� Dimensioning or using 

the Measure 
command.

Procedure Open an existing assembly.

1 Existing assembly.

Open the existing assembly named Collision 
from the folder Collision.

2 Collision locations.

The link stops the motion of the assembly in two places. Move the 
assembly to the point of collision and measure the angle formed using 
Measure or dimensions on a drawing view.

ANGLE “A”- As the handle sub-assy is pulled back, the link 
hits it.

ANGLE “B”- As the handle sub-assy is pushed forward, the 
link hits the hold-down sub-assy.

Measurements: (rounded)

Angle “A” = 38° Angle “B” = 90°
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Exercise 59:
Exploded Views

Using the existing assemblies, add exploded views and explode lines.

The files are found in the Flashlight folder.

Assembly: 

Flashlight

Tip Many of the components are 
positioned on an angle and 
require the Triad to be 
dragged and dropped to set 
the proper explode 
direction. The triad can be 
dropped onto an edge or 
face.Pre-
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Exercise 60:
Exploded Views 
and Assembly 
Drawings

Using the existing assemblies, add exploded views and explode lines. 
Use the exploded views to generate drawings with balloons and a 
BOM. Use the A-Scale1to2 template.

The files are found in the Exploded Views folder.

Assembly: 

part configs

Assembly: 

Gearbox 
Assembly
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Appendix

The material in this appendix supplements the material covered in the 
lessons. It was removed from the lessons to keep them of manageable 
length, and included here for your reference.

� Tools, Options settings used in this course.

� Creating a customized document template for parts.

� Organizing your document templates.

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2005 Training Manual

454

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



SolidWorks 2005 Training Manual

Options Settings 455

Options 
Settings

The Tools, Options dialog is the means by which default SolidWorks 
settings are changed. It contains settings that apply to individual 
documents and that are save with those documents, as well as settings 
that apply only to your system and your work environment.

The Tools, Options dialog contains two tabs that are labelled System 

Options and Document Properties.

Applying Changes There are tabs within Options to make changes to the system or 
document properties. This allows you to control how the settings are 
applied. Your choices are:

� System Options

Changes to the system options customize your work environment. They 
are not saved with specific document. Rather, any document opened on 
your system will reflect these settings. For example you might want 
your default spin box increment to be 0.25 inches. I might typically 
work on small parts and want a default spin box increment of only 
0.0625 inches. System options let us each customize our work 
environment to our own needs.

� Document Properties

Changes will affect only the currently open document. The system’s 
default settings are not changed.

Changing the 
Default Options

To change the default Options, follow this procedure:

1. From the Tools menu, choose Options.
2. Select the tab for the settings you wish to change.
3. When finished, click OK.

Note You can only access document properties when a document is open.

Suggested 
Settings

For a complete listing of all the settings available through the Tools, 

Options dialog refer to the on-line help.

Important System Options that are used in this manual are:

� General

Input dimension value: Enabled
Maximize document on open: Enabled

� Sketch

Display plane when shaded: Disabled

� Default Templates

Always use these default document templates: Enabled

Document 
Templates

With a Document Template file (*.prtdot, *.asmdot, 
*.drwdot) you can save document properties for use in new 
documents. You can create a new template that contains just the 
settings that you want. When you want to create a new document, 
select the template you want and the document will inherit the 
template’s settings.
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How to Create a 
Part Template

Creating a customized template is a simple procedure. You open a new 
document using the existing default template. Next you use the Tools, 

Options dialog to modify the document’s settings. Then you save the 
document as a template file. You can set up folders to contain and 
organize your templates.

In this section we will create customized part template.

1 Open a new part.

Open a part using the default part template. The part will be used to 
form the template and will be discarded afterwards.

2 Choose a template.

Click File, New and the Templates tab of the dialog. Click the 
template Part and OK

Note Do not use the Novice settings on the dialog when saving a document 
template. The resulting template will not be seen.

3 Properties.

Verify, and if needed, set the following Document Properties:

� Detailing

Dimensioning Standard: ANSI

� Detailing, Annotations Font

Dimension: Century Gothic; Height = 12 points
Detail: Century Gothic; Height = 12 points
Section: Century Gothic; Height = 12 points
Note/Balloon: Century Gothic; Height = 12 points

� Detailing, Dimensions

Precision, Primary Units, Value: 3

� Detailing, Annotations Display

Always display text at same size: Enabled
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� Grid/Snap

Display Grid - Disabled
Snap to Points - Disabled

� Units

Linear Units - Millimeters

� Material Properties

Material properties are document-specific. Use Edit Material to set 
the proper material for the part. It is a good idea to create a part 
template for each commonly used material. This will save time and 
ensure accurate results when performing mass properties 
calculations and when making section views on drawings.

� Reference Geometry

The default names for the three system reference planes are not 
controlled by Tools, Options. They are controlled by the document 
template. Since any feature can be renamed, the planes can be 
renamed as well. When the part is saved as a template, the plane 
names will be saved in the template file. Then, any new parts 
created using this template will automatically inherit the plane 
names. If you wish to, rename the reference planes. For example, 
you might prefer XY, XZ, and YZ instead of the default names.

4 Save a template.

Click File, Save As.

For Save as type, select Part Templates. 

Name the template mm_part and navigate to the directory where you 
want to store your customized templates. In this example, we will 
simply save the template in the SolidWorks installation directory in the 
folder Data\Templates.

Click Save.
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5 Use the template.

Close the current part without saving it. Open a new part using the 
template mm_part that appears in the dialog under the Templates tab. 
Check to see that the settings have been carried over.

Drawing 
Templates and 
Sheet Formats

Drawing templates and sheet formats have many more options than 
part or assembly templates. A complete treatment of creating and 
customizing drawing templates and sheet formats is covered in the 
course SolidWorks Essentials: Drawings.

Organizing Your 
Templates

As a general rule, it is not a good idea to store your customized 
templates in the SolidWorks installation directory. The reason for this is 
that when you install a new version of SolidWorks, the installation 
directory is overwritten. This would overwrite your customized 
templates.

A better strategy is to set up a separate directory for templates, just as 
you would for library features and standard parts libraries.

You can control where SolidWorks searches for the templates by means 
of Tools, Options, System Options, File Locations. The Show 

folders for box displays search paths for files of various types, 
including document templates. The folders are searched in the order 
they are listed. You can add new folders, delete existing folders, or 
move folders up or down to change the search order.
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Default Templates Certain operations in SolidWorks automatically create a new part, 
assembly, or drawing document. Some examples are:

� Insert, Mirror Part

� Insert, Component, New Part

� Insert, Component, New Assembly

� Form New Sub-assembly Here

� File, Derive Component Part

In these situations, you have the option of either specifying a template 
to use or having the system use a default template. This option is 
controlled by Tools, Options, System Options, Default Templates.

If you have selected Prompt user to select document template, the 
New SolidWorks Document dialog box will appear and you can 
choose the template you wish to use. If you have selected Always use 

these default document templates, the appropriate file will be 
automatically created using the default template. This section of the 
Tools, Options menu also enables you to define what template files 
the system should use by default.
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Numerics

3 point arcs 25

A

adding
components to an assembly 383, 393

analysis
factor of safety 203
mass properties 195–196
of assemblies 424–436
stress 196–210

angular dimensions 40
animating exploded views 444
annotations

balloons 447
center marks 76
datum feature symbols 324
hole callouts 83
in assemblies 381
notes 326
parametric notes 326

appearance
color 71–72
hiding components 399
of dimensions 109
RealView graphics 193
textures 264
threads 265
transparency of components 399–

400
virtual sharps 185

arcs
3 point 25, 181
autotransitioning between lines and 

arcs 61
centerpoint 25
dimensioning min/max 182
normal 60
tangent 25, 60, 189
tangent intent zones 61

area fill patterns 148
area hatch 328
area, See measure

See also section properties
array, See patterns
arrow key navigation 235
arrows

toggle inside, outside 110
assemblies 375–408, 421–447

adding components 380, 383, 393–

394, 396, 398, 402
adding sub-assemblies 402
analysis 424–436
animating exploded views 444
bottom-up design 377, 423
changing dimensions 429
collision detection 427
configurations 318–319, 330, 396, 

398–399
copying components 399
creating new 379
dynamic motion 384
explode lines 443
exploded views 436–445
FeatureManager design tree 380
hiding components 399
interference detection 425, 427
mating components 385
moving components 384, 391, 395
opening a component 398
reordering objects 382
rollback 382
rotating components 384, 391, 395
showing components 401
transparency of components 400
using part configurations 318–319, 

330, 396, 398–399
assembly drawings 445–447

balloon callouts 447
bill of materials 446
explode lines 443

assembly motion 384, 391, 395, 433–
436

associativity 7, 81–82
autodimension sketch 104–105
axes, temporary 153, 256

B

balloon callouts 447
bevel, See chamfers
bill of materials 446

balloons 447
blends, See fillets
BOM, See bill of materials
boss, definition of 52

 See also features
browser

insert component 319, 383
saving your work 23

C

callouts 69, 447
center marks 76
centerlines 26, 102

revolved features 181
centerpoint arcs 25
chamfers 192
changing dimensions

appearance 109, 123
in an assembly 429
of a part 81

changing the size of a plane 107
check sketch for feature 227
circles 25, 109

perimeter 109
circular patterns 147, 152–154
clearance detection 428
collision detection 427

performance considerations 428
color 4, 15, 18, 27, 71, 310–311

editing 71
Command Manager 15
components

adding 380, 383, 393–394, 396, 398, 
402

copying 399
hiding 399
instance number 381
mating 385
moving 384, 391, 395
opening 398
placing 385
properties 401–402
rotating 384, 391, 395
showing 401

ConfigurationManager 280
configurations 279

adding 282
assembly considerations 318–319, 

330, 396, 398–399
changing (switching) 284, 314
ConfigurationManager 280
copying 284, 314
creating 282
defining 311
deleting 317
design tables 312
editing parts that have 

configurations 286–292
modeling strategies for 319
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of parts in assemblies 318–319, 330, 
396, 398–399

performance considerations 318
renaming 284, 314
terminology 279
uses of 318
using in drawings 320

confirm delete 252
confirmation corner 24
constraints, See geometric relations
construction geometry 102
contour select tool 258–259
coordinate systems 160
copy

components in an assembly 399
configuration 284, 314
feature 127
fillets 261

COSMOSXpress 196–210
counterbore, See hole wizard
countersink, See hole wizard
crosshatch 194, 328
Ctrl key

copy (Ctrl+C) 127
copying dimensions 78
copying fillets 261
paste (Ctrl+V) 127
rebuild (Ctrl+B) 81
redraw (Ctrl+R) 82
selecting multiple objects 37, 67
switch documents (Ctrl+Tab) 75, 81
with middle mouse button 118

cursors 17
curve driven patterns 147–148, 156–

158, 173
custom properties 196
customization 11–14, 18
cut

definition of 52
 See also features

D

dangling
dimensions 230
relations 128, 231
repairing 230

datum feature symbols 324
datum plane, See planes
degrees of freedom 381
delete

configurations 317
confirmation dialog 252
features 252
mates 416
relations 34, 128, 255

density 193, 196
design intent 7–9, 31–33, 38, 51–52, 

57, 81, 100–101, 107, 111, 
180

examples of 8
design tables 309–318

adding configurations 313
adding new headers 313
anatomy of 312

auto-create 309–310
bidirectional changes 310
controls 310
customizing with Excel 311
editing 314
formatting 311
inserting 309–310, 316
linking 310, 316
options 310
printing on drawings 329
protecting 310
saving 318
symbol in FeatureManager design 

tree 309
detail views 322
detailing 72, 320–330, 445–447

See also drawings
dimensions

aligned 39
angular 40
arrows 110
automatic dimensioning of 

sketches 104–105
changing their appearance 109, 123
changing their value 81, 429
concentric circles 129
copying 78
dangling 230
diameter 182
dimension tool 38
drawings 78
driven 80, 114
driven by design tables 310
driving 6
font 73
fractions 89
linear 39
linking 304–305
making several equal 304–305
min/max arc conditions 182
modify tool 40
moving 78
ordinate 325
point-to-point 39
preview 39
properties 123
radial 62
reattach 230
renaming 306
revolved features 182
smart 38

display
options 117

display relations 33, 101
distance, See measure
document templates 18, 455–459

default 458
how to create 456
organizing 458

draft
analysis 345–349
feature 347
in extruded features 106
neutral plane 347

ways of creating 119, 347
drag and drop

configurations 398
copying dimensions 78
copying fillets 261
moving dimensions 78
reattach dimensions 230
reorder features 252–253, 261

drag handles, See sketch, dragging
See also drag and drop; dimensions, 

moving
drawing properties 320
drawing views

3 standard views 74
detail 322
moving 75
section 322
standard 3 view 74

drawings 72, 320–330, 445–447
area hatch 328
center marks 76
creating a new drawing 73
design tables, printing 329
detail views 322
dimensioning 78
notes 326
parametric notes 326
properties 320
section views 322
sheet formats 74
toolbars 73
tools, options 73

drill, See hole wizard
driven dimensions 80, 114
dynamic assembly motion 384, 391, 

395
dynamic clearance detection 428
dynamic collision detection 427

performance considerations 428
dynamic mirroring 103

E

edit
color 71
definition 130, 253
design table 314
features 130, 253
material 193
sketch 129, 254
sketch plane 239
texture 264

editing parts 221, 249–292
ellipse 25, 207

partial 25
end conditions

blind 43
mid-plane 106
revolved features 184
through all 68
up to next 110

entities, sketch 25
equations 305–309

global variables 308
erase, See delete
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errors
highlighting problem areas 233
messages 225
rebuild 224
repairing 224–234
What’s Wrong? 225–227

Esc key 123
Excel, customizing design tables 311
explode lines 443

jog 443
exploded assemblies

explode lines 443
exploded views of assemblies 436–445

animating 444
extending geometry in a sketch 122
extrude

boss 42, 60
cut 67
end conditions 59
thin feature 359
with draft 106

extrusion
definition of 52

F

families of parts, See design tables
feature-based modeling 5
FeatureManager design tree 5–6, 10, 

15
arrow key navigation 235
design tables 309
error markers 226
flyout 149
in assemblies 380
splitting the window 281

features
applied 5
boss 60
chamfer 192
check sketch 227
copy and paste 127
cut 67
definition of 52
delete 252
draft 347
editing 130, 253
extrude 42
fillet 52, 68
holes 64
properties 279, 283
renaming 59
reorder 252–253, 261
revolved 180, 184
ribs 353–358
shell 349
sketched 5
statistics 242
suppress 279, 283
sweep 190
thin 359
unsuppress 279, 283

feedback
sketch 28

file explorer 16

file extensions
ASMDOT 455
DRWDOT 455
PRTDOT 455
SLDASM 380
SLDDRW 73
SLDPRT 23

file properties 196
filing, See saving your work
fill patterns 148
fillets 52, 68

copying 261
edge propagation 70
full round 357
rules 69
sketch 41

fixing
components 380
parts 380
See also errors

flip dimension, distance mate 407
font

text 73
fractions 89
full round fillets 357

G

geometric relations 7, 33, 35, 37, 101
add 37
automatic 8, 27
coincident 129
collinear 255
concentric 121
dangling 128, 231
delete 34
display/delete 33, 101, 255
examples, table of 35, 37
horizontal 38
symmetric 102
tangent 113, 254
vertical 255

geometry, sketch 25
3 point arcs 25
centerlines 26
centerpoint arcs 25
circles 25
ellipse 25
ellipse, partial 25
lines 25
parabolas 25
parallelograms 26
points 26, 187
polygons 26
rectangles 26
splines 25
tangent arcs 25

grips, See sketch, dragging
See also drag and drop; dimensions, 

moving

H

hidden items, selecting 125
hidden line removal (HLR) 68, 117
hide

components 399
hole callouts 83
hole wizard 64
hollowing a part, See shelling a part

I

inference lines 189
insert

3D sketch 443
boss, sweep 190
component 380, 383, 393–394, 396, 

398, 402
design table 309–310, 316
ellipse 207
explode lines 443

insert model items 77
instance

copying in an assembly 399
number 381

interference detection
dynamic 427
performance considerations 428
static 425

interrogating a part 234
interrupt rebuild 241
isometric views, See standard views

J

jog, line in a sketch 443

K

keyboard shortcuts 11, 31, 75, 81–82, 
118

L

linear dimensions 39
linear patterns 146, 149–152, 169, 172
lines 25–26

autotransitioning between lines and 
arcs 61

jog 443
link values 304–305

M

mass properties 195–196, 424
mate groups 382
material

editing 193
material properties 193, 196
materials

edit 193
mates

adding 385
alignment 386, 406
coincident 389, 406
concentric 389
definition 382
deleting 416
distance 407

flip dimension 407

mate groups 382
parallel 395, 406
smart 403
tangent 397

Pre-
Rele

ase

Do not co
py o

r d
istr

ibute



Index SolidWorks 2006 Training Manual

I-4 SolidWorks Essentials

to reference planes 388
toolbar 390
use for positioning only 408

measure 125, 127
See also section properties

middle mouse button 118
mirror

dynamic 103
pattern 147
sketch 102–103

mirror patterns 154, 172
modify

features 130
motion, assembly 384, 391, 395, 433–

436
mouse buttons 17
move

component 384, 391, 395
moving views 75
multibody solids 188
multiple views 63

N

neutral plane draft 347
notes 326

linked to properties 326

O

offset
sketch entities 119

open component 398
options 15, 17, 69, 73, 76, 78, 89, 107, 

114, 225, 229, 235, 310, 322, 
379, 455, 457–458

ordinate dimensions 325
origin 24, 54
orthographic views, See standard views

P

pan 116–118
parabolas 25
parallelograms 26
parameters, See dimensions
parametric modeling 6
parametric notes 326
parent/child relationships 237, 252–

253, 257, 282, 318
parts

copying in an assembly 399
creating new 22, 58
editing 221, 249–292
interrogating 234
repairing errors 224–234
saving 23
template 456

paste
configuration 314
feature 127

patterns 145, 169–175
area fill 148
circular 147, 152–154
curve driven 147–148, 156–158, 173
fill 148
linear 146, 149–152, 169, 172

making a pattern of a pattern 163
mirror 147, 154, 172
pattern seed only 155
patterning faces 163
sketch driven 147, 159–161, 170
skipping instances 171
table driven 147, 159–161, 170
vary sketch option 161, 175

performance considerations 318, 428
perimeter circles 109
perspective views 117
physical simulation 433–436
placing components 385
planes

creating 351–353
default 54
definition of 52
mating to in assemblies 388
neutral 347
resizing 107
sketch 60

points 26, 187
polygons 26
preferences, See options
properties

component 401–402
custom 196
dimension 123
feature 279, 283
file 196
linked to notes 326
mass 195–196, 424
material 193, 196
suppress 279, 283

PropertyManager 15, 34, 102

Q

querying a part 234

R

radial dimensions 62
rebuild 81, 186

errors 224
interrupting 241

rectangles 26, 58
redo 31
redraw 82
reference plane, See planes
refreshing the display 82
regenerate, See rebuild
relations, See geometric relations
relationships, parent/child 237, 252–

253, 257, 282, 318
renaming features 59
reorder

features 252–253, 261
in assemblies 382

repaint, See redraw
repair

dangling dimensions 230
sketch 229

resizing a plane 107
reuse of data 127

See also library features

revolved features 180, 184
dimensioning 182
end conditions 184
multiple centerlines 187
sketch rules 181

ribs 353–358
rollback

in assemblies 382
in parts 235, 258
to a feature 241
to a sketch 238

rotate
component 384, 391, 395
view 116–118, 191

rounds, See fillets

S

saving
design tables 318
your work 23

scroll 116–118
section views 117, 262–263, 322
seed 155
select other 125
selecting items

box selection 228
contour selection 258–259
cross selection 228
filters 389
hidden items 125
multiple objects 37, 67, 70

selection filters 389
shaded view 68, 117
shared sketches 260
sheet formats 74, 320
sheet setup 320
shelling a part 349
show

component 401
simulation, physical 433–436
sketch

3 point arcs 25
arcs 25, 58, 60, 181
automatic dimensioning 104–105
autotransitioning between lines and 

arcs 61
centerlines 26, 102
centerpoint arcs 25
check for feature 227
circles 25, 109
contours 258–259
convert entities 157
create new 23
definition of 52
dragging 31, 34
edit plane 239
editing 129, 254
ellipse 25, 207
ellipse, partial 25
entities 25
explode lines 443
extending geometry 122
feedback 28
fillets 41
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geometry 25
indicator 25
inference lines 189
insert 23
introduction 23
lines 25–26, 58
mirror 102–103
offset entities 119
parabolas 25
parallelograms 26
perimeter circles 109
planar face 60
points 26, 187
polygons 26
rectangles 26, 58
relations 33, 101
repairing 229
rules that govern 30, 181
shared sketches 260
splines 25
status of 29
symmetry 102–103
tangent arc intent zones 61
tangent arcs 25
trimming 120–122
wake-up inferencing 66

sketch driven patterns 147, 159–161, 
170

sketch plane 60
edit 239
how to choose 54

sketch relations 33, 101
sketching

cursors 17
feedback 17

Smart Mates 403
snap

moving dimensions 78
See also inference lines

splines 25
standard views

isometric 110
view orientation command 119

statistics, features 242
stress analysis 196–210
stretch, See sketch, dragging
suppress feature 279, 283
sweep 190
symbols

balloons 447
center marks 76

symmetry
in a sketch 102–103

system feedback 17
system settings 455

T

table driven design, See design tables
table driven patterns 147, 159–161, 

170
tangent

arcs 25, 60, 189
geometric relations 113, 254
intent zones 61

mates 397
tap, See hole wizard
templates

default 458
document 18, 455–459
how to create 456
organizing 458

temporary axes 153, 256
terminology 52
text

embossed or engraved on a part 213
font 73

textures
adding or applying 264
editing 264
threads 265

thin features 359
thin wall parts, See shelling a part
toolbars 12–14, 73

animation controller 434
mates 390
simulation 433

tools, options 15, 17, 69, 73, 76, 78, 89, 
107, 114, 225, 229, 235, 310, 
322, 379, 455, 457–458

transparency 400
trim, in a sketch 120–122

U

undo 31
view 401

units
converting units in dialog boxes 407
feet & inches 89
fractions 89
in assemblies 379
setting 89

unsuppress features 279, 283
user interface 10–18

callouts 69
cursors 17
customizing 12
feedback 17
keyboard shortcuts 11
menus 11
mouse buttons 17
toolbars 12

V

variables
dependent versus independent 306
global 308
See also equations; link values

versions, See configurations
view

display options 68, 116–117
exploded 436–445
modify options 116–118
orientation 119

isometric view 110

normal to 108, 185

rotate 118, 191
undo 401

view ports 63

viewports 63
views

section 262–263
views, drawing

detail 322
moving 75
section 322
standard 3 view 74

virtual sharps 185

W

wake-up inferencing 66
What’s Wrong? functionality 225–227
wireframe view 68, 117
work plane, See planes

X

X-Y axes, See coordinate systems

Z

zoom
in/out 117
to area 117
to fit 117
to selection 117, 119
using middle mouse button 118
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Question: What do you call an elite SolidWorks user?

Answer: A Certified SolidWorks Professional.

Get trained, get tested, and join our worldwide community of proven talent.

See reverse for more details.
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